
  

 

Introduction 

The jet.engine™ GUI (Graphical User Interface) is software used to set up, control and monitor the inc.jet™ line of Imagers and ink delivery systems.  This software will 
look somewhat familiar to anyone who has worked in a Windows environment. 

The menu system at the top left consists of a series of drop-down menus.  The toolbars underneath the menus feature typical Windows icons such as New, Open, Save, 
Font, formatting options, etc., as well as icons that are specific to the jet.engine™ system (e.g., icons for the various data objects, for moving between records, for
loading data, etc.).  If you move your mouse over an active icon, a tool tip appears, which describes the function of the icon. 

The Main Tabs are directly underneath the tool bars. You use these screens to design a print job as well as set up and run the system. 

By default, the jet.engine™ GUI opens on the Imager Setup tab. 

Using this Help 

Understanding Word Symbolism 

Navigating Through Topics 

Making a Paper Manual 

Understanding Word Symbolism 

Certain text in Help topics has different formatting to indicate special meaning:   

Bold Text:  If a word in a sentence or paragraph (not in section headings) appears in bold text, it indicates that the word is a proper name or Key Word. For 
example, in the phrase "Please read the entire jet.engine™ GUI Help System", the bold text refers to the title bar at the top of this window.  Bold text may also 
refer to buttons, tabs, or drop option boxes that perform control functions. 

Underlined Text:     Words that are underlined require special attention.  These words are given emphasis as a warning or a note critical to the subject of the
word or sentence in which the underlined text is contained. 

Hyperlinks:    Hyperlinks are underlined and appear as blue text.  Clicking on a hyperlink opens another screen somewhere in the jet.engine™ GUI Help System
to reveal more information about the blue underlined text.   Hyperlinks may also transfer you to an internet address on the world wide web using the default web
browser installed on your machine. 

Pop Up Text:  Pop Up Text looks like a Hyperlink but is not underlined.  Clicking on this brings up a pop up window that contains a note or definition about the
word in blue text. 

Drop Down Text :  Click on Drop Down Text to display additional information, diagrams, pictures, etc.  Click once to show the text, click again to hide it.  This
format is used in many places to hide text that may not be of interest to you. 

Note: This icon and text formatting indicates a special message that is important to the text or picture above.
                                                                                                       

 Warning: This icon and text formatting indicates that this message contains a warning and should be read and followed carefully. 

Navigating Through Topics 

You can view topics by double clicking on the topic in the Contents tab. While viewing one topic, you may need to click a hyperlink to another topic.  To return to the

previous topic, click the Back  button at the top left of the jet.engine™ GUI Help System window. 

Printing This Help File (Making a Paper Manual) 

These Help files have been optimized to provide ease of navigation and printability.  Although this is primarily a software Help system, it can also be printed using any
printer installed on your machine.  

Open Help Contents   

Select Print   

Make Selection   
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Select Printer Options   

Overview 

Contents 

Software Installation Requirements 

Other Languages 

What's New in This Release 

System Overview and Requirements 

System Specifications 

Software Installation Requirements 

OS Requirements 

System Requirements 

OS Requirements 

The jet.engine™ GUI is designed to run on Windows XP and Vista operating systems.  If installed on other operating systems, the following error message may 
appear:    

The operating system is not adequate for running jet.engine™ GUI.   

If this error occurs, the installation process will automatically abort. 

System Requirements 

Minimum system requirements vary with system setup and application.  Factors affecting performance of the jet.engine™ GUI software, other than PC ratings, include:

1. Database size (if loaded) 

2. Conveyor speed 

3. Number of Imagers/pens 

4. Printing area 

5. Page gap 

Items 1 – 4 require higher system requirements as the size of the item increases (directly proportional).  Item 5 requires a higher system requirement as the gap size
decreases (inversely proportional). 

Absolute Operating Minimums 

    Windows XP Home  

    600 MHz processor 

    64 MB RAM 

    40 MB hard drive space 

Suggested Requirements 

    Windows XP Professional or Windows Vista-Business Edition 

    Pentium 4 class processor or better 

    1 GB RAM 

    80 MB hard drive space 

Other Languages 

Language Settings of jet.engine™ GUI 
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The jet.engine™ GUI is currently available in seven languages: 

English (United States)  
Chinese (Traditional)  
French (France)  
German (Germany)  
Italian (Italy)  
Japanese  
Spanish (Traditional Sort)  

English is the default language of the installation program. 

  

Changing to non-English 

 Note: Contact your OEM provider for more details on obtaining additional Language DLL(s) for changing the GUI language after the setup.exe is 
run. 

What's new in this Release 

Feature Changes and Additions 

  Features    

Bug Fixes!   

  

System Overview and Requirements 

The jet.engine™GUI is just one part of an overall printing system.  A complete printing system consists of: 

jet.engine™ GUI software   Software designed to setup, control, and monitor the other system components. 

jet.engine™ Imager   The printer itself.  This is the device that controls the spraying of the pens. 

HP™ Designed Print Cartridges   The ink container and delivery (spraying) device. 

Transport Base    What the Imager is mounted to and what the media is transported on. 

Power Supply   The device that supplies electrical power to the Imagers and peripherals. 

Print Sensor   A sensor mounted upstream that detects the product. 

Encoder   A device that measures speed of the product or conveyor. 

 

System Specifications 

Printing Resolutions 

Horizontal (Process Direction) 

600 dpi 

300 dpi 

200 dpi 

150 dpi 
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120 dpi 

100 dpi 

75 dpi 

Vertical (Non Process Direction) 

600 dpi 

300 dpi 

Maximum Printing Speeds 

Maximum printing speeds are rated at 600 or 300 dpi vertical resolution by each stated horizontal resolution. 

 

 Note:  Maximum printing speeds are a limitation of the HP™ pens' ability to consistently spit ink in a uniform pattern. 

 Note:  The jet.engine™ GUI allows for a 10% over-speed allowance before automatically shutting down the printing process.  In some applications, where print 
quality is not a concern, this percentage can be increased.  Please contact your OEM provider for more information about this setting. 

  

Getting Started (Quick Start Guide) 

Contents 

Installing the Software 

Starting the jet.engine™ GUI 

Initial Setup 

Sample Job Setup 

Printing a Sample Job 

Creating a Custom Job 

Where to go Next 

  

Installing the Software 

Installing for the First Time 

Reinstalling or Updating 

Installing the jet.engine™ GUI for the First Time 

The jet.engine™ GUI is installed much like any other Windows program.  Follow the steps below: 

Start the Installation Program   

Accept Agreement   

Enter Customer Information   

Destination Folder   

Choose Installation Options   
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Confirm Installation Settings   

Finish Installation   

Reinstalling or Updating jet.engine™ GUI 

When you install the GUI you will have an option for removing the previous GUI (if the GUI is a recent version). 

 Note:  It is a good idea to back up jobs and configurations before updating. 

After backing up job and configuration data (optional), install the update, using the steps listed above.  

 Warning: If reinstalling or updating an older version of the jet.engine™ GUI, you will be requested to manually remove the jet.engine™ 
GUI first (by the setup.exe dialog). To work properly, the older version must be un-installed before updating to a new version. To do this, 
open the Windows Control Panel,  select Add/Remove Programs, and select the jet.engine™ GUI entry from the list. 

 Note: Software Installation/Clean Install  

  Warning:If you are installing a new version of the jet.engine™ GUI and you check off the Clean Install check box, (see screen shot below), 
selecting the clean install will remove everything (essentially delete the jet.engine.gui folder). If you select a clean install it is advised that you 
back up jobs and configurations before performing the Clean Install!   

  

 

  

  

Starting the jet.engine™GUI 

There are three ways to start the jet.engine™GUI. 

Windows Desktop icon:  Double click the jet.engine.gui icon . 

Windows Start Menu: Click Start > All Programs > jet.engine GUI > jet.engine.gui (see below). 

jet.engine.gui.exe: Open Windows Explorer, navigate to the C:\jet.engine.gui\ folder, double click the jet.engine.gui.exe filename. 

Page 5 of 146jet.engine GUI Help



 

 Note: The folder path may be different if the default setting for the Destination Folder was changed during installation. 

Initial Setup 

Contents 

Configuring PC Network Settings 

Setting the Imager IP Address 

Updating Firmware 

Initial System Setup and Settings 

Testing the Print Sensor Input 

Testing the Encoder Input 

Aligning the Pens for Seamless Printing 

Application Settings 

  

Configuring PC Network Settings 

The PC on which the jet.engine™ GUI is installed must have at least one physical network (ethernet) adaptor installed locally.  The PC will become the 
server for the printers attached to it.  This requires certain settings to be manually entered in the PC network settings section of Windows, which is
accessed through the Windows Control Panel. 

Follow the steps below to set your PC's network connection to work with the default IP address that is assigned to the Imagers at the factory. 

Open Network Connection   

Set IP and Subnet Mask   

Click OK > OK to continue. 

 Note:  The jet.engine™ GUI requires a dedicated network connection.  If the host PC (the PC on which the jet.engine™ GUI is installed) is 
connected to a local network, a second network card must be installed and configured.  Contact your company's IT department or OEM provider for 
further details. 

  

Setting the Imager IP Address 

Once the PC on which the jet.engine™ GUI is installed has the proper network settings (set in the previous section, Configuring PC Network Settings), 
the program can be started (see Starting jet.engine GUI). 

The jet.engine™ GUI checks for Imagers connected to the host PC at program startup.  The startup process looks for the Imagers (printers) which
were connected to it the last time the program shut down.  If there are changes, the Find Imagers window appears.   

This Find Imagers window is activated in one of three ways: 

the first time the program starts after installation; 

on startup, if the program sees a printer configuration change; or 

by selecting Find Imagers from the File menu. 

To set the imager IP Address: 

  Note:  To make IP Address changes, the jet.engine™ GUI must be in Technician or Developer software mode. 

Confirm/Set Software Mode   
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Scan for Imagers   

Confirm Imager Order   

Change IP Address   

  

Updating Firmware 

Some versions of the jet.engine™ GUI require a minimum firmware version to communicate and operate properly.  New features included in jet.engine™ GUI upgrades 
will also contain a firmware upgrade as well.  

To see the versions of firmware you are currently running you can select Help/About from the top Menu bar on the jet.engine™ GUI. 

                 The firmware version number being used for the GUI will be displayed on this About jet.engine™ GUI screen. 

 

  Note: The Automatic Firmware Updates feature setting should be Enabled in Application Settings, (this is the default setting). If this setting is enabled the 
jet.engine™ GUI automatically checks for the necessary versions of the firmware. If it is turned off for some reason it is recommended that it should be Turned Back 
On in the Applications Settings. 

Firmware will be automatically updated by the default setting in the Application Settings -> EnableAutomaticFirmwareUpdate = 1  (shown below) 

Firmware is located in located in C:\jet.engine.gui\firmware folder 
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Click on the following Application Settings link for a complete list of all settings. 

  

 Program Startup/Versions Warning Message    

  

Two types of hardware: 

V4 imager board: 

Support for service station 

Imager Firmware file name starts with “V4” (for example) V4Imager_B2132051_APP.s19 

V5 imager board: 

No support for service station 

Imager Firmware file name starts with “V5”  (for example) V5Imager_B5133054_APP.s19 

  

The Automatic Firmware Update process is as follows: 

1) The imager reports the current version of firmware  

2) If the firmware version in the folder “\firmware” is newer the imager will be updated automatically.  

The following status window will appear while the new firmware is being downloaded: 
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 Note: If you have two imagers with the same IP Address the Automatic Updates process will not start!. 

3) The status of the firmware update will be logged in the GUI Log tab:  (Example below) 

 

  

  

Manual Firmware Update: 

 Warning: It is possible to manually update the firmware, however, this is not recommended.  

From the Find Imagers window, click Update Firmware. 

An Open File window will appear. 

Select the file version suggested in the previous Errors Report. 

Click Open to continue. 

The following status window will appear while the new firmware is being downloaded: 

  

 

  

Next >> 

Initial System Setup and Settings 

When setting up the printing array for the first time, certain settings are made that will most likely never change.    These are: 

Password Settings & Access Control 

General System Settings 

Imager Settings 

Pen Properties 

Password Settings & Access Control 

There are several levels of password protection that can be used to limit the user to certain sections of the jet.engine™ GUI.  From the Options menu, choose Advanced 
Configuration and select the Passwords tab.   
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There are 4 levels of access control (software mode) in the jet.engine™ GUI: 

Operator - Lets you run jobs.  This is the lowest level of access.  No system setting changes are allowed. 

Supervisor - Enables you to change jobs and data sources. 

Technician - Allows access to passwords and system configuration and settings. 

Developer - Allows full access control to all GUI settings. 

By default, the jet.engine™ GUI starts in Operator mode. On the Passwords tab, you have the option of setting a password for access to the Supervisor and Technician
modes. 

 Tip:  Check the Start application in last used Software Mode option to enable the jet.engine™ GUI to open in the previously used Software Mode.   

General System Settings 

To avoid errors during operation, certain settings need to be entered in the System Settings tab of the Imager Configuration window.   System settings are generalized 
parameters that allow you to:  

tell the jet.engine™ GUI how to display data; 

set overall operating settings; 

control special functions or options; 

select modes of operation that allow communication with other devices or applications. 

The following need to be set at the minimum and are enough for most customers: 

Terminal Mode   

Units   

Other Settings   

Other general settings are set on the Imager Setup tab of the main jet.engine™ GUI screen. The following  parameters must be set: 

Print Resolution     

Conveyor Direction     

Pen Direction    

Imager Settings 

These settings tell the jet.engine™ GUI how to interface with the outside world.  They deal mainly with the setup of the Print Sensor and Encoder, and are found in 
Options>Imager Configuration>Imager Settings. 

You need to tell the jet.engine™ GUI how to handle the passing of signals between the encoder, print sensor, and other Imagers (if installed).  You do this through
VTMK Configuration.* 

 

*VTMK = Vacuum Table Mounting Kit 

The first two settings in the box are presets that work with inc.jet™ supplied kits and configurations: 
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VTMK - Parallel Wired    

Daisy Chained   

Custom   

  Note:  More about IO Settings is contained in the next two Help sections: Testing the Print Sensor Input and Testing the Encoder Input. 

Pen Properties Settings 

This group of settings is optional.  They notify you when the installed ink containers need to be replaced.  From the Pen Status tab of the main jet.engine™ GUI screen, 
click the Set Pen Parameters button. 

Pen Type   

Application Settings 

 Note: The Application Settings in the jet.engine GUI used to be stored in a Registry. The Registry is no longer used for the Application Settings.  

Application Settings Menu: 

  

To access the Application Settings Menu you must log in as Technician or Developer 

 

 Once you are logged in as Technician or Developer you can access the Application Settings menu by clicking on “Options” on the top menu bar and select Application
Settings. 

  

Once you have opened the Applications settings menu you can set a variety of Advanced settings 

Page 11 of 146jet.engine GUI Help



  

Clicking on an individual menu item will highlight the item, double clicking on the item will open an “Edit Application Setting” menu,  

 

In the example (above); you would enter a data value in the “Value Data” field box, 1 represents Yes and 0 represents No.  

  

 Note: Application Settings can be a number, a number including a decimal point, a symbol, a word or a path to a file location. 

  

 Note: Click the following link for descriptions for the current "jet.engine GUI Application Settings"  

  

Next>> 

Testing the Print Sensor Input 

The Print Sensor is usually, but not always, a photo eye that is connected upstream of the first printer.  This is the device or means used to trigger the printer. The
following sensor settings must be entered during initial setup: 

Input channel   Select hardware sensor input. 

Active and Non-Active States   Select input polarity (sensor is active high or active low). 

Input Edge   Select transition trigger point. 

Distance From Sensor   Enter how far away the sensor is from the Imager. 

After you have configured the settings, you can test the input: 

Block the sensor with the page or media. 

Verify that LED 5 of the imager is red when blocked. 
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 Note: Printing does not have to be enabled to test the Print Sensor. 

 Note: Only the first imager will show the print sensor when not in print mode. 

 Note: When in print mode, the encoder must transition 4 pulses (4/300”) to “qualify” as a sensor trigger.  (This is to eliminate false triggers 
when the transport is stopped). 

  

Next >> 

Testing the Encoder Input 

An Encoder is a device that is used to measure distance traveled over time at various speeds in high resolution.  The Encoder tells the Imagers in the system when to
print. 

The Encoder is usually, but not always, mounted just upstream of the first upstream Imager. This provides the best accuracy.  However, the Encoder can also be 
mounted anywhere in the conveyor path, or on a shaft of the conveyor drive. 

You must enter the following Encoder settings in initial setup: 

Mode   Select the mode in which the Encoder is connected. 

Input channels   Select a hardware input(s). 

After configuring these settings, you can test the input: 

Block the sensor with the page or media. 

Verify that LED 5 of the Imager is green when blocked.  Refer to the Imager Technical Manual for more information. 

 Note: Printing does not have to be enabled to test the encoder. 

Next >> 

Aligning the Pens for Seamless Printing (Stitching) 

At this point, the system should be ready for printing.  All of the basic mechanical, electrical, and software settings should be in place.   

Stitching is not required for printing the sample job, but is recommended.  Refer to the How To: Set Up Stitching  section of Help for a tutorial on how to perform 
Stitching.   

 Note:  Stitching must be performed before Creating a Custom Job.  If Stitching is not done prior to job layout design, placement of data in the Form Design tab of 
the main jet.engine™ GUI screen may not correspond to the placement of data on the printed output. 

Application Settings 

 

 

  

GUI Application Settings Guidelines: 

  

 Key for colored boxes  

  

Yellow: Can be set within GUI settings by user 

Aqua: Should not be changed by user in Application Settings dialog. 
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Key Name: HKEY_LOCAL_MACHINE\SOFTWARE\inc.jet\GUI\Settings 

  

Click the following link for information about how to access the Application Settings Menu. 

  

  

AckTimeout (8000) 
msec  

The amount of time (in milliseconds) the 
GUI will wait for the imager to respond with 
an ACK to any message sent.  This time can 
sometimes be long, especially when 
cleaning station commands are sent and 
the processor is busy and can’t read the 
Ethernet queue quickly. 

Current Value: 0X00001f40 (8000) 
ActiveConfiguration 

  

Default The Configuration Loaded when the GUI is 
first executed 

AdvancedConfigurationPassword Password Password to access the Advanced 
Configuration Pop-up Window, leave blank 
= No Password Necessary 

What is password normally used? 
AdvancedConfigurationPasswordRequired (0) NO 0 = No Password , 1 = Password Required 

to access the Advanced Configuration Pop-
up Window 

AutoAbort 

Can be set within GUI settings 
by user 

(0) NO 0 = Normal, 1 = Automatically Abort 
Printing when Stop Button is Pressed. 

AutoLoadJob 

Can be set within GUI settings 
by user 

  

(0) NO 0 = Disable, 1 = Enable Automatic Load of 
job running when GUI was closed 

AutoRemoveAllAddRange  

Can be set within GUI settings 
by user 

  

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG – Automatically remove all records and 
add the selected range when Start Print 
button is pressed. This feature is enabled 
only when “RemoveAllAddRangeEnabled” is 
enabled. 

AutoScroll 

Can be set within GUI settings 
by user 

(1) 
YES 

0 = Disable, 1 = Enable Database Auto 
scroll in Print Monitor Tab 

CleaningTimeout (32) Sets the number of seconds the cleaning 
station is allowed to use when responding 
to a command. Value is large to support 
cleaning station calibration operations. 

Current Value: 0X00000020 (32) 
CompressRasterData 

Can be set within GUI settings 
by user 

  

(1) 
YES 

0 = Disable, 1 = Enable Compression of the 
Raster Data Image prior to sending it to the 
Imager 

ConnectEmulator (0) NO 0 = Normal Operation, 1 = Connect to 
Imager Emulator 

Factory Testing Function – requires 
Emulator Application. Note - when using 
the emulator the OutOfSequencePageCheck 
MUST be set to 0, and the file 
“io_config.dat” must be deleted from the 
configuration being used. Application 
must be restarted for any changes in 
this setting to take effect! 

CreateErrorLogs 

  

(0) NO 0= No/Disable  1= Yes/Enable.  

TSG – Creates a separate log file in the 
“ErrorLogs” folder and log each Critical 
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Error generated while the application is 
running. It also create a separate folder for 
each Critical Error generated and copies the 
current log file and the previous log file to 
that folder. Application must be 
restarted for any changes in this 
setting to take effect! 

DebugDisconnectMode 

Should not be changed by user! 

(0) NO 0 = Disable, 1 = Enable 

DebugTraceLevel 

Can be set within GUI settings 
by user 

  

(1) 0 = Disable Debug Logs in the “Logs” 
directory when GUI executed Current 
Value: 0X00000001 (1) 

DefaultContrast 

  

(0)  Current Value: 0X00000000 (0) 

TSG - Set the vertical contrast.  

Range 0 to 15 in 6.25% increments,  

0 = 100% contrast (default) This will effect 
only the printed image and not be displayed 
on the GUI form design. 

DefaultGraphicPath 

  

  Add description 

TSG – Used by dynamic bitmap object. 
Defines the default directory from which 
the bitmaps are loaded. 

DeveloperPassword 

Should not be changed by user! 

Password Password to set User Mode to Developer in 
the GUI  

DisableJobCompleteMessage 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG - Disable or Enable the popup 
message when a job is completed 

DisableJobStoppedMessage 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG - Disable or Enable the popup 
message when a job is stopped. 

DisableSplashWindow 

  

(0) NO 0= No/Disable  1= Yes/Enable 

TSG - Disable or Enable the splash window 
displayed when the application is started.  

DisableTestPrintLayoutMarks 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG – Disable or Enable Page 
Boundary marks while printing the 
layout. Application must be restarted 
for any changes in this setting to take 
effect! 

EnableAutomaticFirmwareUpdate 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG - Disable or Enable Automatic 
Firmware Update. If Enabled the 
application will compare the firmware 
version of the jet.Engine upon 
connection and update it’s firmware if 
a new firmware is available on the 
Computer. 

EnableManualInkTracking 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG - If enabled, artificially create an id for 
the pen, based on the imager number and 
pen number, and use it as a Pen ID to track 
the ink usage. 

EnableRestartAfterLastCompletePage 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG – If enabled, user can specify 
Restart Settings via Options menu 
command. Application must be 
restarted for any changes in this 
setting to take effect! 

EnableTrue600DPI 

  

(0) NO 0 = Disable, 1 = Enable True 600 DPI 
printing  

TSG - 
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EncoderBasedTracking 

  

(1)  0 = Disable, 1 = Enable - The Encoder-
based Page Tracking feature is used to 
track inconsistency between an encoder 
signal as it is fed into different imagers. 
 The GUI will declare an error if a difference 
larger than the tolerance of encoder ticks is 
detected. The Tolerance setting allows the 
operator to choose what should constitute 
an error. This feature is used for cut-sheet 
and continuous form applications. 

FitToWindow 

Can be set within GUI settings 
by user 

  

(1) 0 = Disable, 1 = Enable Fit To Window in 
Imager Setup Tab 

GridColor 

Should not be changed by user! 

  

  

0x00808080

  

The color of the grid as displayed in the 
Form Design Tab. 

Current Value: 0x00808080 (8421504) 

GridHorizontalSpacing 

Can be set within GUI settings 
by user 

  

0.10000 Horizontal Grid Setting (Range is 0.01 to 
0.25) 

When units are English, this is in inches. 
When units are metric they are stored in 
inches and converted to metric by the GUI. 

GridShowGrid 

Can be set within GUI settings 
by user 

  

(0) NO 0 = Disable, 1 = Enable Display of Grid 
Marks in Form Design Tab 

GridSnapToGrid 

Can be set within GUI settings 
by user 

  

(0) NO 0 =  Disable, 1 = Enable Snap To Grid 
Mode in Form Design Tab 

GridStyle 

Should not be changed by user! 

  

0x00010100 The style of the grid as displayed in the 
Form Design Tab. 

Current Value: 0x00010100 (65792) 

GridVerticalSpacing 

Can be set within GUI settings 
by user 

  

0.010000 Vertical Grid Setting (Range is 0.01 to 0.25) 

When units are English, this is in inches. 
When units are metric they are stored in 
inches and converted to metric by the GUI. 
Current Value: 0.010000 

HoovenHackForBadPenBoard 

Should not be changed by user! 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG – Customer specific setting to switch 
pens. Only used by one customer. This 
should not used by any other customer. 

IgnoreFPGAFirmwareWarning (0) NO 0 = Disable, 1 = Enable Display of 
Firmware warning, if the Firmware is 
different then required, every time the GUI 
runs. 

ImagerLogEthernetFilter 

Should not be changed by user! 

  

(0) Storage for the setting in the Imager 
Ethernet Log (Advanced 
Configuration/Debug Tab).  

0 (0x0000) = No Logging 

1 (0x0001) = Command Logging 

2 (0x0002) = Register Logging 

4 (0x0004) = Register Low-Level Logging 

8 (0x0008) = Print Logging 

16 (0x0010) = Pen Logging 
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32 (0x0020) = Flash Memory Logging 

64 (0x0040) = Cleaning Station Logging 

128 (0x0080) = Miscellaneous Logging 

256 (0x0100) = Error Logging 

65535 (0xFFFF) = All 

Current Value: 0x00000000 (0) 
InkCostEnabled 

Can be set within GUI settings 
by user 

  

(1) 
YES 

0 = Disable, 1 = Enable Display of Ink Cost 
Estimates when not printing 

InkCostPerML 

Can be set within GUI settings 
by user 

  

0.95240 Cost per milliliter to use in Ink Cost 
Estimates 

Current Value: 0.95240 

InkCostPerMLUnits 

Can be set within GUI 
settings by user 

  

($) ($) = Units to display with ink cost estimate 

KeepAliveTime (2500) Current Value: 0x000009c4 (2500)  

TSG – Used to monitor the connection with 
jet.Engine. Application must be 
restarted for any changes in this 
setting to take effect! 

LastFirmwareVersionUsed 

Should not be changed by user! 

  

(0) Storage Location for Last Firmware Version 
Used   0x00200f0a  ??? 

Current Value: 0X00000000 (0) 

LastFirmwareVersionUsedV5 

Should not be changed by user! 

  

  

(0) Current Value: 0X00000000 (0) 

TSG - Storage Location for Last Firmware 
Version Used   for the V5 board. 

LastMode 

  

(8) Saves the last mode, i.e., supervisor, 
technician, … 

Current Value: 0X00000008 (8) 
LastStartedPage 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG – Used in conjunction with the 
“EnableRestartAfterLastCompletePage” 
setting. This should not be modified by the 
user on the application settings dialog. 

LogInkUsage 

  

(1) 
YES 

0= No/Disable  1= Yes/Enable     

TSG – If enabled, log the ink usage to the 
log file. 

LogKeepAliveMessages 

  

(0) NO 0 = No/Disable, 1 = Yes/Enable Logging of 
Keep Alive Messages. 

LogRipTimings 

  

(1) 
YES 

0= No/Disable  1= Yes/Enable     

TSG – If enabled, log Rip timings to 
the log file. 

LogTriggerEvaluations 

  

(1) 
YES 

0= No/Disable  1= Yes/Enable     

TSG – If enabled, log trigger 
evaluations to the log file. 

ManifoldPenLife 

Can be set within GUI settings 
by user 

760.00000 Current Value: 760.00000  

MaxImageCacheSize (200) Current Value: 0X000000c8 (200) 
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  TSG – Used by dynamic bitmap object 
to determine maximum number of 
bitmaps that can be sent to the 
jet.Engine. 

MaxLinesPerLog (10000) Maximum number of lines to put in a log 
file before closing that file and opening a 
new one 

Current Value: 0X00002710 (10000) 
MaxPCBuffersAllowed 

  

(40) Current Value: 0X00000028 (40) 

TSG - Maximum number of buffers allowed 
to be pre-ripped on the PC before we error 
out. 

Multistation 

  

(0) NO 0 = Disable, 1 = Enable Multistation 
printing mode 

Application must be restarted for any 
changes in this setting to take effect! 

OEM (0) OEM user select:  0 = inc.jet (Others 
available and provided by inc.jet) 

OEM user select: 

0 = inc.jet 

1 = Kirk-Rudy 

2… TBD 

Current Value: 0X00000000 (0) 

Application must be restarted for any 
changes in this setting to take effect! 

OperatorMoveAmount 

  

0.00000 Current Value: 0.00000 

TSG -  
OutOfSequenceErrorCorrection (0.00000) No longer needed when Encoder Based 

Tracking is enabled. 

This value is used for a tolerance in looking 
for out of sequence pages. The check 
compares the distances from sensor of 
imagers. It ensures that 

if one imager follows another, the pages 
print in that same manner. The correction is 
necessary when imagers are close together 
because the 

pages can finish printing and notify the GUI 
at a time that is very close. This allows 
those cases to be ignored. 

Current Value: 0.00000 
OutOfSequencePageCheck (1) No longer needed when Encoder Based 

Tracking is enabled. 

An Imager Request for data is tied to a 
distance from sensor for that imager.  Upon 
receipt of a request for data, the software 
loops through all imagers to see if that 
imager should have completed this page 
already.  If it should have, but has not – an 
error is declared. (Must be set to zero when 
running the Emulator).  

0= No/Disable  1= Yes/Enable     
OverspeedVariablePercent (10) Sets percentage of overspeed allowed 

before printing is stopped due to overspeed 
error.  (10 = 10% - 15KHz nominal firing 
rate, 16.5KHz maximum firing rate) 

Current Value: 0X0000000a (10) 
  

OverwritePdfFile 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG – If enabled, pdf file is overwritten 
when using PDF Print Engine. 
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PageDifferentialAdjustment 3.00000 Value in inches added to page length to 
compensate for imager width. 

Sets an additional length to be added to 
each page (in inches?) when performing 
the differential page check.  Required when 
the page size is about the same as the 
Imager-to-Imager spacing, to compensate 
for the fact that an imager has a “width”. 

Current Value: 3.00000 
PageDifferentialCheck (1) 

YES 
0 = Disable, 1 = Enable Page Differential 
Check (number of pages in the imager 
“span” is not more than physically possible 
is computed by GUI for all imagers) 

PdfFileNameType 

  

(0)   

Current Value: 0X00000000 (0) 
PdfRipKeys 

  

  TSG – Third party license key used by PDF 
RIP software component 

PdfRipRes 

  

  TSG – Path to the resource files used by 
the PDF RIP software component. 

PdfRipTemp 

  

  TSG – Path to the temporary files used by 
the PDF RIP software component. 

PenCalibrationEnergyIncreasePercentage (28) Sets the percent over energy applied to 
each pen when it is automatically 
calibrated. 

Current Value: 28.00000 (28) 
PenCalibrationTimeout (12000) Time (in msec) to allow a pen calibration to 

complete before declaring a timeout 

Current Value: 0X00002ee0 (12000) 
PixelDropVolume(pl) 

Can be set within GUI settings 
by user 

  

(30) The pixel drop volume (in picoliters) to use 
for each pixel fired in the cost estimates 
and the pen life status and tracking 
calculations 

Current Value: 0X0000001e (30) 
PreviousJob ?  The file name and path to the job that will 

be loaded automatically if “Load Previous 
Job” is enabled. 

0= No/Disable  1= Yes/Enable     

  
Realtime 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG – If enabled, runs the GUI process at 
the Realtime priority. 

Application must be restarted for any 
changes in this setting to take effect! 

RemoveAllRangeEnabled 

  

(0) NO 0= No/Disable  1= Yes/Enable  

TSG – When enabled, displays the 
controls on the Print Manager Screen 
that allows the user to remove all 
queued records and add user specified 
records to the queue for printing. 
Application must be restarted for any 
changes in this setting to take effect! 

RemoveLogFilesAfterXDays (14) Sets the number of days to keep log files 
before they are automatically deleted to 
prevent filling a hard drive with log files. 

Current Value: 0X0000000e (14) 
RemoveRedundantButtons (0) NO 0 = Include, 1 = Remove Record Block and 

Fixed Text Buttons from the GUI – these 
functions can be performed using the Field 
Block. 

  
RequiredFirmware (2112032) Default Firmware Required by the GUI – 

Used when performing the FPGA Firmware 
Warning check at initial execution of the 
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GUI. 

Current Value: 0X00203a20  (2112032) 
RequiredFirmwareV5 

  

(5132049) Current Value: 0X004e4f11  (5132049) 

Resources ? Sets the language resource file to use when 
running the GUI. Currently supported 
languages include Japanese (jpn), German 
(deu), Chinese (), Chinese () – Must have 
the supporting language DLL installed in 
the same location as the jet.engine.exe file 
in order to use this feature. 

RestartPageIncrement 

  

(0) Current Value: 0X00000000 (0) 

RestartPrompt 

Can be set within GUI settings 
by user 

  

  

(1) 
YES 

0= No/Disable  1= Yes/Enable     

TSG – Used in conjunction with the 
“EnableRestartAfterLastCompletePage” 
setting. This should not be modified by 
the user on the application settings 
dialog. 

SaveConfigurationTimeout (30) Amount of time allocated to saving the 
Firmware configuration in the Imager 
(Imager Configuration/System Settings 
Tab).  If the Imager does not respond 
within this number of seconds, an error is 
declared. 

Current Value: 0X0000001e (30) 
SaveImagerBitmaps (0) NO 0 = Disable, 1 = Every page bitmap created 

during printing is stored in the 
C:\incjetbmps\ directory. 

StartInLastMode 

Can be set within GUI settings 
by user 

  

(1) 
YES 

0 = Always open in Operator Mode when 
GUI is executed, 1 = Always open in Last 
User Mode used when GUI is executed. 

StopPrintingDelay 

  

(0) Current Value: 0X00000000 (0) 

TSG -  
SupervisorPassword super Password to set User Mode to Supervisor in 

the GUI 

  
SupportLeftRight (0) NO 0 = Disable, 1 = Enable display (and 

operation) of the Left/Right Paper 
Orientation in the Imager Setup Tab – Still 
in Development 

TechnicianPassword tech Password to set User Mode to Technician in 
the GUI 

UseContrast 

  

(0) NO 0= No/Disable  1= Yes/Enable    

TSG - If enabled, set the contrast using the 
value defined in the “DefaultContrast” 
setting. 

UseNewPageDifferential 

  

DB-(1) 
YES 

0= No/Disable  1= Yes/Enable     

TSG – If enabled use a new method for 
calculating the max page differential that 
include the PageWidth as part of 
calculation. 

UseNewStopMessage 

  

(0) NO 0= No/Disable  1= Yes/Enable     

TSG – If enabled, use new message while 
stop printing that takes the stop type 
argument. 
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Sample Job Setup 

 Note:This topic assumes that you have already configured the Imager software and hardware settings required for system operation. If you have not done so, go to 
Getting Started (Quick Start)/Initial Setup in Help. 

The jet.engine™ GUI comes with a sample job that includes a pre-designed form set up for two Imagers, and a pre-loaded database containing
fictitious personal records with address information.  The form is designed with many of the standard printable form objects as a working example. 

To open and load the sample job: 

Open Job Window   

Find the Sample Job File   

Open the File   

Customer Specific Settings   

 Note: Opening this job will add a second Imager to the configuration, if one is not already present.  If only one Imager is being used, the second Imager must be 
removed from the configuration in the Imager Setup tab.  Only the top half of the form design layout will be printed. Refer to the How To:  Setting the Imager 
Configuration of this help system for more details on how to delete additional Imagers. 

Next >> 

Printing a Sample Job 

Print jobs are started from the Print Manager main tab of the jet.engine™™GUI.  This is also where you: 

Select data to be printed (Queuing) 

Start a print job 

Monitor job progress 

Monitor job statistics 

Monitor Ink Status 

Stop a print job 

Example of Print Manager tab with sample job loaded   

Select data to be printed (Queuing) 

Queuing is the state that a record is in when the jet.engine™ GUI has selected it for printing.  At this point, the records have not yet  been processed.  All records are
queued by default when a Data Source is added to a job, or when the job is opened.  In most cases, no further action is required. 

In certain cases, however, you may want to pick up from where you left off on a previous print job.  Refer to the following:  

Queuing Options   

Example of Queuing a Range of Records   

Start A Print Job 

Starting a print job is as easy as pushing the Start Print button.  The Status column of the Print Manager display will change once printing has started.  Record status will 
begin to change from Queued to Ripped to Buffered. 

You'll notice as well that several of the monitors and statistics are now active. 

The system is ready to print on product being fed. 

Monitor Job Progress 

There are several displays of information that can tell you how far along the print job is.  Some of these are particular to the print cycle, while others are universal
throughout the entire job.  These include: 

Record Status   Indication of what stage a particular record is in. 

Counter   How many have been printed. 

Job Status Frame   Status information about the entire job. 

Monitor Job Statistics 
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Several job statistics are provided for your monitoring, estimating, and planning needs.  These displays of data are crucial for monitoring performance of a job as well as
the printing system.  Statistics displayed here can invaluable when planning future print jobs. 

These readings include: 

Speed and Time Related   

System Bandwidth   

Monitor Ink Status 

Ink Status information is displayed in the Ink Status frame.  This information is drawn from the Ink Status tab of the main jet.engine™ GUI interface screen.  Pixels Per 
Page is critical to calculating ink usage and estimating approximately how many ink dispensing containers will be needed in the future.  Pages To Empty and Time To 
Empty are based on an average of the Pixels Per Page and the Time/Speed statistics. 

 

Stop A Print Job 

Once the print job has started, the green Start Print Job button changes to a red Stop Print Job button, which is used to stop and abort a print job or print cycle. 
 Pressing the Stop Print Job button changes the button into a red Abort Printing button.  Click it once again to abort the print job. 

 Note:  If the Auto Abort option is checked in the System Settings tab of the Imager Configuration window, the job will be immediately aborted with the first click. 

Creating a Custom Job 

 Note:This topic assumes that you have already followed the preceding steps of the Getting Started (Quick Start) section of Help. This means that all the hardware 
settings and core software settings have been entered into the GUI and the system is able to print at least at a basic level. 

Several steps of planning and software setup must be taken to ensure a proper print setup: 

Stitching the pens   Aligning the print heads. 

Analyze product stock   The media on which you will print. 

Adjust mechanical imager mounting   

Enter GUI setup parameters   Physical setup parameters. 

Create a template   A paper form layout design guide. 

Lay out the Form Design   Defining print areas and data types 

  

  

Where to go Next 

General Information 

How To 

 Note:  At this point, the software should be set up, and the sample jobs were able to print, at least at a basic level.  If not, try searching Help using the Search tab 
located at he top left of this window for the particular problem you are having. 

General Information 

The topics found in the General Information section of Help assume that you have read the prior sections, or that you already have a basic understanding of the GUI
software.  These are the topics you will view when pressing the F1 key while in the different GUI screens, and where you will find explanations on the different tabs, 
windows, and controls used throughout the GUI. 

It is a good idea to briefly read over this section in its entirety.   This section can also be used as a first point of reference if you are having problems operating a
particular part of the GUI. 

How To 
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There are several How To topics that provide tutorials on how to se tup or perform certain features of the jet.engine™GUI.  These include: 

How To: Set Up an IO Event 

How To: Set the Imager Configuration 

How To: Set Up Stitching (Align Printing) 

How To: Set Up Purging 

How To: Proof 

How To: Advanced Form Design 

How To: Read jet.engine™ GUI Debug Logs 

How To: Work with Data Sources 

  

General Information 

Contents 

Main Tabs 

Imager Configuration 

Working with Jobs and Configurations 

Form Design (Job Layout) 

Working with Databases 

Testing Print Jobs 

Ink Level Settings 

Advanced Configuration 

Terminal Mode Overview 

Menu Bar 

Toolbars 

Print To PDF 

Pen Life Settings 

Multistation 

Main Tabs  

The jet.engine™GUI application has seven (7) Main Tabs located below the toolbars on the jet.engine™GUI screen. You can click on each tab in the image below for a 

more complete description. Use the Back button  in the tool bar to return to this page. 

 

  

Imager Setup 

The Imager Setup tab is where you set up and configure the Imager system. 

Form Design 
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The Form Design tab is where you lay out and design your print job . 

Print Manager 

The Print Manager tab is where you initiate printing and monitor the status of a running print job. 

Service Station 

The Service Station tab is where you set up and control operation of Imager service stations for Imagers configured with Automatic Capping (AC) capability. 

Pen Status 

The Pen Status tab is where you set up, monitor, and re-set ink levels for each pen cartridge. 

I/O Status 

The I/O Status tab is where you can view the status of all inputs and outputs used in all enabled IO events. 

Log 

The Log tab is where you can view any status or error messages that occur during a print job. 

Imager Setup 

On the Imager Setup screen you can create print job configurations and store them in a file with a .ijj extension. 

The Imager Setup screen is divided into three areas: 

1. The top area left area (Job Setup) is where you set printing parameters.  

2. The top right area (Imager Setup) is where you configure the jet engines.  

3. The bottom area is where you see a graphic representation of the Imager/print configuration . 

 See How To:  Setting the Imager Configuration for additional information on using Imager Setup. 
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Form Design 

The Form Design screen is where you lay out the various data objects (Field Block, Record Block, Message Line, Indicia, Fixed Bitmap, Dynamic Bitmap, 
Number Generator or PDF File) that will be used in the print job . In other words, this is where you design your print job. Please refer to the individual objects for
additional details. 

The Form Design layout screen, the area where you place the objects, is actually a scale representation of the print area available to the Imagers.  Your design area is
on the Imager Setup screen. (See also Grid Settings and Stitching.) 

 Note: There may be instances when you want to design a print job with overlapping blocks.  You should position the objects on the Form Design screen exactly 

as you want them printed. Use the Bring To Front  and Send To Back buttons on the tool bar to arrange the objects, keeping in mind that dynamic blocks 
will always print on top of fixed blocks. 
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Print Manager 

You start, stop, and monitor all of your print jobs in the Print Manager. This screen displays the contents of the data file that is printing, as well as statistics on the
performance of the Imagers and the jet.engine™ GUI.  You can  also monitor ink status on this screen. 

 

Before you start printing, you can direct the system to Stop On Error by checking that box.  This means that every time the system detects an error, the print job will
stop.  If this is not checked, the system will simply skip that page in the printing process. 

If you check the Auto Scroll box, the Print Manager will continually scroll during the printing process so that the record being printed is the first record listed.  If you
don't check this box, you can manually scroll up and down through the records. 
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Under these check boxes is a Print to Disk/Print to V4 Imager drop-down menu, (shown above). 

There are additional files required to enable this Print to Disk feature, if you would like to use this feature please contact your Inc.Jet Service 
Field Application Engineer. 

Print to Disk/Print to V4 Imager: 

Typically, you would choose Print to V4 Imager as your destination for the print job.  However, there may be occasions when the print job is so complex, or has so many 
objects, that the size of the job affects the ability of your PC to process it.  In such an instance, you may choose to Print to Disk. This saves the job as a .ptd file, which
can then be opened and printed. 

 Note: This selection drop down menu for selecting  Print to V4 Imager or Print to Disk will not appear on the display unless" "is set to "1" for " " in 
the "Applications Settings" dialog menu. 

  

 

  

Remove All and Add Range: 

You can select a range In the Start Record Number and End Record Number that you want to print within the job you currently have loaded.  

To do this enter in the starting and ending record number range you would like to print. 

Next click the   button, the records you specified will be queued for printing and the rest of the records will be removed. 

Automatically Remove All and Add Range on Start Print: 

You can select a range In the Start Record Number and End Record Number that you want to print within the job you currently have loaded that will start the next time you
press the "Start Print" button.  

To do this enter in the starting and ending record number range you would like to print. 

 Next click the check box to select  

 Note: This selection boxes for selecting  Start Record Number, End Record Number, the select button for Remove All and Add Range and the check 
box for Automatically Remove All and Add Range on Start Print will not appear on the display unless " " is set to "1" for " " in 
the "Applications Settings" dialog menu. 

  

Print to Disk: 

1. To Print to Disk, select that option from the drop-down menu.  A Save As screen appears, in which you can name the file and select a location where you want
to store it. It will automatically be saved with a .ptd file extension.  

2. Click OK to return to Print Manager, and then click the Start Print Job button. The print job will process as though it is printing, but it is actually being saved as
a complete file.   

3. Once it has finished, open the file (select Open Job from the File menu, locate and select the .ptd file, and click OK). You'll notice that the drop-down menu no 
longer appears in Print Manager, because the file can only be printed to the V4 Imager.  

4. Click the Start Print Job button and the job will print.     

You can set the number of Initial Pages to Purge by entering that number in the box (see How to:  Insert a Purge Page). 

The boxes across the top of the Print Manager tell you how fast the system is printing (Speed Inches/Second), how many Pieces/Hour it is printing, and also the 
Time Remaining in the printing process.  

The counter keeps track of the number of pages printed in all print jobs while the GUI is running, unless you hit the Reset button between jobs or exit the GUI. You can 
see how many pieces have printed in the current job in the Job Status box.  It also shows you the Error Count, i.e., how many errors have occurred in printing. 

The Ink Status box indicates how many Pixels Per Page are being printed, and estimates for you how many more pages will print before ink runs out (Page to 
Empty).  In some instances, it will indicate the approximate Time to Empty. 
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If you have checked the Calculate Ink Costs box on the System Settings screen, the Ink Status box will be replaced by an Ink Estimate box, which shows an estimate of 
the cost to print 1,000 pages of a selected record. This information is only shown when printing is not in progress. 

The Buffers box is an optional feature that will only appear if you have set it up in System Settings. 

The Quantity column appears only if the setting Enable Multiple Copies has been enabled in the System Settings. 

 

Page Number Range 

  

When no database is loaded in Print Manager Tab, (Right click on the blank Print Manager data section), the Set Page Number Range Menu will pop up. From here you 
can specify Start and Stop page numbers, select to stop after a specified number of pages or specify that you will Hit the Stop Print Button manually to stop printing. 

            

Installation of the Printer Driver: 

The printer drivers are automatically installed in the GUI. In the event a problem occurs and the GUI will not print an error message pop up will appear. (See examples 
of Windows XP and Windows Vista messages that will pop up below). 

Windows "XP" Printer Driver Message: 

 

Windows "Vista" Style Printer Driver Messages:  
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When the GUI is first installed you will see the following dialog.   

Press Continue. 

 

Next, the following warning will be displayed.   

Click on the “Install this driver software anyway”. 

 

If the V4 jet Engine DPI Printer did not install correctly you will see the following dialog. 

Click OK and then close and restart the GUI and the V4 jet Engine DPI Printer will attempt to install again. 

 

How to install the printer driver manually: 

Close the GUI and look for a folder inside the jet.engine.gui/PrinterDriver folder called InstallPrinter.exe, click on it and run it. This will install the printer drivers into the 
GUI.  

File location:    

/    

 In the event that this does not work properly call Inc.Jet Service for assistance. 

Service Station 

Much like your motor vehicle, Imagers need maintenance to keep them in good operating order.  You can set up a number of operations on the Service Station screen 
that will help ensure that your Imagers perform reliably. 
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If you have checked the Service Station Enabled box on the System Settings screen, the Service Station appears as a Main Tab. 

  

The Imager Box shows you which Imagers are currently recognized by the system.   

Note:  When Imagers are added via the Imager Setup screen, they will not appear in this box until the GUI is shut down and restarted. 

After you select an Imager, you can control it by using the buttons to the right of the Imager Box. 

The Auto Park Mode box, if checked, parks the Imager when a print job is stopped by the GUI. If you do not check this box, you need to use the Park button. To 
Park an Imager is to place it onto the capping station, where the pens will fire a purging (or cleansing) spray into the cups in the capping station. Parked Imagers are
protected from having their print heads dry out. 

You use the Print button to move the Imager to the ready-to-print position.  If you click on Remove Tray, the capping tray, which contains the cups, moves to the 
front of the Imager for easy removal.   

Manual Operation allows you to "jog" the Imager, i.e., adjust it In, Out, Up, or Down in small increments.  It is a good practice to Park the Imager after using any 
of the Manual Operation buttons to re-qualify it. 

Note: During the Park and Clean operations, ink is discharged into the cups, and these can overflow if too much ink accumulates. 

  

  

  

Pen Status 

You can check the quantity of ink in each pen from the Pen Status screen.   Based on the job in progress, the jet.engine™GUI calculates the number of Pixels Per 
Page for you, and determines the number of Pages To Empty for each pen and Imager . 

If you click the Set Pen Parameters button, you go to the Pen Properties screen, where you can set the Low Ink Warning Level for each Imager and its pens. 
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Good Nozzles Indicators: 

The Good Nozzles test is an electrical test that the GUI performs that looks for damaged nozzles, (not clogged jets).  This means that the pen cannot print with more
than the number of nozzles indicated.  

 Note: The "Good Nozzles number"  on the display represents the number of good nozzles on each pen.  

  

Good Nozzles Indicator Color Key: 

300  Good nozzles = Green       0  Good nozzles = Red       

290 and over - up to and including 299  Good nozzles = Green/Yellow Combined    

260 and over - up to and including 289  Good nozzles = Yellow    

1 and over - up to and including 259  Good nozzles = Red/Yellow Combined    

  

Unknown # of Good Nozzles = Gray    

Note that multiples of 13 to 14 or 21 to 22  bad nozzles indicate that the contacts on the back of the pen are dirty and cleaning may recover many nozzles. A 
number of lower than 300 good nozzles on the display can also indicate that a pen may be seated in the stall improperly.  

IO Status 

The IO Status tab displays the status of all inputs and outputs used in all enabled IO events.  

 

For each enabled event , the screen displays the following information: 

The name of the Input or Output (This will be either the default label or a label you have defined using Define Labels on the IO Events page.) 
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The Number (#) of the affected imager  

Whether the event is an Output or Input 

The Point involved, i.e., which one of the six (6) inputs or two (2) outputs 

Whether the Control is Automatic or Manual (If the event is an Input, you cannot change to Manual control.  However, if the event is an Output, you can 
use the drop-down menu to change from Automatic to Manual.  Changing to Manual enables the Toggle button so that you can then manually control the 
Output.) 

When you exit the IO Status tab, all IO Events will revert to Automatic Control. 

  

Log 

The Log screen displays any status or error messages that occur during a print job. The Log will continue to be appended as long as the software is running.  You can 
clear the Log by clicking on the Clear button.  

The Contact button allows you to communicate with the Imagers and report any problems with the active configuration. If you click on the Contact button, you'll 
receive a message telling you whether the Imager is still alive, as well as the firmware version of the Imager. 

 

  

Imager Configuration 

Contents 

IO Events 

Network Setup 

Stitching 

Imager Settings 

System Settings 

Imager Status LED's 

Network Setup 

Contents 

Find Imagers 

Set Imager IP Address 

Set Imager IP Address 

Each Imager must have its own unique IP (Internet Protocol) Address. This identifies the location of the Imager.  Some portion of the IP Address represents the 
network number or address, and some portion represents the local machine address. You can set Imager IP Addresses from the Find Imagers screen. 
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From the File menu choose Find Imagers.  

 

From the list of Imagers that appear on the Find Imagers screen, select an Imager.  Click on the Set IP Address button. 

Note: The Manual update buttons will be disabled when you are in "Automatic Mode"  

  

 

Enter the IP Address.  The Network Mask and GateWay do not change. 

Note: The firmware version numbers may be different for a system with a V4 and a V5 

Find Imagers 

In the Find Imagers window you'll see a list of all the Imagers found on the network. You can click on the  Find New button to detect new Imagers on the network. 

 

If you select an Imager from the list by clicking on it once, the other buttons will become active: 
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Find Imager Function Select Buttons: 

Move Up - Clicking on the "Move Up" button moves the Imager up in the list 

Move Down - Clicking on the "Move Down" button moves the Imager down in the list 

Delete - Clicking on the "Delete" button deletes the Imager from the list 

Find New - Clicking on the "Find New" button looks for any new Imagers 

Set IP Address - Clicking on the "Set IP Address button" brings up the Set Imager IP Address window 

Start Flash - Clicking on the "Start Flash" button flashes an LED on the selected Imager to verify communication with that Imager 

Update Firmware - You can also Update Firmware on a selected Imager by clicking on the Update Firmware button.  

The following status window will appear while the new firmware is being downloaded: 

  

 

  Note: The Automatic Firmware Updates feature should be Enabled, (this is the default setting). If this setting is enabled the jet.engine™ GUI automatically 
checks for the necessary versions of the firmware. If it is turned off for some reason it is recommended that it should be Turned Back On in the Applications Settings. 

  

 Note: If you have two imagers with the same IP Address the Automatic Updates process will not start!. 

(See also Updating Firmware in the Getting Started (Quick Start)/Initial Setup section of Help.) 
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A typical Windows browser screen appears from which you can select a Firmware File (*.s19).  You will find these in the Imager Utilities directory, where they were 
placed when you installed the jet.engine™ GUI. Once you have selected the Firmware File, click Open and the software for the selected Imager is updated.  The 
system will also automatically reboot the Imager. 

  

 System Settings 

From the System Settings screen you have access to a number of features used to configure Imagers. 

 

Terminal Mode 

By configuring Terminal Mode, you can set up the jet.engine™GUI to receive dynamic print data from a remote application, as well as allow a remote application to
control several of the jet.engine™GUI  functions and capabilities. 

Units 

In the Units box you can set the jet.engine™GUI to run in either Imperial or Metric mode. You can also change the unit of measure for Print Speed Units. 
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Logging 

Logging is a process by which messages are written to a log file and can be used as a debug tool.  You can enable or disable Logging in this section. 

All logs are created as a file with a date/time stamp as its name. There are three types of Logs: 

  

1. GUI Logs: These log all the messages to and from the jet.engine™ GUI in the log file. jet.engine™ GUI Log file names begin with the letter "G." 

 

2. Imager Logs: All Imager messages are recorded in Imager Logs. Imager Log file names begin with the letter "I."  

 

3. Terminal Mode Logs: If the jet.engine™GUI is set up in one of the Terminal Modes, these logs give an account of all recognized messages between the remote 
machine and the jet.engine™GUI. Terminal Mode Log file names begin with the letter "T." 

 

Log files are limited to 10,000 lines (default). After the log is full, a new file, with a new time stamp, is created. The old file is preserved in the respective log directory. 

Pen Properties 

If you check Automatically Reset Ink Level on Cartridge Change, the jet.engine™GUI will reset the ink level of a new pen to 100% and track the ink usage of all the pens
installed.   

 

You can also enter the Pixel Drop Volume and Manifold Pen Life values.  

If you check Calculate Ink Costs, the jet.engine™GUI will provide an estimate of the cost to print 1000 pages of any given record. Units refers to a currency symbol (the 
U.S. "$" is the default), and Amount refers to the cost of the ink per millilitre, in the selected currency. 

The Ink Estimate information will appear on the Print Manager screen, in place of the Ink Status box, only when printing is not in progress. 

  

In the example above, the selected record prints 1995 Pixels Per Page, using 16708.44 millilitres of ink at an estimated cost of $0.06 Per 1000 Pages. 

Note: The Ink Estimate will be affected by such variables as stitching, overlapping objects, and objects hanging off the edge of the page.  
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Track Record Status by Default:  

The "Track Record Status by Default" feature generates a verification file for the database to record records printed or errored. When this feature is enabled a
verification file will be generated for every new job that is created and run. The naming convention is "databasefilename.ext.verification", and when initialized contains a
"?" (question mark) on each line for the number of records in the database. As the database is printed the question mark "?" will be replaced with a "P"  for printed or 
"E" for errored.  When the database is closed and reopened the user will see the record status in the first column of the print manager tab indicated by green cells with
the text "printed" (or red cells with the text "errored" ) for previously processed records.   

 Note: The user can clear the tracking file by selecting Delete Tracking File from the Data menu to reprint the database. 

  

 

Enable Multiple Copies: 

If Enable Multiple Copies is selected; you can configure a job field in a schema that contains a number that will specify how many pages of that individual record will be
printed. 

  

Encoder Based Continuous Form Tracking 

The Encode-based Continuous Form Tracking feature is used to make certain that the eyemark sensor does not miss any marks.  If it does, the GUI will create a popup
and display all pages that were missed. This feature is used for continuous form print applications. 

 

      Continuous Form Size Tracking: 

When the check box in the System Settings Tab to “Enable Continuous Form Size Tracking” is selected, (shown above), the GUI software tracks the distance between 
pages. As each page is printed the software verifies the distance from the last page printed is equal to the “Form Size” set. If a page is missed, an error is generated and 
the skipped page log is displayed.  The log indicates the page number(s) for all skipped pages. The log can be left displayed, or closed by the operator, however, every
time a page is skipped the log will be displayed.  

      Form Size: 

When Printing is started, the software checks that the "Form Size" defined in the Continuous Form Size Tracking, (shown above), is at least 0.25” larger than the page 
width set in the form size in the Imager Setup. If the check fails an error is generated and printing is stopped. 

      Abort Printing on Error Detection: 

If this box, (shown above), is checked or "enabled", the software aborts printing on error detection. 

      Automatic Sensor Generation: 

When the check box to “Auto correct missed sensor hits using pulse output”, (shown above), is enabled, the GUI software will automatically generate and insert missed
top of form marks for the continuous web.  

 Note: Auto correction uses output 0 to create the top of form pulses, so this output is not available for other uses when this mode is enabled. 
The placement accuracy of the output pulse is 1/75”. 

    Form Print Delay: 

The “Form Print Delay” setting, (shown above), defines the number of top of form pulses in a row that will cause an error. The system will add this number of pages to
the sensor queue (inserting this number of blank pages at the beginning of printing) and then automatically generate top of form pulses. All top of form pulses
generated are logged as “generated TOF” in the skipped page log. The system will track the distance between all received top of form pulses and insert correctly located
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top of forms in the print stream for any missed pages. If the system ever reaches the point where no top of form pulses are queue up then too many pages in a row
have been missed, an error is generated and printing is terminated.  

Other Settings 

 

In the Other Settings box, you can set the Encoder DPI as well as the Number of Imager Buffers.  

V4 GUI Name allows multiple instances of the jet.engine™GUI  to be given different names.   

You can elect to have the Service Station Enabled.  

If you check Auto Load Previous Job , then the next time you open the jet.engine™GUI it will automatically open with the job that was active when the 
jet.engine™GUI was closed.  
(You can also choose to load the previous job loaded by selecting Load Last Used Software Mode in Advanced Configuration/Passwords section).  

Enable Buffer Graphs is a diagnostic tool which, when enabled, displays during printing on the Print Manager screen, allowing you to see what is moving through 
the print buffers.  

Selecting Allow Rotation of Dynamic Blocks enables rotation of dynamic objects, i.e., Record Blocks, Field Blocks, and Number Generators, during printing.  
You should be aware, however, that this operation consumes a great deal of your computer's CPU speed, and has the potential to slow down your print job.  

Enabling Auto Abort means that, instead of clicking twice on Stop Print Job in Print Manager, to halt a print job, the job will instead be aborted with a single click 
on the Stop Print Job button.   

Compress Raster Data compresses the data that is sent to the printer. 

Track Page Size setting should be disabled as the default setting. When this setting is disabled the top of form sensor is locked out for the length of
the page. If it is enabled it allows you to run variable length pages, it is not suggested that this setting be used unless you actually are running
variable page sizes! 

  

  

Imager Settings 

On the Imager Settings page you can set up the jet.engine™GUI to work with a particular Imager setup.  Presets for parallel and daisy chained VTMK (Vacuum 
Table Mounting Kit) configurations are provided.  The Custom button is used to configure user-supplied encoder and sensor combinations.  The Encoder and Sensor
sections are disabled when VTMK presets are used. 

Sparse Spit is a feature that, when enabled, keeps the pens clean and ready to print by firing each of the jets individually at random.   Because the dots are spaced
out, they go unnoticed.    The number entered in the Interval box must be multiplied by 16 inches to determine the repeat distance in inches of encoder travel. 

You can check Enable Warming Pulse to eliminate the need for pens to warm up before firing . This keeps the pens in a ready-to-fire condition. 

Encoder and Sensor signals may be simulated when necessary.  Encoder Free Run Rate is the approximate belt speed.  The number entered here is rounded to the 
nearest acceptable value as determined by current parameters. Fixed Repeat Length is the amount of belt travel between firings. 

Sensor Delay Accuracy affects the resolution of the printer.  As the number is increased, the resolution decreases, but the maximum distance from the sensor to the
Imager may be increased. 
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Stitching Overview 

An Imager is limited to the area it can cover and the number of pens it can contain.  Similarly, pens are limited to the area they can cover.  If the size of your printed
document requires that you use multiple pens and/or multiple Imagers, you want to make sure that the area where one pen meets another, or where one Imager meets
another, does not overlap or leave a gap in the print, and that the leading edge of images from the multiple pens or Imagers align properly.  Fine tuning this process of
adjusting the pen overlap and Top of Form location on Imager pens is called Stitching. 

To configure Stitching, select Imager Configuration on the  Options menu and click on the Stitching tab.  A list of the Imagers is in the upper left corner.  When 
you select an Imager from the list, that Imager’s settings appear in the Pen Overlap and Process Direction Adjustment sections. 

For additional information on setting up Stitching and calibrating Pen Overlap and Process Direction Adjustment (Automatic Adjustment and Manual 
Adjustment), see How To: Set Up Stitching (Align Printing). 

 

Note: Imager #1 - Pen #1 is the reference point and CAN ONLY BE MODIFIED on the Imager Setup screen. 

Status LED's 
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Imager Status LED's 

 

The Imager has six bi-color LEDs that indicate system status. 

  

LED 1 shows 100 Base-T status  

LED 2 shows 10 Base-T status as follows:   

 

LED 3  is used to indicate whether the Imager is configured.  

 

LED 4  Shows Imager Status 

 

LED 5 Shows Sensor and Encoder Status.  The Sensor has priority over the encoder. 

 

  

LED 6  Shows Capping Station Motor status. 

 

  

IO Events 

Contents 

Define Labels 

IO Events Setup 

IO Events Setup 

The IO Events tab displays a list of events that are configured in the system, and their status (enabled/disabled). An IO Event detects a condition and takes an action
based on that condition.  Every event has a Trigger (condition) and an Action.  A sample list of Events with Triggers and Actions is shown in the figure below. (For 
examples of setting up IO Events with Triggers and Actions see How To: Set Up an IO Event.) 
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Events can be placed in the Main Event Group or in a group that you define. Any number of user-defined groups can be created. For example, in the figure above, the 
“Hardware Input Trigger” and “System Event Triggers” groups contain one (1) and four (4) Events respectively. These Events may or may not be inter-related. Once an 
Event is highlighted, the Modify and Delete buttons are enabled. If the event uses a data source as a Trigger, then the Event is displayed in red and the Select Data 
Field button is also enabled. 

If you choose to create a new Event or modify an existing one, the Event Settings screen appears. 

 

You can assign a Description to each Event as well as assign each Event to a Group. Existing Groups are listed in the drop-down menu for Group Name, or you can 
create a new Group by entering a name in the blank box for Group Name. You can also enter Notes in the box on the right if additional information is necessary. 

When the condition to Trigger or execute an event occurs, the specified Action is performed. There are two types of Actions: 

1. Execute Actions Immediately:  These are performed as soon as the Trigger is received.  

2. Execute Actions in the Specified Order:  These Actions have a number of Actions, or a sequence, specified. As soon as the Trigger is received, the first Action is 
performed. The next Action in the sequence must wait until the previous Action is complete.  

Triggers 

There are seven (7) types of Triggers: 

1. Hardware Input: This type is connected to an Imager input. The Trigger condition may be set as its leading edge (when the input reaches a “high” value) or 
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trailing edge (when the input reaches a “low” value). You can rename Imager inputs and outputs with the Define Labels button.  All six Imager inputs are 
available in this section: 

Inputs 0 and 1: On the first Imager, typically dedicated to the encoder; consult the Imager Settings 

Input 2: On the first Imager, typically dedicated to the Imager Sensor; consult Imager Settings 

Inputs 3 and 4: Free 

Input 5: Dedicated to Cleaning Station Interlock; can be used to trigger an event based on Cleaning Station status 

2. Data Source: You can use this type to trigger an Event when it contains a particular string or when it changes its value. In either case, you must specify a field in
the database as the Trigger field. Data Source Triggers can only have Actions that execute immediately.  They cannot perform Actions in a sequence. 

3. System Event: This type of Trigger cannot be controlled once you have set up the print conditions. The system monitors some internal parameters, and you can
use the values of these parameters to Trigger certain events. For example, on completion of printing (Printing Completed), you might want to park the Imager
(Move to Park). Or in the event of an Error, you might want the system to Stop Printing. 

1. Abort Button Pressed – This occurs when the stop printing button is pressed and auto-abort is checked or when the abort printing button is pressed. 

2. Cleaning – This occurs just prior to sending the “Clean” command to the imager. 

3. Cleaning Completed – This occurs after the cleaning command has completed (success or error – it is received upon receipt of all the imager’s status) 

4. Error – This occurs when any imager error is received if the GUI is not already stopping or has received a prior error (in which case it is stopping). 

5. Finished Printing – This occurs as the last item after printing has stopped – whether by aborting, stopping, error, or normal completion. 

6. In Park Position – This occurs after a move to park and the imager is parked status has been received by the GUI. 

7. In Print Position – This occurs after a move to print and the imager is in print position status has been received by the GUI. 

8. Ink Low – This occurs when the ink low condition has been detected. 

9. Ink OK – This occurs when the ink was detected as low and has been restored to a non-low condition. 

10. Moving To Park – This occurs after the “Move To Park” command has been issued to the imager and is awaiting completion. 

11. Moving To Print – This occurs after the “Move To Print” command has been issued to the imager and is awaiting completion. 

12. Page Printed – This occurs after all imagers have reported a page as being printed. 

13. Print Error – This occurs after any error from the ripping, invalid data, or communications failure. 

14. Printing Aborted – This occurs after the printing was aborted (either by pressing the button or by a system action) and the imagers have been stopped.
This also can occur when a system action of Abort Printing is executed and the GUI is not printing so that sequential actions can continue. 

15. Printing Completed – This occurs after the printing has normally completed. 

16. Printing Started – This occurs when the printing has started. The configuration data has already been sent and the ripping has just started. 

17. Purge (Page-Based) – This occurs after an action of Purge has been detected and executed. This is prior to actually sending the purge page. 

18. Purge Completed – This occurs after a purge page (or the last purge page in a set of pages) has been printed on all imagers. 

19. Ready To Print – This occurs after all imagers have been told to enable print. 

20. Speed Updated – This occurs after every ACK from the imager. 

21. Stop Button Pressed – This occurs when the stop button is pressed. 

22. Stop Printing Requested – This occurs after the PC ripping has been stopped but prior to notifying the imagers to stop printing. 

1. Page Printed Count: This Trigger actually counts the number of pages printed by the jet.engine™ GUI. You can set up the Event to execute after printing a certain 
number of pages, e.g., insert a purge page (Purge,the Action) every 100 pages. 

2. Page Processed Count: With this type of Trigger, the jet.engine™GUI processes a number of pages before it begins to print. The default value is 10 pages. This
value depends on the number of Imager buffers, the number of PC buffers, and whether or not you want an early warning of an impeding event.  

3. Timer Expired: This Trigger specifies an input condition of the expiration of a Timer, as set up in Timer and Counter section, below. 

4. Counters: This Trigger specifies an input condition of the count of a Counter, as set up in Timer and Counter section, below.  The input condition can be set to
entering or leaving the counter Maximum, Minimum, or Threshold. 

Note: In the Page Processed Count Trigger, if the jet.engine™GUI detects a condition within the processed pages that satisfies a Trigger to fire an Event, it will fire 
the Event immediately, even if the page has not been printed. 
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Actions 

You can instruct the system to Execute Actions Immediately or Execute Actions in the Specified Order (sequentially).  

To set up an Action, click on the Add Action button. 

 

There are four types of Actions: 

1. Hardware Output:  

The specified Trigger can turn a Hardware Output ON.  

A Hardware Output can also be pulsed, which means you can specify how long you want it to remain ON (Duration) and/or how long you want to Delay
the Hardware Output before it goes to ON. An Event that has a Data Source as a Trigger must be pulsed.  Consecutive pulses that overlap in duration will 
lock the output for the total duration of the pulses. 

If the Trigger is a Data Source or Page Processed Count, and you set the Hardware Output for Immediate action, you have the option to make the Action
Page Based which means the Action will occur after each page is printed. 

If the Trigger is a Data Source or Page Processed Count, and you set the Hardware Output for Immediate action, you can also request an Early Page 
Offset, and specify the number of pages for when the offset should occur. Using this option means you will receive an early warning (by the number of
pages specified) that a Trigger condition is about to occur for the specified Action. 

2. System Action:  

When you set up a System Action, it overrides the parameters set by the system internally by specifying a Trigger that performs them. For example, if the
Trigger is a system-generated Error, the resulting System Action might be Clear Buffers.  Available System Actions: 

Abort Printing 

Clean 

Clear Buffers 

Insert Purge Page 

Move to Park 

Move to Print 

Spit 

Start Printing 

Stop Printing 
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3.  Timer Action 

Reset, Start, or Stop a Timer defined in the system; see Timer and Counter section, below. 

4.  Counter Action 

Load Counter Minimum, Load Counter Maximum, Load Counter Threshold, Increment Counter, or Decrement Counter on any Counter that has been 
defined as shown in the Timer and Counter section, below. 

For examples of setting up Triggers and Actions, see How To:  Set Up  An IO Event. 

Define Labels 

By selecting the Define Labels button, you can rename the input and output points used in the IO Events.  Define Labels is described in more detail in the Define Labels
section. 

 

Timers and Counters 

Selecting the Timers and Counters button brings up the following dialog which allows the creation and modifying of timers and counters.  For more information, see 
Timer and Counter Overview. 

  

 

Define Labels 

When you are setting up IO Events, you have the opportunity to attach labels to Imager Inputs and Outputs. From the IO Events page either choose New, to set 
up a new event, or, highlight an existing event and choose Modify. 

 

This takes you to the Events Settings screen. 
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 Click on Define Labels. 

 

From the Imager drop-down menu, select the Imager you want to label. The Imager name and its corresponding Inputs and Outputs appear in the box below. You 
can rename any of these items. Simply click once on the item you want to rename, and then either the Rename button on the screen, or F2 on your keyboard.  Type in 
the new name, and click OK to save the new name. 

  

  

Working with Jobs and Configurations 

Jobs 

Jobs are files that hold information and settings that are required to tell the GUI how and where to print what. 

These items are saved in the job file: 

Form Design layout      

Object Properties   

Imager Setup parameters   

sdf 

Refer to the following sections for more information on jobs: 

Open Job 

Save Job 

Save Job As 

Job Notes 

Configurations 

Configurations are a set of files that the GUI uses to save setup parameters not saved in a job file.  You will in most cases never need to handle these files unless you
need to make a back up or transfer them to another PC.  They can be stored and opened through the jet.engine GUI. 

Configurations contain: 
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Refer to the following sections for more about using configurations: 

Load Configuration 

Store Configuration 

  

Open Job 

You can open a previously saved job (.ijj file) either by choosing Open from the File menu, or clicking on the toolbar.  This opens a typical Windows browser from 
which you can locate and Open the job.  

 

  

Job Notes 

You can record notes about a job that you might find useful for future reference. 

From the Edit menu, choose Job Notes. The Job Filename, Page Size, and Data Filename are displayed at the bottom of the screen.  Type in any information you 
think is important. If you want to see this information displayed whenever this job is opened, check the box next to Display Notes on Job Open. 
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Save Job 

This is a typical Windows screen. Use this File menu option to save the current job . 

If the job has previously been saved, simply click on the Save button. 

Otherwise, you need to enter a File name, choose a Save as type, and select a destination on your computer or network. 

 

  

Save Job As 

This is a typical Windows screen. Use this File menu option to save the current job . 

If the job has previously been saved, simply click on the Save button. 

Otherwise, you need to enter a File name, choose a Save as type, and select a destination on your computer or network. 

Page 47 of 146jet.engine GUI Help



 

  

Load Configuration 

If you have saved any Configurations, you can retrieve them from the Load Configuration screen on the File menu. A Configuration from a previous print run 
would include the number of Imagers, how they were set up, Stitching, any IO Events involved, etc. 

 

  

Store Configuration 

You can Store a print run's Configuration for future use. A Configuration would include the number of Imagers, how they were set up, Stitching, any IO Events
involved, etc. From the File menu click on Store Configuration.  Type in a name and click OK. Your stored configuration will appear in the list the next time you click 
on Load Configuration from the File menu. 

 

  

Grid Settings 

Grid Settings, which you access from the Options menu, are enabled only when the Form Design screen is the active screen. 
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The grid is the line of evenly spaced dots that you see across the Form Design screen when the Show Grid option is selected.  These help you align your objects. 

You can set the Horizontal and Vertical Spacing, which changes the distance between the dots. If you want fine spacing, choose a smaller number. If you want 
broader spacing, choose a larger number. 

 Note:  Dots can never be spaced more than .25 inches apart. 

You have the option to Show Grid  and/or Snap Objects To The Grid (the top left corner of the block will always snap to the nearest dot). These two options are also
available as toggle buttons directly from the tool bar on the Form Design page:  Show Grid and  Snap Object To The Grid. 

    

  

  

Dynamic Data Objects 

Contents 

Record Block 

Number Generator 

PDF File 

Dynamic Bitmap 

Field Block 

Data/Time Formats 

Record Block 

A Record Block is used with a data source that has variable data.  For example, you would use a Record Block if you are printing a job containing multiple names and 
addresses.  The Record Block that you set up on the Form Design layout is actually a template that shows how you want the information from the data source to be
printed.  Its contents will change as each record prints.  

With the Form Design layout active, click on the  icon .  A Record Block is inserted at the upper left corner of the layout. You can re-position the block by 
dragging and dropping it, or by using the arrow keys on the keyboard. 
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Before using a Record Block, it is important to know how your data is arranged in your data source. Record Blocks are, by default, nine (9) lines long. Think of a 
Line as a Field .   Here is an example of a how a Record Block  might be set up from a data source with variable data:  

*******************AUTO**3-DIGIT 110 

 Mr. C. Montgomery Burns 

 71 Croesus Ave 

                             Springfield, US  11001-2554 

This record has four (4) lines.  Note that the person's name in this example is one field in the data source.  If your data source has a name divided into different fields,
e.g., first name, last name, etc., you will probably want to use a Field Block, rather than a Record Block, for setting up your print job. 

Your data source may have fewer than, or more than, nine (9) lines.  You can make this change on the Field Block Properties screen.  

You can view the block's Properties  in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

 

If the records in your data source have more or less than nine (9) lines (or fields), you can enter the correct number in the box next to Number of Lines.   

You may want your Record Block to start with a line other than the first line (e.g., if "Mr." is the first line you might not want that included).  In that case, in the box
next to File Record Line #, enter the number of the line where you want the Record Block to start. 

You can change the Font , as well as its style and size, on the Font tab. 

To set the position of the block and other characteristics, click on the Block Properties tab. 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

With all text-based objects, including the Record Block, you have the option to display the data as a Barcode.  If you choose this option, a Barcode Properties tab 
appears from which you can set the print characteristics of the Barcode. 

  

  

Number Generator 

The Number Generator object is used for jobs that require the printing of a sequence of numbers, with each page having a different number.  For example, if you
were printing tickets that have seat numbers on them, you would need to set up a Number Generator so that the tickets are printed with individual numbers in a 
sequence.  

With the Form Design main tab screen active, click on the  icon.  A Number Generator block is inserted  in the upper left corner of the  layout. 
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You can re-position the block by dragging and dropping it, or by using the arrow keys on the keyboard. 

In order to configure the Number Generator you need to access the block's Properties , which you do in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

 

The Start # is the number that will start the sequence, and is limited to 30 characters.  A Start # can be simply a number, or it can contain an alphanumeric 
combination.  In the example above, which could be a Number Generator for printing tickets, the Start # indicates that each ticket will be printed with the word 
"Titans", followed by a (-), then a number.  

The Mask controls the way that each character is handled by the software.  There are four different types of masks controlled by Mask Options. 

1. Counter Digits are the dynamic, or changing, characters in the number.  They will change according to a user-defined formula.  Make sure you allow enough 
blank spaces for the number to sequence properly, or  it will roll back to zero.  Counter Digits are always used in calculating the check digit .  This is indicated 
by a “#” character in the mask box. 

2. Static Characters do not change.  They can be included in the Checksum calculation.  Only numeric characters can be Checksummed.  This is indicated by a 
“+” in the mask box.  A “.” in the mask box means that the static character is not used in the Checksum calculation.  

3. Alpha characters, such as "TITAN" in the example above, generate a Static Character (Not Checksummed) Mask ("."). 

4. The Check Digit is the number that is generated as a result of the Checksum Method selected.  This number can be read by a barcode scanner or OCR reader 
to verify that a code has been properly printed and read. 

Weighting allows more sophisticated Checksum calculations to be used by giving more "weight" to certain numbers.  

Once you determine your numbering format , you can set up the method for sequencing the numbers.  The number will increase (or decrease) based on the values
entered into the Count/Every boxes.  The format for the values in these boxes is two numbers, separated by a forward slash (“/”).  The first number is the amount 
that the counter increases when the record is seen. The second number is the number of records that must be seen to trigger an increase. In the Count/Every
example above, 2/1, the number will increase by 2 for each (1) record.  So, if the first number is "TITANS-0001", the next number is "TITANS-0003", then 
"TITANS-0005", and so on. 

Negative values can also be used.  If the Count/Every value is "–2/1", the number will decrease by two for every record it sees.  So, if the first number is "TITANS-
0300", the next number would be "TITANS-0298", then "TITANS-0296", and so on. 

You can set up quite complex counting patterns.  For example, suppose you need to cycle through the same 1000 serial numbers continually.  By entering ‘1/1’ and ‘-
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1000/1000’ the number will increase by one every time until it gets to one thousand.  At that point, it will decrease by one thousand, thus returning to the start.  Since
you can enter up to ten values, you can do quite sophisticated counting. 

Further, the Counting Options box allows choosing between Use Page Number Printed or Use Record Number to determine how to increment the numbers on copies of 
the same page, if Multiple Copies is enabled. 

The Checksum Method and Modulus pull-down menus work together to calculate the Checksum digit in a variety of ways. 

    

DR-Divide, use Remainder takes the numeric string that comprises the Checksum (the number whose Mask is #)  and divides it by the Modulus number.  
Discard the quotient and keep the remainder.   For example, if the string value is 1257 and the Modulus operator is 8, the calculation is as follows: 1257 mod 8 
= 1257/8 = 157 R 1.  Discard the 157 and the resulting Checksum digit is 1. 

DSR-Divide, Subtract Remainder is similar except that the remainder is subtracted from the Modulus number.  For the number 1257 used in the example 
above, the remainder 1 is subtracted from the Modulus 8, resulting in a Checksum digit of 7. 

ADR-Add Digits, Divide Remainder takes the digits in the Checksum number and adds them together.  It divides the result by the Modulus number and 
uses the remainder.  So, 1+2+5+7 = 15, 15 mod 8 = 15/8 = 1 R 7.  Discard the 1 and the Checksum is 7. 

ADSR-Add Digits, Subtract, Divide Remainder is similar to the above method, except that the remainder is subtracted from the Modulus number.  Using 
the example above, the remainder 7 would be subtracted from the Modulus 8, resulting in a checksum of 1. 

A Checksum generator for Code 128 B Barcodes, a common barcode, is also provided. 

You can change the Font , as well as its style and size, on the Font tab. 

To set the position of the block, and other characteristics, click on the Block Properties tab. 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

With all text-based objects, including the Number Generator, you have the option to display the data as a Barcode.  If you choose this option, a Barcode
Properties tab appears, from which you can set the print characteristics of the Barcode. 

  

  

PDF File 

The PDF File (Portable Document Format) capability is a function that is licensed from Printing Technology Services, Inc., and requires a key for you to use it.  To
obtain a key contact Printing Technology Services, Inc. at info@printingtechnology.net. 

There are two instances in which you might use a PDF file:  either you have constructed a PDF file with variable data in it, or you have a PDF file with which you want to
print variable data (i.e., you want to overlay parts of the PDF file with variable data, or you want to print the PDF file with variable data next to it). 

To insert a PDF File, make the Form Design screen active, and  click  on the tool bar. A PDF Block is inserted in the upper left corner of the layout.  

 

You can re-position the block by dragging and dropping it, or by using the arrow keys on the keyboard. 

In order to load a PDF File, you need to access the block's Properties , which you do in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 
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To locate a PDF File, click on the button at the right edge of the PDF File Name box.  This opens a typical Windows browser from which you locate a file. Once you
select a file, you see that the PDF File Information for that file (Number of Pages, Page Height and Page Width) is automatically displayed. 

You have two options for PDF Printing.  If you choose Single Page, and enter the number of the page to print, the system will print the same page repeatedly.   If 
you choose Multiple Pages, and enter the number of the page where you want the printing to start, all pages in the PDF File from that point will be printed. 

From the PDF Appearance tab, you can determine how the PDF File appears on the Form Design layout. 

 

To set the PDF Position, you enter values in the Left and Top boxes.  

You can Crop , or delete portions of, the PDF File, using the Crop from boxes. For example, if you want to delete the bottom inch of your PDF File, simply enter "1" 

in the Bottom box. You can also crop the PDF File directly on the Form Design layout.  Click once on the PDF File block to select it.  On the tool bar, click on , 
the Crop button.  Then, using the blue handles on the edges of the block, and holding down the left mouse button, Crop the block. 

  

Dynamic Bitmap 

The Dynamic Bitmaps feature gives you the ability to use an assortment of bitmaps during a print run. 

With the Form Design screen active, click on the  icon in the toolbar. The Dynamic Bitmap block will be inserted in the upper left corner of the  layout.  You can 
re-position the bitmap by dragging and dropping it, or by using the arrow keys on the keyboard. 
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You can view the dynamic bitmap's Properties  in one of three ways: 

Double click on the bitmap. 

Click once on the bitmap, and then click the  icon in the toolbar. 

Right click on the object, and select Properties from the menu. 

 

If you check the box next to Transparent, then the non-black portions of a bitmap become transparent. 

You can select whether to Truncate bitmap to fit in block or to Auto-Size bitmap to fit in block. 

Dynamic Bitmap List:  

To add each bitmap, click on Add Bitmap. This opens the Select Bitmap Files window, which works like any Windows file browser.   
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Simply select the .bmp file and click Open, or double-click on the .bmp file name. The bitmap will be added to the list.  Repeat this action until you have added all the
bitmaps.  You can see on the Properties screen above that each bitmap selected is connected to a field in your data source and a criterion specified for that field.
When a field criterion for a given bitmap matches the value in the data source, that bitmap will be printed. You can size the bitmap manually by changing the "X" and
"Y" Resolution number in the respective fields. 

If you want to remove a bitmap from the list, click once in the block to the left of the row that contains the bitmap you want to delete.  This will highlight the entire row.
Then click on the Remove Bitmap button. 

 

Field in Data File:                       

Enabling this "Field in Data File" allows you to select a folder containing multiple bitmap and reference what bitmaps you want to print using a field in a database. Under

"Graphic File Folder" click on the  button, once you have selected the folder containing the bitmaps select a field in the database containing the names of
the bitmaps you want to print.  

You can size the bitmap manually by changing the "X Resolution"  and "Y Resolution" number, (shown above). 

 

To select the field that contains the bitmap names; click on the "Data Field Containing File Name" drop down and select the desired field. 

 

From the Dynamic Bitmap Properties tab, you can change the Dynamic Bitmap Position by entering values in the Left and Top edit boxes.  

If you check the box next to Position Is Locked, then the bitmap can no longer be moved around in the layout window. 
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You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

The Object Properties tab allows you can give a unique name to the object you have created.  You can also indicate in the checkbox whether or not the Object is 
Printable. 

Field Block 

Field Block Properties Tab: 

In a Field Block, you can arrange the display of data from a data source .  You can also intersperse fixed text with the fields from the data source.  

Once you have loaded the data source (see Load Data), and with the Form Design screen active, click on the  icon to place the Field Block in the layout. The block 
will be inserted at the upper left corner of the layout.  You can re-position the block by dragging and dropping it, or by using the arrow keys on the keyboard. 

A Field Block can contain data from a data source or can be fixed text.  To load a data source file, click on the Load File button.  Your data will appear in the bottom of 
the window.  You can place a field into the preview window by clicking on the column heading, and then clicking the Add Field button.  To add fixed text, simply type
directly in the preview window itself. 

 

You can choose to make a Field Block either rich text format (RTF) or non-RTF. The picture above shows a non-RTFField Block in the preview window. You see that 
all the data is in the same font style and size, and all text has the same characteristics. An RTF Field Block, however, allows different font styles, sizes, and 
characteristics within one block as shown below. 
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If you decide to make the block RTF (by checking the Rich Text Format box), a tool bar appears above the preview window from which you can choose different font
characteristics, as well as the font and its size. 

If you decide not to make the block RTF, then you select the font, its characteristics and font size from the tool bar on the Form Design layout page. 

The relative position of the fields is shown in the preview window. You can see what the actual data will look like by checking the Preview Data box. The fields for the 
first record in the list will be previewed. 

If you have chosen not to use the RTF format, you have the option to Remove Blank Lines by checking that box.   You can also elect to Remove Leading 
Whitespace from Fields and Remove Trailing Whitespace from Fields.  If you have chosen a non-RTF format, you also have the option to Remove Leading 
Whitespace from Lines and Remove Trailing Whitespace from Lines. 

Block Properties Tab: 

To set the position of the block and other characteristics, click on the Block Properties tab. 

Transform Tab: 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

Barcode Properties Tab: 

With all text-based objects, including the Field Block, you have the option to display the data as a Barcode .  If you choose this option, a Barcode Properties tab 
appears from which you can set the print characteristics of the Barcode. 

Object Properties Tab: 

The Object Properties tab allows you can give a unique name to the object you have created.  You can also indicate in the checkbox whether or not the Object is 
Printable. 

Add Function Fields Selection: 

You have several additional options in the Add Function drop-down menu. 
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1. You can Add or Edit Date/Time Formats. 

 

Click here for: More information on Date/Time Formats 

2. You can insert the current record number into the Field Block as a field by choosing Add Record Number as in the example above. 

 

3. You can Add Page Number into the Field Block  

 

4. You can Add or Edit String Function into the Field Block  
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5. You can Add or Edit Random Function into the Field Block specifying the minimum and maximum numeric value  

 

6. You can Add or Edit Counter Function into the Field Block 1 digit count, 2 offset and 3 page to page offset. 

 

  

Advanced Add/Functions:  

 Note: Advanced Function categories are only available when logged in to Developer Mode. 

 

Add Function Select/Developer Mode: 

The following are more options that are available in the Add Function drop-down menu when you are in "Developer" Software Mode. 
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1. You can insert the horizontal resolution setting into the Field Block so it will display as a field by choosing Add Horizontal Resolution.  

    <<HORIZONTALDPI()>>  Example: 300 

2. You can insert the vertical resolution setting into the Field Block so it will display as a field by choosing Add Vertical Resolution.  

    <<VERTICALDPI()>> Example: 300 

3. You can insert the vertical density setting into the Field Block so it will display as a field by choosing Add Vertical Density.  

    <<VERTICALDENSITY()>> Example: 100% 

4. You can insert the print speed setting into the Field Block so it will display as a field by choosing Add Print Speed.   

    <<PRINTSPEED()>>  Example: 0.00 

USPS Barcodes: 

Check the appropriate box to choose the type of USPS Barcode you would like to include. 

 

If you want to include a Postnet Barcode, a Planet Barcode  or an Intelligent Mail Barcode simply click to check the Include box. 

The screen that opens for Edit Postnet, Edit Planet and Edit IMB is the same screen, the button you select will show the category you are setting at the top left of the
settings box. 

     

 

  

* Click this "Advanced Barcode Settings" link for a detailed description of Intelligent Mail Barcode ("IMB")* 

  

  

Date/Time Formats 

You can insert a Date/Time Stamp anywhere in a Field Block . 

From the Field Block Properties screen, click on the Add Function drop-down menu, and select Add or Edit Date / Time. 
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This will open the Date/Time Formats window. 

 

From the list of possible formats on the left side of the screen, decide on the one you’d like to use, and type the Character for that format into the Date/Time 
Format box.  You can see a sample of the format by clicking on the Test Format button.  The sample appears in the Test of Format box as in the example below.  
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Entering a value for the Day Offset or Month Offset will cause the displayed date to be advanced by the amount entered. 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

The Object Properties tab allows you can give a unique name to the object you have created.  You can also indicate in the checkbox whether or not the Object is 
Printable. 

Fixed Data Objects 

Contents 

Indicia 

Fixed Bitmap 

Message Line 

Indicia 

Indicia are similar to Message Lines, except that they must be formatted within guidelines specified by the United States Postal Service in its Domestic Mail Manual. 
This manual is available online at http://pe.usps.gov/text/dmm/DMMTC.htm.  The Indicia provided with the software is a template that you need to edit in order to
comply with USPS regulations. 

With the Form Design layout active, click on the  icon.  The Indicia block is inserted at the upper left corner of the layout.  You can re-position the block by 
dragging and dropping it, or by using the arrow keys on the keyboard. 

 

You can view the block's Properties  in one of three ways: 

Double click on the block. 

Click once on the block and then click the  icon in the toolbar. 

Right click on the block and select Properties from the menu. 

Indicia Tab: 

 

You can edit the Indicia text by simply typing the desired text/numbers in the box, (shown above). 
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Font Tab: 

You can change the font , font size, and font style on the Font tab. 

 Click here for description of Font Tab: 

Block Properties Tab: 

You have more options on the Block Properties tab. 

 

You can position the Block Position on the Form Design layout by entering values in the Left and Top boxes.  You can size the block entering values in the Width and 
Height boxes. You can also set the Horizontal and Vertical position of the text within the block. 

Checking Word Wrap will keep the text from running outside the block. If you check the box next to Transparent , then the non-black portions of a bitmap become 
transparent.  The bitmap can no longer be moved around in the layout window if you check the box next to Position Is Locked. 

Resize text when box size changes means that if the size of the block is changed, the size of the font will change proportionally. However, this is true only if you
resize the block from the corner.  If you resize the object from the top or bottom, the text size will not change.  

Checking Automatic Font Sizing will automatically adjust the font size. 

You can also have the system Generate error if text exceeds borders. This means that if any of the text exceeds the boundaries of the object, you will receive an
error during printing.  If you do not choose this option and the condition occurs, text will appear truncated or cut off. 

You can change the Character Pitch by entering a number in the Character Pitch/Points field. 

You can choose the default Line Spacing or un-check the default check box and enter in a numeric value for the line spacing desired. 

Transform Tab: 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

  

Fixed Bitmap 

A Fixed Bitmap is one which cannot be changed. You can add a Fixed Bitmap to the Form Design screen by clicking on the  icon.  This opens the Select 
Bitmap Files window, which works like any Windows file browser.   
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Simply select the .bmp file and click Open, or double-click on the .bmp file name. The bitmap will be inserted at the upper left corner of the Form Design layout.  You 
can re-position the bitmap by dragging and dropping it, or by using the arrow keys on the keyboard. 

You can view the bitmap's Properties  in one of three ways: 

Double click on the bitmap. 

Click once on the bitmap, and then click the  icon in the toolbar. 

Right click on the object, and select Properties from the menu. 

 

From the Fixed Bitmap window, you can change the Bitmap Position by entering values in the Left and Top edit boxes.  If you check the box next to Position Is 
Locked, then the bitmap can no longer be moved around in the layout window. 

If you check the box next to Transparent , then the non-black portions of a bitmap become transparent. 

Bitmaps cannot actually be resized in the GUI. You have to use Microsoft Paint or a similar application to do that.   However, if the box next to Allow Sizing is checked, 
you can change the Scaling of the bitmap in one of three ways: 

You can enter Absolute (specific) Width and Height values. 

You can enter Scaling percentages in the Width and Height boxes. 

You can enter DPI (dots per inch) X Resolution and Y Resolution values. 

If you check the Lock Aspect Ratio box before you make changes, the scaling changes proportionally. For example, if you change the Absolute Width to 1.5, the 
same value is automatically entered for the Height.  If you change the Scaling percentage to 150% for the Width, the Height automatically changes by 150% as 
well.  If you change the X Resolution value to 600, then the Y Resolution is automatically changed to 600, too. 
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You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

  

  

  

Message Line 

A Message Line is a block of fixed text that you have created. With the Form Design layout active, click on the  icon. The Message Line block will be inserted at 
the upper left corner of the layout.  You can re-position the block by dragging and dropping it, or by using the arrow keys on the keyboard. 

 

You can enter your text through the Message Line Properties screen. 

You can access the block's Properties  in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

  

 

  

On the Message Line tab, simply type your text in the box. 

Choose the Font and its characteristics from the Font tab. 

Set the Block Properties of your block (e.g., the position of the block on the Form Design layout, the position of the text within the block, the block border, etc.) on 
the Block Properties tab. 

To Transform the block during printing, use the Transform tab. You will also see the rotation change on the Form Design screen. 

With all text-based objects, including the Message Line block, you have the option to display the data as a Barcode.  If you choose this option, a Barcode
Properties tab appears from which you can set the print characteristics of the barcode. 

  

Barcodes 
  

Advanced Barcode Settings 

Barcode Properties 
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USPS Postal Barcodes 

Postnet Barcode 

Planet Barcode 

Intelligent Mail Barcode 

Barcode Properties 

With some text-based blocks, you have the option to display the block as a barcode. You do this by opening the Properties dialog in one of three ways: 

Double click on the object. 

Select the object, and click the  icon. 

Right click on the object, and select Properties from the menu.  

In the box Display Type you can choose either Text or Barcode. 

 

If you check the button next to Barcode, you'll see that a Barcode Properties tab appears. This page is used to define a Barcode Type and its properties. 

 

First, choose a Barcode type from the drop-down menu (see Postnet Barcode for information on using that type). From the Text box, you have the option to Print 
text with the Barcode. You can also elect to place  Text above the Barcode and set the Text Distance in 1/1000 mm increments. 

 

For information on the settings on the bottom of the Barcode Properties screen, (shown above), click the following link to see Advanced Barcode Settings
section. 

The Barcode types that are selectable from the "Barcode Type" Menu are shown (below). 
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 Intelligent Mail Barcode  

              

Intelligent Mail Barcode is selectable in multiple ways using the Field Block Properties dialog setup screen. 

  

Selecting "Include Intelligent Mail Barcode"/Using Barcode "Display Type" & Choosing "Barcode Type":  

In the example, (shown below), the IMB data is being selected from 5 separate fields in the job schema, and is set up by selecting the 

 radio button,  

then under the  tab, and choosing , next choose the options and job parameters for the 
IMB  

barcode. (See IMB field layout description shown below) 

Page 67 of 146jet.engine GUI Help



 

  

Once you have set the Intelligent Mail Barcode options and job parameters for the IMB barcode you need to select the job field (s) that contain the barcode data that 
you want to print. In the example, (below) the barcode data is being selected from five fields. Under the Field Block tab you would select the Barcode ID field and click 
Add Field, next select the Service Type field and click Add Field,  next select the Mailer ID field and click Add Field,  next select the Serial Number field and click Add 
Field,  last select the Routing Code field and click Add Field, now the field (s) that you selected show up in the Field Block Properties display, (shown below). 

  

  

 Note: In the Field Block Properties screen, you also have access to several "USPS Barcode" options.  
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Selecting "Include Intelligent Mail Barcode"/Using "USPS Barcodes":  

In this example we are selecting "Include Intelligent Mail Barcode" under "USPS Barcodes" section of the setup screen. 

 

 On the right-hand side in the USPS Barcodes section, check Include IMB, and then click on the  button to set up the IMB Barcode parameters. From 
this setup screen, (shown below), you can specify the job setup parameters and choose the data field (s) in the job schema that you parse the IMB barcode data from. 

 

From this screen, you can position the IMB Barcode to appear either at the Top or Bottom of a Field Block. 

You have the same pre-set Bars Per Inch and Shaving options described above, as well as several others.  

You also have the option to Allow Blank Data.  If this box is left unchecked, then, when a record occurs which does not have a zip code, an error is generated
according to the Trigger and Action set up in IO Events for such an occurrence. 

 Note: Checksum Field has only one option for IMB: Always choose the Automatic Detection radio button for IMB. 

In this example the IMB data is being selected from 5 separate fields in the job schema.  Using the drop down menus In the Start/End Fields box, you choose which 
Field (s) to use to start the IMB Barcode, and which Field to use to end the IMB Barcode. The drop-down menus for the Fields list the names of all Fields in the 
data source. In this case, to print the full zip code from all 5 fields the Start Field would be Barcode ID , and the End Field would be Routing Code.   

 

 (See the Intelligent Mail® barcode for Large Mailers in Figure 1 layout example below) 

 If the IMB barcode is broken up into more than one field. These fields must be listed in consecutive fields in the job schema.  

The first two examples, (above), are using an IMB that has 5  individual fields. If the IMB is configured in 5 separate fields 

1. In the first field you will always have a 2 digit field which contains the Barcode ID  

2. In the second field you will always have a  3 digit field named Service Type ID  

3. In the third field you will have a 6 or 9 digit field named Mailer ID (Large Mailers use 6 digit and Small mailers use a 9 digit Mailer ID) 

4. In the fourth field you will have a 6 or 9 digit field named Serial Number (Large Mailers use 9 digit and Small mailers use a 6 digit Serial Number) 

5. In the fifth field you will have 4 choices for the Routing Code, the routing code will always be specified as: 

None, (Blank field) 

5 Digit 

9 Digit or  

11 Digit.  
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 Note: If the 5th field, ("Routing Code"), is any length other than the four choices allowed a Barcode Error screen will pop up. 

  

 Note: The IMB Format for "Smaller Mailers" swaps the number of characters required for the Mailer ID and the Serial Number fields. 

  
(See the Intelligent Mail® barcode for Small Mailers in Figure 2 layout example below) 

  
  

Selecting a "Intelligent Mail Barcode" from a Single Field in the schema using "Barcode" "Display type":  
  

Select the radio button, then under the  tab, choose ,  next choose the 
options and job parameters for the IMB barcode. 

 

  
Once you have set the Intelligent Mail Barcode options and job parameters for the IMB barcode you need to select the single job field that contains the barcode data
that you want to print. The characters in the IMB field must be 20, 25,29 or 31 characters.  
  
 In the example, (below) the barcode data is being selected from one field. Under the Field Block tab select the Intelligent Mail Barcode field and click Add Field, now the 
field that you selected shows up in the Field Block Properties display, (shown below). 
  

 Note: If the single IMB field is any length other than 20,25,29 or 31 characters allowed a Barcode Error screen will pop up. 
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 Note: An "Intelligent Mail Barcode" can also be selected from a Single Field in the schema by selecting "Include Intelligent Mail Barcode" under the 
"USPS Barcodes" select section. 

  

Selecting a Static "Intelligent Mail Barcode"using "Barcode" Display type:  

 

It is also possible to print the same IMB barcode on every piece by typing in the barcode digits manually in the dialog setup screen. Note; As is the other examples, the 
only amount of accepted characters for an IMB are 20, 25,29 or 31 characters. 

After typing in the digits desired, select the radio button, then under the  tab, choose 

, now the barcode will be printed from the barcode digits you entered manually in the dialog setup 
screen.  

  

"IMB", ("Intelligent Mail Barcode" Symbology), information overview.   

USPS deadline for availability is December 2008.   

The Intelligent Mail barcode, (IMBC), is the term the United Stated Postal Service (USPS) uses for the new barcode symbology used to track and sort letters and 
flats.  It contains a suite of services, including the Confirm® Service, which is referred to as OneCode Confirm™, and the Address Change Service™, which is 
referred to as OneCode ACS™.  The IMBC is 31 digits in length and consists of five distinct portions, with the last being the 11-digit routing ZIP Code.  The IMBC 
differs visually from the POSTNET because it consists of four bar types: ascending (above horizontal), descending (below horizontal), full length (spans above and
below horizontal) and a short bar. 

Intelligent Mail combines the information of both the POSTNET and PLANET symbols, and additional information, into a single barcode that is about the same size as
the traditional POSTNET symbol.  Automation Discounts for the use of Intelligent Mail barcodes have been supported since March 2007.   

Currently, the use of the Intelligent Mail barcode is optional; however because it offers significant advantages, it makes good business sense to implement this new
symbol today.  The USPS plans to require the Intelligent Mail barcode to qualify for automation discounts beginning January of 2009.   
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 Note: USPS has not finalized the IMB rules and finalized dates have not been determined yet.  Any specific details given in these  descriptions are still subject to 
change. 

The Intelligent Mail® barcode  

The Intelligent Mail® barcode is a height-modulated barcode that encodes up to 31-digits of mailpiece data into 65 vertical bars using 4-state symbology (ascender, 
descender, tracker and full bar). 

Key specification tolerances: 

• Overall barcode length between 2.667 and 3.225 inches. 

• Overall barcode height between 0.125 and 0.165 inch. 

• Vertical barcode clearance at least 0.028 inch; horizontal barcode clearance at least 0.125 inch. 

Other physical characteristics are the same as POSTNET™ and PLANET Code® barcodes. Appendix A contains the Intelligent Mail barcode specification tolerances. 

The Intelligent Mail barcode consists of a 20-digit Tracking Code (Barcode ID, Service Type ID, Mailer Identifier (MID), and Serial Number) and up to 11-digit 
Routing Code (Delivery Point ZIP Code). Depending on mail volume and services selected, the Intelligent Mail barcode construct will change as seen in the figures
below. 

 

 

The following fields are embedded within the Intelligent Mail barcode: 

• Barcode ID identifies the presort makeup in conjunction with an Optional Endorsement Line. 

• Service Type ID identifies special services requested (OneCode Confirm™ and/or OneCode ACS™) or Mail Class when used for automation rate discount without
any services. 

• Mailer ID is a 6-digit or 9-digit number that uniquely identifies the mail owner or mailing agent. 

• Serial Number can uniquely identify the mailpiece or mailing. 

• Routing Code must contain Delivery Point ZIP Code from CASS (Coding Accuracy Support System) certified software in order to obtain automation rate discount. 4 

INTELLIGENT MAIL BARCODE CONSTRUCT 

The Intelligent Mail barcode carries a data payload of up to 31 digits comprised of the following elements. 

 

 Note: For more information on Intelligent Mail® Barcode see the "USPS Intelligent Mail® Barcode Technical Resource Guide", available on the internet at the 
following location: http://ribbs.usps.gov/ONECODESOLUTION/USPSIMB_Tech_Resource_Guide.pdf 

  

Postnet Barcode                            
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A Postnet Barcode is a graphical representation of a US Postal Service Zip Code. You can configure a Postnet Barcode from the Properties screen for either a Record 
Block, a Field Block, a Number Generator, or a Message Line. 

A block's Properties can be accessed in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

Include Postnet Barcode Using "Display Type" Menu: 

On the "Display Type" setup screen you can choose either Text or Barcode, choose "Barcode". 

  

Once you have checked the Barcode radio button, you will see a new tab titled . Click on this tab, and from the "Barcode Type" drop-down menu 

 select a PostNet Barcode. 

PostNet Barcodes are named with a number.  This number tells you the number of digits represented in the barcode. For example, PostNet5 represents a typical 5-
digit zip code and PostNet9, (shown above),  represents a 9-digit zip code. 

PostNet Barcodes may have additional numbers called Checksum digits. These additional digits actually represent numeric calculations that insure the validity of the
data represented by the barcode.  So, you will find PostNet6, PostNet10 and other PostNet Barcodes as options in the drop-down menu, (shown below). 

 

  

 Note: When using an embedded PostNet Barcode, keep in mind when designing your form that clear zones around the barcode are strictly 
enforced. 

 

After selecting a PostNet Barcode, you'll see that you now have a set of Predefined PostNet Options and other job setup settings available to you. This is the 

Page 73 of 146jet.engine GUI Help



easiest way to make changes in the characteristics of a PostNet Barcode. (See below for additional information on editing a PostNet Barcode from a Field Block.) 

Bars Per Inch can be re-set at pre-determined measurements for Narrow or Wide. Normal is the default.  You can also make the bars smaller by selecting one of 
the Shaving options shown.  This lets you "shave" some of the width from the barcode. This can be useful in dealing with ink bleed. You can also use Bars Per Inch
and Shaving in combination. 

If you check the Custom button for either Bars Per Inch or Shaving, the Advanced Barcode Settings at the bottom of the screen become available to you. 

You also have the option to Allow Blank Data.  If this box is left unchecked, then, when a record occurs which does not have a zip code, an error is generated
according to the Trigger and Action set up in IO Events for such an occurrence. 

Once you have set the Postnet options and job parameters for the Postnet barcode you need to select the job field (s) that contain the barcode data that you want to 
print. In the example, (below) the barcode data is being selected from two fields. First under the Field Block tab you would select the Zip Code 1 field and click Add 
Field, then select the Zip Code 2 field and click Add Field, the field (s) that you select will show up in the Field Block Properties display. 

 

 Note: In the Field Block Properties screen, you have access to additional USPS Barcode options using the "USPS Barcodes" Menu.  

Include Postnet Barcode Using "USPS Barcodes" Menu: 

On the right-hand side under USPS Barcodes, click the check box to "Include PostNet", and then click on the  button. 

 

This opens up the Edit Postnet screen, In this screen you choose which Field to use to start the PostNet Barcode, and which Field to use to end the PostNet 
Barcode. The drop-down menus for both Fields list the names of all Fields in the data source . 
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Depending on the data source you are using for your print job , it's possible that the zip code is broken up into more than one Field. In the example above, you have a  
Field named Zip Code 1 that includes the 5-digit code, and a  Field named Zip Code 2 in the same data source that includes the 4-digit zip code extension.  In this 
case, to print the full zip code, the Start Field will be Zip Code 1, and the End Field will be Zip Code 2.  If you want to print only the 5-digit zip code from that same 
data source, the Start Field would be Zip Code 1 and the End Field would also be Zip Code 1. 

You have the same pre-set Bars Per Inch and Shaving options described above, as well as several others. 

From this screen, you can position the PostNet Barcode to appear either at the Top or Bottom of a Field Block. 

Checksum offers you three options: 

1. If you choose Included in Data (None), the record data will contain the Checksum character.  If it is not found, an error will be generated.  

2. If  you choose Automatic Detection, and the data requires it, the software will add a Checksum. Otherwise, if Checksum is found in the data, it will use that 
Checksum.  

3. If you choose Calculated (Postnet), the PostNet Checksum will always be added.  If one is already there, it will generate an error. 

  

 PLANET Barcode                    

   

PLANET barcodes are required by the USPS for use with their CONFIRM service, which provides confirmation that customers received the mail.  As a complement to
Postnet barcodes, they can be used by mailers to synchronize telemarketing programs with direct mail campaigns. 

A PLANET barcode can have either 12 or 14 digits. You can select a PLANET Barcode from the Properties screen for either a Record Block, a Field Block, a Number 
Generator, or a Message Line. 

You access a block 's Properties  in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

Include Planet Barcode Using "Display Type" Menu: 

On the Properties setup screen you will find a box on the screen titled Display Type from which you can choose either Text or Barcode radio button. 

 

Check the Barcode radio button. You'll see a new tab appear titled . Click on this tab, and then from the Barcode Type drop-down menu, (shown 
below), select either 12 or 14 digit  PLANET Barcode.   
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Once you have chosen a PLANET Barcode, you'll see that you now have a set of Predefined PLANET Options available to you. This is the easiest way to make 
changes in the characteristics of a PLANET Barcode. 

Bars Per Inch can be re-set at pre-determined measurements for Narrow or Wide. Normal is the default.  You can also make the bars smaller by selecting one of 
the Shaving options shown.  This lets you "shave" some of the width from the barcode. This can be useful in dealing with ink bleed. You can also use Bars Per Inch
and Shaving in combination. 

In the Predefined PLANET Options, the module width, print ratio and shaving percent values for the barcode are optimized to assure that each bar and space of the
printed barcode are the same size (the same number of pixels wide). 

If you check the Custom button for either Bars Per Inch or Shaving, the Advanced Barcode Settings at the bottom of the screen become available to you. 

You also have the option to Allow Blank Data.  If this box is left unchecked, then, when a record occurs which does not have the PLANET Barcode data, an error is 
generated. 

After choosing the Planet Barcode you need to select the job field that contains the barcode data that you want to print. In the example, (below), you would select the 
Zip Code 1 Field and click Add Field, the field that you select will show up in the display. 
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 Note: In the Field Block Properties screen, you also have access to several USPS Barcode options.  

  

Include Planet Barcode Using USPS Barcodes Menu: 

On the right-hand side under USPS Barcodes box section, check Include Planet, and then click on the  button to set up the Planet Barcode
parameters. An Edit Planet setup screen will appear, from this setup screen you can specify the data field in the job schema that you parse the planet barcode data
from. 

 

In the Edit Planet display setup screen, (shown below), you will choose which Field to use to start the Planet Barcode, and which Field to use to end the Planet 
Barcode. The drop-down menus for Zip Code Fields list the names of all Fields in the data source . In this case if you want to print the Planet zip code, the Start 
Field would be Zip Code 1, and the End Field would be Zip Code 1.   

 

  

 

You have the same pre-set Bars Per Inch and Shaving options described above, as well as several others. 

From this screen, you can position the Planet Barcode to appear either at the Top or Bottom of a Field Block. 

  

Checksum offers you two options: 

1. If you choose Included in Data (None), the record data will contain the Checksum character.  If it is not found, an error will be generated.  

2. If  you choose Automatic Detection, and the data requires it, the software will add a Checksum. Otherwise, if Checksum is found in the data, it will use that 
Checksum.  

  

Advanced Barcode Settings 

With some text-based blocks, you have the option to display the block as a Barcode (see Barcode Properties for information on choosing Barcode as a display type.) 

The following Advanced Barcode Settings are available on the bottom portion of the Barcode Properties screen.   

 Note:  For Postnet Barcodes, these settings only become available if you choose Custom in the Predefined Postnet Options box. 
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If you check Allow Blank Data, the jet.engine™ GUI will not generate an error when blank data is used. 

You can check Translate escape sequences if you are using non-printable or special characters in the barcode.  If this box is enabled, it tells the system that escape
sequences (like \n) are to be translated (Default: no). The use of escape sequences is useful if you need to encode control characters like Carriage Return or FNC1 into
the barcode.  If you want to use non-printable or special characters in your barcode, you have to use escape sequences. They always start with a backslash ("\")
followed by the sequence. You can use them also for encoding binary data (bytes) into your barcode (if the symbology you are using offers this feature, e. g. PDF417 or
Data Matrix). 

If you check Allow only numbers, only numbers in the data will be printed in the barcode.  For example, if this box is checked, and the 9-digit zip code "55555-1111" is 
in the data file, the hyphen will not print in the barcode. 

Optimize for Resolution - optimizes module width to printer resolution:  If this box is enabled, the module width of the barcode will be calculated to the nearest lower
pixel integer to prevent loss of quality. 

Module width:   You can set the module width by entering a value (in 1/1000 mm increments) in the box.  

A barcode is divided into individual "modules " - the smallest unit of the bar segments. The Module width functions as fundamental unit, i.e., all lines and spaces are 
based on this adjustment. The Module width is calculated automatically, based on the width of the blue bounding rectangle, or can be set to a specific value. It also
depends on the number of utilizable data characters to be encoded. Depending upon the printer or image resolution, the lower limit for the Module width may be 
exceeded, leading to unreadable barcodes (a module width < 1 Pixel). Make sure that the barcode bounding rectangle is as wide as necessary. 

Shaving percent:  The bar is reduced by the percent you enter here. For example, entering a 10 reduces the bar by 10 percent. 

Format /subset:  Format is like a "picture" specification for formatting the barcode data prior to printing it. 

Guard width:  The Guard bar is a horizontal line, which limits the barcode on the upper and lower side. If the value is not set to zero (standard), the Guard bar is 
printed. Values larger than zero indicate the width of the Guard bar in 1/1000 mm. For some barcode types (like UPC and EAN), the value must be zero. 

Notch height:  This sets the height at which the synchronization bars protrude from the barcode, e.g., the double lines within EAN (the European standard)  on the left,
centrically and on the right side. 

Generate check digit: If this box is enabled, a check digit will be included in the barcode. For non-Postnet Barcodes, the choices are Standard (the default choice) or 
None.  For Postnet Barcodes, the choices are Automatic (the default choice), Postnet, or, with some, None. 

  

Barcode Format Overview 

  

This page supplies an overview of the supported barcodes, standard print ratios, and standard check digit methods. 

  

  

Barcode Name Name of the barcode symbology 

Print Ratio Standard Print Ratio of the barcode. Predefined corresponding to the barcode 
symbology. 

Ratio Format 
String 

Format of the Print Ratio. Helpful to understand the definition of the Print 
Ratio. 

xB (1B, 2B, ...)            width of the single Bars 

xS (1S, 2S, ...)            width of the single Spaces (also called gaps) 
Check-Digit Enumeration of the pre-selected check digit method for each barcode 

symbology. 
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Bar Code Name Print Ratio Ratio Format 
String 

(Ratio Hint) 

Check 
Digit 

Not a valid type ------- --------   
Code 11 1:2.24:3.48:1:2.24 1B:2B:3B:1S:2S None        
Code 2 of 5 
(Standard) 

1:3:4.5:1:3 1B:2B:3B:1S:2S None        

Interleaved 2 of 5 
Standard 

1:3:1:3 1B:2B:1S:2S None 

Code 2 of 5 IATA 1:3:1 1B:2B:1S None 
Code 2 of 5 Matrix 1:3:4.5:1:3 1B:2B:3B:1S:2S None 
Code 2 of 5 Data 
Logic 

1:3:1:3 1B:2B:1S:2S None 

Code 2 of 5 Industrial  1:3:1 1B:2B:1S None 
Code 3 of 9 (Code 39) 1:3:1:3 1B:2B:1S:2S None 
Code 3 of 9 (Code 39) 
ASCII  

1:3:1:3 1B:2B:1S:2S None 

EAN8 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S EAN8        
EAN8 - 2 digits add 
on 

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S EAN8       

EAN8 - 5 digits add 
on 

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S EAN8        

EAN13 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S EAN13       
EAN13 - 2 digits add 
on  

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S EAN13       

  
EAN13 - 5 digits add 
on 

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S EAN13       

  
EAN128 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S Code128     
UPC 12 Digits  1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S UPCA        
CodaBar (2 widths) 1:3:1:3 1B:2B:1S:2S None 
CodaBar (18 widths)     ----

           
Code128 automatic 
subset switching / 
autocompress 
(Code128 A, B, and C 
see below) 

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S Code128 

Deutsche Post 
Leitcode 

1:3:1:3 1B:2B:1S:2S DPLeit      

Deutsche Post 
Identcode 

1:3:1:3 1B:2B:1S:2S DPIdent     

Code 16K     ----
           

Code 49     ----
           

Code 93 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S 2Mod47      
UPCD1     ----

           
Flattermarken 1:1 1B:1S None 
RSS-14 1:2:3:4:5:6:7:8:9:1:2:3:4:5:6:7:8:9 1B:2B:3B:4B:5B:6B:7B:8B:9B:

1S:2S:3S:4S:5S:6S:7S:8S:9S 
None 

RSS Limited 1:2:3:4:5:6:7:8:9:1:2:3:4:5:6:7:8:9 1B:2B:3B:4B:5B:6B:7B:8B:9B:
1S:2S:3S:4S:5S:6S:7S:8S:9S 

None 

RSS Expanded 1:2:3:4:5:6:7:8:9:1:2:3:4:5:6:7:8:9 1B:2B:3B:4B:5B:6B:7B:8B:9B:
1S:2S:3S:4S:5S:6S:7S:8S:9S 

----
           

Telepen Alpha 1:3:1:3 1B:2B:1S:2S None 
UCC128 (= EAN128) 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S Code128 
UPC A  1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S UPCA 
UPC A – 2 digit add 
on 

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S UPCA 

UPC A – 5 digit add 
on 

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S UPCA 

UPC E 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S UPCE        
UPC E – 2 digit add 
on 

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S UPCE        

UPC E – 5 digit add 
on  

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S UPCE        

PostNet-5 (ZIP 5 
digits) 

1:1 1B:1S PostNet     

PostNet-6 (ZIP 5 
digits + check digit) 

1:1 1B:1S PostNet     
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PostNet -9 (ZIP + 4) 1:1 1B:1S None 
PostNet-10 (ZIP + 4 + 
check digit) 

1:1 1B:1S PostNet     

PostNet-11 (ZIP + 4 + 
2) 

1:1 1B:1S PostNet     

PostNet -12 (ZIP + 4 
+ 2+ check digit) 

1:1 1B:1S PostNet     

Plessey Code 1:2:1:2 1B:2B:1S:2S Plessey     
MSI Code 1:2:1:2 1B:2B:1S:2S MSI1        
SSCC18 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S Mod10       
FIM       
LOGMARS  1:3:1:3 1B:2B:1S:2S None        
Pharmacode One-
Track 

1:3:2:4:2:3 1B:2B:1C:2C:1S:2S None 

Pharmacentralnumber 1:2.5:1:2.5 1B:2B:1S:2S PZN     
    

Pharmacode Two-
Track 

1:1 1B:1S None 

General Parcel       
PDF417 1:2:3:4:5:6:7:8: 

1:2:3:4:5:6 
1B:2B:3B:4B:5B:6B:7B:8B: 
1S:2S:3S:4S:5S:6S 

None 

PDF417 Truncated 1:2:3:4:5:6:7:8: 
1:2:3:4:5:6 

1B:2B:3B:4B:5B:6B:7B:8B: 
1S:2S:3S:4S:5S:6S 

None 

MaxiCode 1:1   ----
           

QR-Code 1:1 (1B:1S) ----
           

Code128 (Subset A) 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S Code128 
Code128 (Subset B)  1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S Code128 
Code128 (Subset C)  1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S Code128 
Code 93 Ascii 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S 2Mod47 
Australian Post 
Standard Customer 

1:1 1B:1S None 

Australian Post 
Customer 2 

1:1 1B:1S None 

Australian Post 
Customer 3 

1:1 1B:1S None 

Australian Post Reply 
Paid 

1:1 1B:1S None 

Australian Post 
Routing 

1:1 1B:1S None 

Australian Post 
Redirection 

1:1 1B:1S None 

ISBN Code 
(=EAN13P5) 

1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S EAN13       

  
Royal Mail 4 State 
(RM4SCC) 

1:1 1B:1S None 

Data Matrix 1:1   ----
           

EAN-14 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S EAN14       
Codablock-E     CodablockE 
Codablock-F 1:2:3:4:1:2:3:4 1B:2B:1S:2S CodablockF 
NVE-18 1:2:3:4:1:2:3:4 1B:2B:3B:4B:1S:2S:3S:4S Mod10       
Japanese Postal 
Code 

1:1 1B:1S None 

Korean Postal 
Authority Code 

1:3:4 1B:1S:2S Mod10Kor    

RSS-14 Truncated 1:2:3:4:5:6:7:8:9:1:2:3:4:5:6:7:8:9 1B:2B:3B:4B:5B:6B:7B:8B:9B:
1S:2S:3S:4S:5S:6S:7S:8S:9S 

None 

RSS-14 Stacked 1:2:3:4:5:6:7:8:9:1:2:3:4:5:6:7:8:9 1B:2B:3B:4B:5B:6B:7B:8B:9B:
1S:2S:3S:4S:5S:6S:7S:8S:9S 

None 

RSS-14 Stacked 
Omnidirectional 

1:2:3:4:5:6:7:8:9:1:2:3:4:5:6:7:8:9 1B:2B:3B:4B:5B:6B:7B:8B:9B:
1S:2S:3S:4S:5S:6S:7S:8S:9S 

None 

RSS Expanded 
Stacked 

1:2:3:4:5:6:7:8:9:1:2:3:4:5:6:7:8:9 1B:2B:3B:4B:5B:6B:7B:8B:9B:
1S:2S:3S:4S:5S:6S:7S:8S:9S 

None 

Planet 12 digits 1:1                1B:1S Mod10Pla    
Planet 14 digits 1:1 

               
1B:1S Mod10Pla    

Micro PDF417 1:2:3:4:5:6: 
1:2:3:4:5:6 

1B:2B:3B:4B:5B:6B: 
1S:2S:3S:4S:5S:6S 

None 
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Guard Width 

  

Width of optional bars printed above and below the symbol. The guard bars eliminate partial reads (as drawn in the example below). The complete symbol can be
surrounded by a guard box. 

 

  

Module Width 

The module width (abbreviated with X in this document) is the width of the smallest element in the barcode (the smallest bar or space). The minimal
module width depends on the barcode-symbology. In most specifications the recommended module width is at least 0.19 mm.  

When adjusting the module width of a barcode object, ensure if the entire barcode can be displayed with the maximum data content (widen the barcode object if
needed).  

If the module width is not specified, it is computed automatically by dividing the width of the object by the number of required modules. This depends on the number of
data characters to be encoded. The module width decreases as the data content increases. 

  

Notch Height 

  

The height of linear barcode-symbol is not relevant in most cases. 

For most barcodes, the recommended minimal height is 15% of the symbol width. 

Print Ratio 

The print ratio or so-called Bar/Width-Ratio is the width relationship of all elements of a barcode – with respect to the smallest element. Such a ratio 
exists for the bars and also for the spaces. 

Simple barcode-symbologies are using only two different bar widths, i.e. the entire data must be shown by using a combination of wide and narrow elements. More
efficient linear barcodes are using elements with up to 9 different widths.  

The ratio-format is used to describe the possible ratio settings. The ratio-format depends on the selected barcode-type and shows how many different bar and space-
widths are used in a particular symbology. 

 

  

The picture above shows a barcode with 4 different element widths (8 elements in total; 4 bars / 4 spaces). Because ratios of bars and spaces are maintained
separately, the ratio format is built as follows: 

1B:2B:3B:4B:1S:2S:3S:4S 

The first four values (1B:2B:3B:4B) refer to the 4 different bar widths, the second four values (1S:2S:3S:4S) refer to the available spaces. These settings show that 4
different bar widths and 4 different space widths are used in the symbology. The actual width is computed by multiplying the module width with the current setting of
the print ratio for this element.  

The print-ratio is adjustable by defining a ratio-string. Without user interaction the recommended standard ratio is used. However – the user has the possibility to adjust 
the print-ratio to individual needs. 

Example: 

Code 2of5 Interleaved has uses a print ratio of 1:3:1:3. The ratio–hint for this symbology shows 1B:2B:1S:2S. 

This indicates that the wide bar is 3 times the width of the small bar (and similar for the spaces). If you want a ratio of 1:2 (which is sometimes required by industry
label specs) then you adjust the print-ratio like “1:2:1:2”. The first two values 1:2 adjust the bar ratio and the last two values adjust the ratio of the spaces. 

RatioHint Ratio Result 
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Table 2: Print-ratio adjustment 

  

Format/Subset – Format is like a ”mask” for formatting the barcode data prior to encoding it. 

Ø      Attention: do not confuse the Format with the Ratio Format! 

Placeholders in the format string can be mixed with constant data characters to build a final data string. Control characters are also supported. With this feature it’s 
possible to: 

§   Select subsets in Code 128, EAN 128 and UCC 128 (even within the code!) 

§   Select the required start/stop character for CODABAR 

§   Change the position of the check digit (for special applications only) 

§   Set the values Date, Preamble, Service Class, postal and country code directly in the barcode data (in conjunction with special Esc-sequences). 

  

Examples: 

(Format) 
(1B:1S) 1:1 1 bar and 1 space is used 

Same width is used for bars and spaces 
(1B:2B:1S:2S) 1:2:1:2.4 2 bar-width and 2 space-widths are used by the 

symbology 

The print ratio of the wide bars (2B) to the 
small bars (1B) is specified as 2 : 1 

The print ratio of the wide spaces (2S) to the 
small spaces (1S) is specified as 2.4 : 1 

(1B:2B:3B:1S:2S) 1:2.5:4:1:2 3 different bar-widths and 2 different space-
widths are used by the symbology 

There are three bar widths (1B, 2B, 3B) with 
the ratio 4 : 2.5 : 1 
and 2 space widths with the ratio 2 : 1 

Placeholder 

character 

Description 

# Stands for the next data character 
& Stands for all remaining data characters 
^ Stands for the next check digit (use only if check digits will be computed!)
A Switch to Subset A (used in: Code 128, EAN 128, UCC 128) 
B Switch to Subset B (used in: Code 128, EAN 128, UCC 128) 
C Switch to Subset C (used in: Code 128, EAN 128, UCC 128) 
A Start- or stop character A (only in: CODABAR) 
B Start- or stop character B (only in: CODABAR) 
C Start- or stop character C (only in: CODABAR) 
D Start- or stop character D (only in: CODABAR) 
S Only for MaxiCode: enables setting the values of Date, Preamble, Service 

Class, Postal- and Country- Code directly in the barcode data (only in 
conjunction with Escape Sequences). 

J With Japanese Postal codes, the Address B  data fields can be 
automatically compressed, i.e. Japanese symbols are converted into ASCII 
symbols.  

Data input Barcode 
type 

Format 
string 

Data used for encoding 

123 Irrelevant   123 
123 Irrelevant 5& 5123 
123 Irrelevant &6 1236 
123 Irrelevant q#w#e# q1w2e3 
123 Irrelevant #q& 1q23 
123 Irrelevant &^ 123c 
123 Irrelevant ^& c123 
Hello Code 128 A& Hello 
Hello Code 128 A##B& Hello 
Hello4711 Code 128 A##B& Hello4711 
Hello4711 Code 128 A##B###C& Hello4711 

Page 82 of 146jet.engine GUI Help



  

red       characters       represented in Subset A 

gray     characters       represented in Subset B 

green   characters       represented in Subset C 

c                                  represents the place of the check digit 

  

Optimize for Resolution 

  

Printing tolerances can lead to problems when decoding a barcode. A remedy for this problem is to optimize the module width with respect to available printing 
resolutions. Assume you want to print a barcode with a resolution of 300 dpi then one pixel equals 0.003333 inch (or 0.08466 mm) in such a case. 

  

To avoid raster errors, you should select a module width that is an integer multiple of the pixel width (e.g. for 300 dpi a multiple of 0.08466 mm). 

  

Ø      200 dpi: 2 modules per pixel (0.127 mm) = 0.254 mm 
Ø      202 dpi: 2 modules per pixel (0.1257 mm) = 0.251 mm 
Ø      300 dpi: 3 modules per  pixel (0.08467 mm) = 0.254 mm 
Ø      600 dpi: 5 modules per pixel (0.04233 mm) = 0.212 mm 
Ø      For printer solutions over 300 dpi normally the optimizing of the module width isn’t necessary.  

  

  

Translate Escape Sequences 

If you want to use non-printable or special characters in a barcode, you have to use “Escape Sequences”. An Escape Sequence always start with a 
backslash (‘\’) followed by the sequence. 

  

      Hint: With activated Escape-Sequences you are not able to encode a Backslash („\“) directly. Therefore you have to encode “\\”. 

  

Escape-
Sequence 

Description 

\a Bell (alert) 
\b Backspace 
\f Form feed 
\n New Line 
\r Carriage Return 
\t Horizontal Tab 
\v Vertical Tab 
\\ The Backslash \ itself 
\0ooo ASCII-character in octal notation: 

ooo      octal digits (0..7) 
\ddd ASCII-character in decimal notation: 

ddd      decimal digits (0..9) 
\xhh For encoding Bytes or ASCII-characters in hexadecimal notation 

hh        hexadecimal digits (0..F) 
\F FNC1 or Gs (\x1d), used in UCC/EAN codes as field separator 
\E ECI (Extended Character Interpretation), used in 2D codes like MaxiCode, 

DataMatrix and QR-Code. Is used for switching between various code 
pages (multiple character sets) – contact us to get further information. 

\EB, \EE special ECI identifiers for nesting ECIs. \EB (ECI Begin) opens a nesting 
level, \EE (ECI End) closes it. Used in QR-Code 

\G GLI (Global Language Identifier), similar to ECI, but only used in PDF417. 
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Extended Escape Sequences 

  

Generate Check Digit  

The method for the check digit (s) calculation depends on the respective barcode type; especially for barcode types EAN 8/13, UPC A/E and Postnet
6/10/12.  

Ø      When selecting the standard check digit, the input can take place with and without a check digit. In the latter case the check digit is calculated 
automatically and added. 
Ø      Example EAN13: 12 digits input (= utilizable data), the 13th digit (= check digit) is added automatically. 13 digits input (=Utilizable data), the 
check digit is replaced by your data and isn’t calculated. 

  

  

Common Object Properties 

Control 
character 

Escape 
Sequence 

Barcode type(s) 

FNC1 \210 Code128, EAN128, UCC128 
FNC2 \211 Code128, EAN128, UCC128 
FNC3 \212 Code128, EAN128, UCC128 
FNC4 \213 Code128, EAN128, UCC128 
DC1 \x11 Code93, Code93Ext 
DC2 \x12 Code93, Code93Ext 
DC3 \x13 Code93, Code93Ext 
DC4 \x14 Code93, Code93Ext 
Rs \x1e MaxiCode (Mode 3,4 SCM) 
Gs \x1d MaxiCode (Mode 3,4 SCM) 
Eot \x04 MaxiCode (Mode 3,4 SCM) 

Check Digit  Check digit calculation methods 

None No check digit will be computed 
Standard Standard check digit of barcode type will be used 
Mod10  Modulo 10 (usually used with Interleaved 2of5) 
Mod43  Modulo 43 (suggested for Code39 and Logmars, consist of 1 

digit) 
2Mod47  Modulo 47 (2 digits) 
DPLeit   Method for DP Leitcode 
DPIdent  Method for DP Identcode 
1Code11  Method for Code11 (1 digit) 
2Code11  Method for Code11 (2 digits) 
Postnet  Method for USPS Postnet 

MSI1     Method for MSI (1 digit) 
MSI2   Method for MSI (2 digits) 
Plessey Method for Plessey 
EAN8  Method for EAN 8 
EAN13  Method for EAN 13  
UPCA   Method for UPC A 
UPCE   Method for UPC E 
EAN128 EAN 128 internal method (Modulo 103) 
Code128 Code 128 internal method (Modulo 103) 
RM4SCC Method for Royal Mail 4 State 
PZN    Mod-11 Method for PZN 
Mod11W7 Mod-11 (Weighting = 7)  
EAN14    Method for EAN 14 
Mod10Kor   Method for Korean Postal Authority - Modulo 10 
Mod10Pla   Method for Planet - Modulo 10 
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Contents 

Font 

Rotate 

Block Properties 

Object Properties 

Font 

Font Properties: 

The Font tab is available in many of the Properties windows.  This is where you can choose the font, font style, and font size for the block . You also have options for 
Underline and Strikeout (put dashes through the text, e.g., strikeout).  The Sample Text Area displays the font with the characteristics you have chosen. 

  

 

  

Choose Font From Data File: 

You can set up print objects on form design to change font type from page to page. A database field that contains font names can be used to designate the font you 
want to use for every page/record.  

 Click on the "Choose Font From Data File" check box, when this box is checked the "Data Field Containing Font Name" menu becomes enabled. Then click on the drop 
down menu select arrow and choose the field name from the database file that contains the font names. (See example below) When the job runs the font type entry for 
each record will be used to select the font used for that record. 

   Note: The database you have loaded must have a field that contains the font name that will be assigned to each respective record in the  job file. 
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Transform 

 

From the Transform tab on the Properties screen, you can change the Angle of Rotation of a block or bitmap in 90° increments.   

 

  

For some blocks or bitmaps, you also have the option of entering a Custom degree of your choice. 

Page 86 of 146jet.engine GUI Help



   

  

Flip Horizontal mirrors the object relative to the horizontal axis.  Flip Vertical mirrors the object relative to the vertical axis.  An object may be flipped Before or After 
Rotate. 

 

 

 Note: You will see these "transformation changes", (shown above), on the Form Design screen. 

  

Block Properties 

Block properties (e.g., position on the layout, border characteristics, etc.) are set on the Block Properties tab in the Properties screen.  

You can access a block's Properties  in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

Click on the Block Properties tab. 
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You can position the block on the Form Design layout by entering values in the Left and Top boxes.  To change the size of the block, enter values in the Width and 
Height boxes. If you want to position the text within the block, choose Horizontal and Vertical options.  You can specify the Character Pitch in the Character Pitch 
box.  

Checking Word Wrap keeps the text from running outside the block. If you check the box next to Transparent , the non-black portions of a bitmap become 
transparent.  The bitmap can no longer be moved around in the layout window if you check the box next to Position Is Locked. 

Resize text when box size changes means that if the size of the block is changed, the size of the font will change proportionally. However, this is true only if you
resize the block from the corner.  If you resize the object from the top or bottom, the text size will not change. 

You can also have the system Generate error if text exceeds borders. This means that if any of the text exceeds the boundaries of the object, you will receive an
error during printing.  If you do not choose this option, and the condition occurs, text will appear truncated or cut off. 

The Block Properties tab for the Record and Field Blocks also gives you a Casing option. 

 

Casing may be set at either None, All Caps (every letter in the block is capitalized), or to Upper/Lower Case as defined in String Replacement. 

Rectangle Type and Pen Width have drop down menus that help you define the border characteristics of the block. 

              

To Transform the block during printing, use the Transform tab. 

Line Spacing allows you to specify the number of lines per vertical inch. 

For help with Block Properties of a Bitmap, Dynamic Bitmap, or PDF File, see their individual pages. 

  

Object Properties 
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The Object Properties tab allows you can give a unique name to the object you have created.  You can also indicate in the checkbox whether or not the Object is 
Printable. 

  

Tables and Groups 

Contents 

Table 

Selecting & Grouping Objects 

Alignment of Multiple Objects 

Table 

This is a feature you can use to design a page of multiple objects arranged in a fixed column and row format. The row and column elements can be individual layout
objects, or a group of layout objects. 

There are four instances in which you might use this feature. 

To print multiple copies of an individual object 

In this example, a page of identical Indicia have been set up for printing. (You could also do this with a Record Block, Field Block, Message Line, Number 
Generator, or Dynamic Bitmap.) 

 Note:  The Table feature cannot be used with a PDF File.  Placement of multiple PDF Files in Form Design will cause a Global Protection Fault (GPF) and cause the 
 jet.engine™ GUI to shut down. 

   

To set up the table, first place one block on the Form Design screen.  Then, click  on the tool bar to open the Table Properties screen. 

Page 89 of 146jet.engine GUI Help



 

In the Table Size section, you set the Number of Rows and the Number of Columns that you want to print on the page. The example above is set up to print a
page with two rows of three columns. 

You set the Row Height and Column Width in the Block Spacing box.  Row Height is the spacing between the top edge of the block in one row and the top edge
of the block in the row below.  Column Width is the spacing between the left edge of one block and the left edge of the block in the next column.  In this example
both the rows and columns are set 1.5 inches apart. 

The Record Increment Options box does not apply for this example and is left at the default No Increment. 

The Object in Table box lists all the objects that are used in the table. In this example, only Indicia are used. Select Indicia in this box and the Properties button 
becomes active. If you click on this button, you will see the same Properties screen for Indicia that you would see if you double-clicked on the single object in Form 
Design (before setting up the Table). To give the Table object a unique name (other than "Indicia"), click on Object Properties and enter a name in the space 
provided. 

To print multiple objects from a data source where the structure of the object is identical but the contents 
change for each object 

Address labels are a good example of this type of print setup:  the structure of the labels is identical, i.e., the data appears in the same place for each label, but the
content of each label changes as you go from record to record, as seen below. 

 

In this example, the Number of Rows is 2, the Number of Columns is 3, the Row Height is set at 1.75, the Column Width is set at 2.5, and Field Block is listed 
in Objects in Table.  
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The Record Increment Options is set to Increment By Columns. This means that the change in records will go from column to column, left to right, with Record 2
to the right of Record 1, and Record 3 to the right of Record 2.  If Increment By Rows was checked, the change in records would go from row to row, top to bottom,
with Record 2 under Record 1 in Column 1, etc. If No Increment was checked, the page would print multiple copies of only one record. 

To print multiple objects when each row or column must have a different starting number 

This instance is applied only to a Number Generator block and uses a feature called Step and Repeat. 

In the example below, the print job is set up to print serial numbers.  Notice that each column starts with a number one thousand higher than the previous column (each
column Steps up by 1000), and each row starts with a number one higher than the row directly above it (it Repeats the number above, incremented by 1). 

 

The Table Properties (Table Size, Block Spacing, Record Increment Options) for these objects are similar to the earlier example of the address labels. 
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If you select Number Generator in the Objects In Table box, and click on the Properties button, the Number Generator Properties screen is displayed. 

 

This is the same screen you would see if you double-clicked on a single Number Generator block while in Form Design (before setting up the Table), with one 
exception: there are boxes for Step Increment and Repeat Increment. This is where you set the Step and Repeat values. 

Any combination of the above 

You may find that you want to combine two or more blocks, as in the example below. 
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Each object in this table contains a Field Block in text format, a Bitmap , and a Field Block in barcode format. Look at the Table Properties: 

 

There are three objects listed in Objects In Table: Barcode, Bitmap and Name.  If you selected either Barcode or Name, and clicked the Properties button, you 
would see the Properties screen for a Field Block displayed.  These Field Blocks were given a unique name in Object Properties.  

  

Selecting & Grouping Objects 

When designing your print job on the Form Design screen, you may want to combine or Group objects. In order to do so, you first need to Select the objects to be 
grouped.  You can do this in either of two ways: 

Select the first object by clicking on it once. You can tell that an object has been selected by the blue "handles" that appear on the edges.  Then, while holding
down the Ctrl key, click once on each of any additional objects you want to include in the Group. 

Position the mouse pointer somewhere outside the first object. Then, while holding down the left mouse button, move the mouse over the other objects to be
combined.  As you move over the objects, you'll see a box being formed.  Whichever object is touched by the box will be included in the Group when you release 
the mouse. This is called rubber-banding. 

Once you have selected multiple objects, you can put them in a Group by clicking   on the tool bar. (To ungroup objects, click .) 

You can also combine individual objects with a Group or Groups, or Groups with other Groups, using one of the methods above. 

You may want to Select an object once it is in a Group. You can do this without ungrouping the objects. Click once on the object you want to Select.   You'll see that 
the entire Group is selected.  Click again on the object you want to Select and only that object is selected. 
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If the object you want to Select is in a Group within a Group, click once on that object and the entire Group is selected.  Click a second time on the object and the 
smaller Group within which it is contained is selected. Click a third time on the object and the object is selected. 

  

  

Alignment of Multiple Objects 

Select the multiple objects by holding down the CTRL key and clicking on the blocks to be aligned. Using the buttons on the tool bar for Left Align, Right Align, Top 

Align, and Bottom Align   , align the blocks as you want them to appear in print.  

 Note: The first block to be selected for alignment is used as the reference point for aligning all the other selected blocks.  

Working with Databases 

Contents 

Load Data 

Unload Data 

Data/Modify Schema 

String Replacement 

Search 

Manual Schema 

Load Data 

You can load a data file either by selecting  Load Data from the Data menu, or by clicking the   icon .  This opens a typical Windows browser for locating and 
opening the file. 

 

  

Unload Data 

To Unload Data, choose Data/Unload Data from the menu or click on the    icon .  Data is automatically unloaded. 

Data/Modify Schema 

Data sources containing records can be in a variety of different formats. You need to be certain that the system can identify the format of your data source file. 

  

After you load your data source (see Load Data), view the records in the Print Manager main tab to see if they appear as they should.  If they do not, then the system
was unable to automatically detect the format, and you may need to tell it where one record ends and another begins, or, within records, where one field ends and
another begins.  You do this by selecting Modify Schema from the Data menu. The Record Source Schema screen is where you define the format of your data 
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source file. 

       

The Track Record Status  

The Track Record Status feature generates a verification file for the database to record records printed or errored.  The naming convention is
"databasefilename.ext.verification", and when initialized contains a "?" (question mark) on each line for the number of records in the database. As the database is
printed the question mark "?" will be replaced with a "P"  for printed or "E" for errored.  When the database is closed and reopened the user will see the record status in
the first column of the print manager tab indicated by green cells with the text "printed" (or red cells with the text "errored" ) for previously processed records.   

 Note: The user can clear the tracking file by selecting Delete Tracking File from the Data menu to reprint the database. 

Creating Reprint File: 

 In addition a new database containing only the un-printed records can be generated by accessing the Data menu and then clicking 
on Create Reprint File. 

For more information on printing or deleting tracking records, click on this "Track Record Status link"  

On this screen you can specify Record Delimiters and Field Delimiters in your data source file. A Delimiter tells the system what in the file indicates the end of a 
record or field.  

You can also Define, Edit, or Delete fields from this screen. 

The first several records are shown in Data Preview at the bottom of the screen, so you can see how they appear in the data file. 

If the Multiple Copies setting is enabled, you can specify a field in the data source to use as the quantity to print in the Print Quantity Select box. 

To name a Field, select it in the Field Properties box, and click on Define Field. This brings up the Field Properties screen. 

 

Enter a Field Name and click OK.  The name will replace Field N in the Field Properties box, and in the Data Preview box. To edit an existing Field Name, select 
the name, click on the Edit Field button, and replace the Field Name in the box. Click OK. 

Page 95 of 146jet.engine GUI Help



You can also Delete a field name after selecting it in the Field Properties section. 

Define Schema: 

 

With a database loaded, under the "Data" Menu select Define Schema, the Define Record Source Schema selection screen, (shown below), will display.  

 
  

The purpose of the Define Schema Selection is;  

1. To permit the reuse of an existing schema for multiple databases. 

2. To allow for a unique schema for each database. (Default Mode)   

  

The file location of the schema you have loaded will show in the "Existing Schema File" section of the Define Record Source Schema selection screen, (shown above). 
When you define a schema for a job, it is saved with the job.  

  

This screen provides you with 3 options: 

1. Default Mode This option will look for a schema file with the name of the database appended with .schema. Also note that database files ending with the
extensions .csv, .tab, etc. will automatically create schema files. If the database ends with .txt and no schema exists the user will be prompted to create one
using the Modify Schema dialog. 

2. Existing Schema option allows the user to specify a schema with a different file naming convention used in the Default mode. Note that 
unloading the database will automatically revert back to the Default Mode. Again, the existing schema file is lost when a new database is
loaded.  

3. "Save current Schema as new file and use it" allows you to save the existing schema file as a new schema and use it. Note, after this action the file name will be
moved into the second option, (existing schema file). 

  

String Replacement 

There may be recurring items in your data source file that you would like to replace with a different item. These items are call Strings and you can change them by 
creating a String Replacement List. 

From the Data menu click on String Replacement. If there is an existing List that you want to use, select it in the Current Replacement Lists box and click Load . 
The List appears in the bottom of the screen. 
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In the example above, Replacement List 1 tells the system that every time "AVENUE" appears, replace it with "Ave." Every time "STREET" appears, replace it with
"St", and so on. If you want to edit something on the list, click on the item in the List.  Its values appear in the From and To boxes.  From there you can edit the items
by re-typing in the From and/or To boxes, or click on Clear Fields and type in new values. You can also select the items and click Delete to remove them from the 
List.  If you want to add to the list, simply type in the From and To boxes and click Save.  The items are then added to the List. 

To add a list to the Current Replacements List box, click on New. 

 

From here, you can browse to select a List that already exists elsewhere, or you can create a new List by giving it a File name and choosing a file type from Save as 
type.  Click the Save button. 

If you are adding a List that already exists elsewhere, it will be added to the Current Replacements Lists box.  From there you can select it, Load it and edit as 
described above. 

If you are creating a new List, select the name from the box, enter values in the From and To boxes, and click Save. Repeat until you have completed the List. 

You can also Delete a List by selecting it in the Current Replacements Lists box and clicking on Remove. 

These Lists become part of the configuration for your print job and will be saved as part of the job's .ijj file. 

  

Search 

Once you have loaded a data source (see Load Data), you can Search for a particular record through the Find Record screen, either by clicking on Search from the 

Data menu, or by  clicking on the    icon . You must be in Print Manager to use this function. 

On the Find Record screen, start by entering in the Enter Search String box the item, or a portion of the item, for which you are searching.  You can also indicate
which fields to Search In by choosing from the drop-down menu. Click on the Search button.  

Records which match your Search criteria appear in the box in the bottom part of the Find Record screen. 
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When you find the record for which you are searching, select that record by clicking the record number in the first column. If you want to print that particular record
(e.g., it generated an error and you want to print it again), click Add Selected To Queue. 

  

When you return to the Print Manager screen, you'll see that the Status of that record is Queued. 

If you select that particular record and click OK, you return to the Print Manager screen.  That record is now the first record in the list, and you can see where it is in
relation to the rest of the data source by using the scroll bar on the right of the screen. 

  

  

Manual Schema 

 

Manual Schema Purpose:   

The Manual Schema is used to permit binding a schema and sample database to a job that uses terminal mode. 

The Schema is embedded in the Job 

A sample Database can referenced and the first 20 records previewed 

Software Mode Operator cannot access. 

No data is shown in the Print Manager tab as there is no actual database. 
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Manual Schema Usage: 

• To create a job with a Manual Schema No database can be loaded,the Software mode must be Supervisor or above. 

The following are the steps to create the Manual Schema; 

1. Set Schema 

2. Menu: Data-> Manual Schema… 

3. Choose example database; (you w ill be prompted for schema if one does not exist). 

Choose sample database for data preview (optional) 

Menu: Data->Modify Schema… 

Press OK; (you will be prompted for database to use for preview) 

 Note: The path for data is stored in job (not the database) 

 Note: If a job is opened and the database is not found, it will not preview and no error will be generated. 

Manual Schema Removal: 

To remove a Manual Schema from a job use the following steps;  

Menu: Data -> Remove Manual Schema 

 

 Note: You will now be able to load a database  

Edit Manual Schema: 

To edit a  Manual Schema embedded in a job use the following steps; 

 

Menu: Data->Modify Schema  

Make changes 

Press OK  

• You will be prompted for database to use for preview 

 Note: You can press cancel if no data preview is desired 

Testing Print Jobs 

Contents 

Preview Form Data 

Test Page: Print Preview 

Test Page: Print 

  

Preview Form Data 

If you want to see how the data in your print job will look in print, without actually printing it, you can use the jet.engine™GUI's  Preview feature. 

After you have set up your block on the Form Design screen, Load Data, either by clicking   on the tool bar, or by selecting Load Data from the Data menu. 
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Then, while still on the Form Design screen, select Preview from the Data menu, or click on  on the tool bar (this button will allows you to toggle the Preview
feature on an off). 

The first record in your data source is now previewed in the block on the Form Design layout.  If you want to view other records in the data source, you can use the
Page arrow buttons on the tool bar to move back and forth through the pages, or to the beginning or end of the data source. Typically, one page prints one record.  
However, when using a Table, one page can print multiple records. (Note: These button features are also available as selections on the Data menu.) 

 

If you want to view a particular page, enter its number in the box, and hit Enter on your keyboard.  That page's record(s) will appear in the block. 

With the Preview feature enabled, the data that appears in the block on the Form Design screen is also the first record that appears on the Print Manager screen.  
From there, you can scroll through the records and view a particular record in the context of other records before and after it. 

Conversely, with Preview enabled, you can highlight a record on the Print Manager screen and see it previewed on the Form Design screen. 

  

  

Test Page: Print Preview 

You might find it useful to view your print job before running the entire job. You can do this from the File menu by choosing Print Preview. 

 

From this screen, you can preview the print job as individual pages, or in Two Page spreads. Using the Next Page and Prev Page buttons, you can move back and 
forth among the pages.  You can also Zoom In or Zoom Out on individual pages. 

 Note:To not use the layout marks as shown above, set the "Application Settings", 'DisableTestPrintLayoutMarks' to 0. 

If you choose the Close button, you will return to your document without printing anything. 

Choosing the Print button brings up a typical Windows print dialog. 

 

From here, you can select a printer and its properties, print all or a specific range of pages, and set the number of copies to print. 

  

Test Page: Print 

Page 100 of 146jet.engine GUI Help



You might find it useful to print a test page of your print job to see how it looks on a page before running the entire job. 

To print a test page, either click  on the tool bar, or, from the File menu, choose Print/Test Page. You'll then see  a typical Windows print dialog (as shown 
below), where you can select a printer and its properties, print all or a specific range of pages, and set the number of copies to print. 

 

  

Advanced Configuration 

Contents 

Passwords 

Pen Parameters 

I/O Configuration 

Purge Settings 

Passwords 

 

When operating the jet.engine™GUI as a Technician or Developer, you have the ability to set passwords. You can access this feature by going to the Options menu, 
choosing Advanced Configuration , and clicking on the Passwords tab. 

 Note:  If you are operating in the Operator or Supervisor mode, and require a password, see your systems administrator. 

If you want to require a password to access the Advanced Configuration features, then enter the password in the Advanced Configuration Password box, and 
check the box next to Advanced Configuration Password Required. If this box is not checked, a user will not be prompted for a password to access Advanced 
Configuration, even though you may have entered a password. 

You can also set passwords here for users to access different operating modes.  The Operator mode is the mode with the fewest privileges and cannot require a 
password. However, both the Supervisor and Technician modes can be set to require a password.  Enter the password in the box next to the appropriate mode.  If
no password is entered here, then the user can change operating modes at will. 

Last Used Software Mode: 

By default, the jet.engine™GUI opens in the Operator mode. If the "Start application in last used Software Mode" box is checked, the application will open in the 
last used mode. If you have specified a password, then the user will be prompted for that password. The jet.engine™GUI will remain in Operator mode if the password 
is entered incorrectly. 
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Pen Parameters 

Pen Parameters allow you to set the conditions under which the pens will operate. Each pen can be set up separately with non-similar characteristics. 

 
Pen Drive Voltage is the voltage output of the pen regulator that drives the pen.  

 

Pulse Warming Temperature is the trigger threshold that controls the pulse warming trigger. 

 

Fire Pulse Length is the amount of time that the Pen Drive Voltage is applied to the pens. The recommended range of values is 1.9 µs to 2.2 µs, although higher values 
are provided.  

 Note: Using values that are higher than recommended values may result in the print job running at a slower than optimal speed. If you want to use Fire Pulse 
Lengths higher than 2.3 µs, please contact inc.jet™ Technical Support. 

The Fire Pulse Length and the Pen Drive Voltage together decide the energy provided to the pen, which in turn decides the amount of ink that will be used to print. 

IO Configuration 
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The IO Configuration screen allows you to set the Cut off Frequency for each Input on every Imager. The Default is 31.25 KHz. 

The Cut off Frequency sets the amount of time an Input must remain stable in order to be recognized as valid. The lower the Cut off Frequency, the longer the Input 
must remain stable without transitions. A Cut off Frequency value of 31.25 KHz means that Input must remain constant for a period of 16 µs for it to be a valid Input 
transition. Cut off Frequencies of 15.625 KHz and 10.4167 KHz mean the Input must remain constant for 32 µs and 48 µs respectively. If the setting is set to None, all 
signals are accepted. 

 Note: In order to be recognized, the Input that provides the encoder pulses must also confirm to this condition, or the encoder Input will be filtered out. 

Purge Settings 

Purging is a means of periodically cleaning the ink jets by sending ink through each jet on the ink head. Configuration of automatic purging during capping station
movements is set up on the Purge Settings tab, which you access through Advanced Configuration.  

Note: Purge Settings is only available if you have Technician privileges.  

 

All jet.engine™ Imagers equipped with automatic capping stations have the ability to automatically purge all enabled pens whenever a capping station movement is
performed. Capping station moves include Move to Print, Move to Park, and Clean. 

On the Purge Settings tab, you can enable and disable purging and set the purge volume for all Cleaning Station moves. The purge volume is adjustable using a slider 
scale from 30 pixels to 300 pixels per nozzle. The selected value defines the number of pixels of ink that each pen will print using every enabled nozzle when performing
the purge operation.  

There are three occasions when you can purge the nozzles on the pens: 

1. Purge before Print:  

A purge (in the capping tray) occurs before a Move to Print is performed. 

2. Purge on Park:  

A purge (in the capping tray) occurs after a Move to Park is performed. 

3. Purge on Clean:  

A purge (in the capping tray) occurs before a Clean is performed. 
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Additionally, you can control the following behaviors: 

Clean On Park 

A clean occurs when the Imager is parked. 

Spit Setting 

Specify the volume of ink to use when a Spit is performed. 

 Note:  Keep in mind, that purge parameters are stored in the Imager,and not the jet.engine™GUI. The purge parameters are received from each Imager and 
displayed when the Purge Settings tab is selected.  Therefore, the parameters must be set up for each Imager and may not be same for each Imager. Each time a new 
Imager is added to the system, these parameters must be re-configured. 

  

Other 

Information regarding the Hardware Configuration, Debug and Cleaning Station features is covered in separate documentation. Please contact inc.jet™. 

Menu Bar 

 

The Menu Bar appears directly under the blue title banner, in the top left corner of the jet.engine™ GUI screen.  It is similar to menu bars found in most Windows-
based applications. 

Each heading contains a drop-down menu which will allow you to access commands, functions, additional menus or information. 

Click on a heading in the following list for additional information about its drop-down menu. 

File 

Edit 

View 

Options 

Data 

Help 

File Menu 

 

The File Menu contains commands to be used with individual files: 

New Job:  Use this command to open a new job file. 

Open Job:  If you select this command, you'll see a browser window from which you can locate and open a job that has previously been saved. 

Save Job:  Use this command to save an existing job to which you have made changes.  You can also use this command to save a new job for the first time. 

Save Job As:  You can use this command to save a new job for the first time, or to save an existing job under a new name. 

Load Configuration: If you have previously stored a job configuration (a group of specific settings), you can use this command to load that configuration into the
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current job. 

Store Configuration:  Use this command to save a configuration or group of settings which you may want to use for future jobs. 

Find Imagers: Use this command to find imagers that are connected to the jet.engine™ GUI. 

Print: Use this command to print a selected item. 

Print Options: Use this command to open a print options menu, (shown below). 

See Print to PDF section for more information on setting up and using this feature. 

            

Print Preview: Use this command to preview a selected item before printing it. 

Exit:  Selecting this command closes the jet.engine™ GUI. If you have not already saved the open file, you will be asked if you want to save the
changes. 

  Note:Between the Print Preview command and the Exit command, you'll see a list of the most recent jobs which have been opened (TestJob.ijj in the example 
above). Up to ten jobs may be listed and may include jobs from the current jet.engine™ GUI session as well as from previous sessions. You can double-click 
on a file name to open that file. 

Edit Menu 

 

The Edit Menu contains typical Windows commands used for editing (Cut, Copy, Paste, Delete, Select All), along with their keyboard shortcuts. These commands are 
only available when Form Design is the active Main Tab. 

In addition, the Clear All command can be used to remove all objects from the Form Design screen. 

Job Notes: 

Another feature of the Edit Menu is the Job Notes option. 
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If you choose this command, you will see a screen with a text box in which you can record notes about the current job that you might find useful for future reference.
 Check the box next to Display Notes on Job Open to have this information displayed whenever the job is opened. 

Define Background Image: 

Another feature of the Edit Menu is the Define Background Image feature. From here you can select an image to appear in the background. 

 

 

View Menu 

You can use Zoom option on the View Menu to change the size of the Form Design area from a list of percentages.  The default is 100%. 
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The Reset Toolbars option is also on the View menu. 

 

Toolbars can be moved around in the toolbar area at the top of the screen, and they can be moved into the lower portion of the window, by selecting
the gray bar on the left side of the toolbar while holding down the left mouse button. If you close a toolbar that you have moved to the lower
portion of the window (by clicking the 'X' in the upper right corner), the toolbar disappears. To retrieve the toolbar, select Reset Toolbars from the 
View menu, and the toolbar will be returned to the toolbar area at the top of the window. 

Options Menu 

 

The Options Menu is your gateway to available settings for Imager Configuration, Advanced Configuration, Proof Settings, and Grid Settings.  Selecting any of these 
items will take you to additional screens for accessing their settings. 

Software Mode refers to the level of access available to the user. 

 

The Operator mode is the mode with the fewest privileges and does not require a Password. An Operator cannot change the job layout or any of the job's 
configurations.  A Supervisor has limited access to hardware configuration and can change the job layout.  A Technician is able to configure hardware and can change 
IO Events. A Developer has full access to hardware configuration as well as to all the debug tools available in the jet.engine™ GUI. 

Application Settings Menu: 

You must log in as Technician or Developer to access the Application Settings menu, clicking on this Application Settings link to learn more about Application Settings. 

  

Data Menu 
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From the Data Menu, you can Load Data or Unload Data. 

Note: You can also use the Load Data Source and Unload Data Source buttons on the Database Toolbar. 

Once a data source has been loaded, and Preview mode has been selected, you can use this menu to move among the records, i.e., go to the First Record, the Previous 
Record Page, the Previous Record, the Next Record, the Next Record Page or the Last Record.  

You can also manage the Print Queue from this menu: 

  

        

  

  

 Note: You can also access the Print Queue menu by right-clicking anywhere on the Print Manager Main Tab. 
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From the Print Queue menu you can -  

Add All records;  

Remove All records;  

Add Selected records;  

Add From Selected to End; Select a specific record and add every record from there to the end of the data source 

 

  

Add Range; Specify a range of records and add them to the print queue 

 

Remove Selected records;  

Reset All Quantities of records with quantities defined, if Multiple Copies is Enabled; 

Set All Quantities of records with quantities defined, if Multiple Copies is Enabled; 

Reset Selected Quantities of records with quantities defined, if Multiple Copies is Enabled; 

Set Selected Quantities of records with quantities defined, if Multiple Copies is Enabled; 

 

Add Error Records to the print queue which had previously showed up as records with errors.  

Click on the following links for information on the Data Menu choice categories; String Replacement, Define Schema and Modify Schema.  

  

Creating a Reprint File 

To Create a Reprint File you need to go into the Data Menu and select Modify Schema and enable Track Record Status (shown below). Click on this Track Record 
Status Link for more detailed information. 
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After the Track Record Status is enabled you can now select Create Reprint File from the Data drop down menu, the following message box will display. Click OK and the 
file will be sent to the default printer you have selected. 

 

Delete Tracking File 

To Delete a Tracking File make sure the Track Record Status is enabled, then select Create Reprint File from the Data drop down menu, the following message box will 
display.  

 Warning: Be sure you do not need the Tracking File before clicking on Yes to delete it! 

 

Help Menu 

Help/Topics 

If you select Help Topics it will bring you to the Help Files menu where you can look up any subject in an organized index. 

       

Help/About: 

If you select About, you'll see a typical Windows screen that gives information regarding the software version and build level. 
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Technical Support: 

Technical Support contact information is also listed on this screen. 

Firmware Versions: 

 Note: The Firmware versions that are required for use in Version 2.0 are listed on the bottom right of the About jet.engine™ GUI screen, (shown 
above). 

 FYI: Firmware versions are updated automatically, this feature is set to automatic firmware update enabled as the default setting in the Application 
Settings. When the jet.engine™ GUI is updated to a newer version it  contains new firmware versions that will automatically install as long as 
automatic updates is enabled. 

From this screen you can also access a copy of the License Agreement by clicking on the   button on the About screen, (shown above). 

Help/Generate Help Request Wizard: 

If you select Generate Help Request the following jet.engine.gui Help Request Wizard screen will pop up. This wizard will guide you through and 
collect all the necessary information and files that we will need to diagnose your issue/concern.  

  

       

  

Once the jet.engine.gui Help Wizard screen displays click on "Next" to continue.  

In the second screen that opens you will enter in the "Customer information", i.e. your name, company name, Job Title, address, email and telephone numbers.  

The third screen is where you will "Describe the issue in detail", you will create a title name for the issue and fill in the information on the date and time of the incident,
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the detail of the description and steps on how to reproduce the issue.  

The fourth screen will allow you to "Select the components to include in the zip file" that the Help Wizard will create, there is a check box that you will select for each
item that you would like to include in the zip file.  

The files you can select are Job file, Configuration files, Registry settings, Systems information, Dynamic bitmap files, PDF files and Data source schema file.  

On the same page you can select the "Data Source Records", the choices are None, All records, First 20 records or a specific start / finish record range can be
specified.  

There is also a selection for "Maximum Number of Log Files" that you can specify from 1 to 99.  

After completing this information click the "Next" button, you will see a screen that says "please wait while we process your request". A progress bar will display and
then the last screen will display once the information has been saved.  

On the last screen you will see a message that says; "Successfully generated help request file, Please follow the instructions below to get technical support".  

The information on this page will give you the instructions on where the file is located that you have just created, (Example:Help request file:
 C:\jet.engine.gui\TechnicalSupport\helpRequest_2008_10_17_10_13_50.zip). The file can be sent to the email address indicated; jetengine@incjet.com, or a CD 
containing the file can be sent via US Mail. 

The bottom section of the page will show you a summary of the information you provided using the Help Request Wizard, if any of the information is incorrect you can
press the back button to go back and correct any errors that you may have made in the information that you provided. 

Once you have finished inputting all the information and decided your method for submitting the file you created to Inc.Jet you can click the "Finish" button. 

  

Toolbars 

Toolbars consist of icons that give you quick access to functions and features of the jet.engine™ GUI. In many instances, a toolbar icon is an alternative to 
going through the Menu Bar. 

If you hold your mouse over an icon, a tool tip will appear that describes the function of that icon. 

Toolbars can be moved around in the toolbar area at the top of the screen, and they can be moved into the lower portion of the window, by selecting
the gray bar on the left side of the toolbar while holding down the left mouse button. If you close a toolbar that you have moved to the lower
portion of the window (by clicking the 'X' in the upper right corner), the toolbar disappears. To retrieve the toolbar, select Reset Toolbars from the 
View menu, and the toolbar will be returned to the toolbar area at the top of the window. 

There are five (5) toolbars available in the jet.engine™ GUI. Click on a toolbar title in the list below to find out more about its features. 

File 

Form Design (Job Layout) 

Font 

Preview 

Alignment 

File Toolbar 

 

From the File toolbar you can do the following: 

 Open a New file or job 

 Open an existing file or job.  If you click on this icon, a browse window appears. 

 Save a new file or save changes to an existing file. 

 Cut text or an object. 

 Copy text or an object to the Windows clipboard for pasting elsewhere. 

 Paste text or an object already copied to the Windows clipboard. 

 Print using the typical Windows Print dialog. 
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 View the About screen, which gives information about the version of the software.  You can also access the License Agreement through this screen. 

 Access the Help files (you can also use the F1 key on your keyboard). 

 Access the Job Notes screen. 

  

Form Design (Job Layout) Toolbar 

 

The icons on this toolbar are used to place and manage data objects on the Form Design page. 

The first eight (8) icons represent data objects: 

  Field Block 

  Record Block 

  Message Line 

  Indicia 

  Fixed Bitmap 

  Dynamic Bitmap 

  Number Generator 

  PDF File 

The remaining icons can be used to manage data objects on the Form Design screen: 

  Delete an object 

  Access the Properties for a selected object 

  Toggle the Form Design grid on and off 

  Snap objects to the grid  

Font Toolbar 

 

This toolbar is used primarily to manage Font attributes: 

  Click on the arrow on the right to see a drop-down menu of available fonts. 

  Click on the arrow on the right to see a drop-down menu of font point sizes. 

  Use these icons to change the attributes of a font or any of its individual characters.  From left to right, they are: Bold, Italicize, Underline and 
Strikeout Effect. 

At the end of this toolbar are two icons that are used to manipulate data objects on the Form Design screen when they overlap each other.  They are: 

  Bring to Front - moves the selected object to the front of another object. 

  Send to Back - moves the selected object behind another object.  

Note: Font changes are retained until changed; they are not lost when the GUI is shut down. 

Preview Toolbar 
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The icons on this toolbar (with the exception of the last two on the right) are only active when the Print Manager Main Tab is the active screen, and a data source has
been loaded. You can use them to preview records in the print queue. 

The number visible in the center (2 in this example) indicates which Page (or record) of the total number of pages (104 in this example) is selected. 

Use the single arrows to move one page back (previous page) or one page forward (next page). 

Use the double arrows to move one screen back (previous record page) or one screen forward (next record page). 

Use the arrow/line combinations to move to the first page/record of the data source or the last page/record of the data source (104 in this example). 

The remaining icons are: 

  Record Search 

  Toggle Preview mode on and off 

  Load Data Source  

  Unload Data Source 

  

  

  

Alignment Toolbar 

 

The icons on the Alignment Toolbar become active when you are in Form Design and have selected two or more objects (using the Ctrl key). 

Use the four (4) icons on the left to Align multiple objects according to the direction of the arrows, i.e., left align, right align, top align, or bottom align. 

The Crop tool:  is only available when working with a PDF object. 

The icons  and ,  are used for Grouping of multiple objects. 

The last icon on the right:    is used for arranging objects in a Table.  

  Print To PDF 

The ability to Print to PDF has been added, and when combined with the following features, allows the GUI to create a PDF print that will mimic the exact print that will
be created on the product, including background images already present, different colors of the pens, and differing pen location. 

Full Color Background Image 

Define Color of the Pen 

Adjust Pen Group location 

Printing Completed Project 

  

Full Color Background Image 

The Edit Menu contains the option "Define Background Image...".  This allows a bitmap, jpeg or tiff formatted image to be underlayed behind the print job loaded into
the GUI - allowing for simulation of a form or product being printed on top of.  The following screen is used to define the image before entering it as the background. 
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Define Color of the Pen 

The color of each pen can be individually assigned in the form design tab, allowing for an accurate reproduction of what the final print will look like.  The button in 
the Form Design tab change it from black & white to color mode, then right clicking on the pen will bring up the Select Pen Color popup.  

 

Either select from a preset or create a custom color.  Each pen will display as the selected color on the form design screen, as well as during a print to PDF. 

 

Adjust Pen Group Location 

The Form Design tab allows the location of the pen group to be moved, to allow it to be aligned with the background image form, product, etc.  This is the last step
needed to have a sample of the finished print job read to print.  Select the pen group, and drag it to the location that it needs to be in.  This only works in the color
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mode, not black and white.   

 

  

Printing Completed Project 

With everything else ready, one must still set the imager to print with the correct parameters 

To print the now formatted job to a PDF, make sure a PDF Printer is installed on the system, and that the job is formatted as wanted.  Under the GUI File Menu, select
Print Options... to display this screen: 

 

From this screen the operator can select the number of records in the database to include in the preview and whether to include the various options in the output image.
 Optional output elements include the background imager, pen boundary lines, and a cover sheet. 

The full color background image can be included in the print preview. The entire background image will be printed, including any parts that are outside the page size
configured for the jet.engine page. The background image is always printed behind all pens data. Pen boundary lines are dotted lines that show the boundaries between
each Print Cartridge in the overall layout. 

Once layout and setup is complete, use the Print... selection from the GUI file menu to print the file (be sure to select the pdf printer), or use Print Preview to get a look
at your completed layout as it will print. 

  

  

Terminal Mode 

By configuring Terminal Mode, you can set up the jet.engine™GUI to receive dynamic print data from a remote application, as well as allow a remote application to
control several of the  jet.engine™GUI  functions and capabilities. 

 Note: The Terminal Mode - Communication Interface Specification contains a detailed description of the commands used in this mode. 

You set up Terminal Mode in a section of the Systems Settings screen, which you access from the Options/Imager Configuration menu. 
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There are seven (7) possible Terminal Modes available on the Mode drop-down menu: 

1. Disabled (Normal Mode): This disables Terminal Mode and is the default jet.engine™GUI operating mode. 

2. Terminal Mode #1:  No dynamic print data files are loaded into the  jet.engine™GUI.  Dynamic print data is sent to the jet.engine™GUI application from a 
remote application, one record at a time, by commands defined in the Terminal Mode - Communication Interface Specification.  Terminal Mode #1 also 
supports several commands related to remote control of jet.engine™GUI  functions and capabilities. 

3. Terminal Mode #2:  This is also called Gunther Inserter Mode and is similar to Terminal Mode #1, except that the dynamic print data is sent to the 
jet.engine™GUI  in the format required by the Gunther Inserters.  The Terminal Mode - Communication Interface Specification contains a description of the 
commands used in this mode. 

4. Terminal Mode #3:  This mode allows direct ASCII printing capability. Pre-Amble and  Post-Ambles, if required, are configured in the  jet.engine™GUI.  The 
Pre-Amble and the Post-Ambles are used to delimit (signal the beginning or end of) the ASCII data to be printed.  This mode does not support the reception
or handling of the remote commands defined in the Terminal Mode - Communication Interface Specification. 

5. Index Mode #1:  In this mode a dynamic print data file is loaded into the jet.engine™ GUI, either directly from the jet.engine™GUI or from a remote 
application. The remote application sends a message to the jet.engine™GUI, one record at a time, to indicate which record to print, based on the Index number 
of the record. This allows the system to print items from a dynamic print data file in non-sequential order. This is useful in systems where items that require 
dynamic print can get diverted and not reach the printer, or in applications where random access of the dynamic print data file is required.  The Terminal Mode -
Communication Interface Specification contains a description of the commands used in this mode. 

6. Index Mode #2:  This is a proprietary mode used by a particular customer. 

7. Read-Print Mode #1:  This mode allows direct connection of a barcode scanner to the jet.engine™GUI computer through a RS-232 port.  The barcode scanner 
reads a barcode and sends the scanned data to the jet.engine™GUI. The jet.engine™GUI then uses the data as an Index into the loaded dynamic print data file,
and prints the data associated with that Index. The dynamic print data file is loaded into the GUI, and the Field number in the data file that represents the
Index is configured in the jet.engine™GUI.  The Field selected as the Index represents the characters that the scanner will output to the GUI when the barcode
on the document is scanned.  The barcode scanner is configured to use an STX (0x02) as the Pre-Amble, and an ETX (0x03) as the Post-Amble.  The scanner 
is configured to run in Point-to-Point operating mode, which sends data whenever it is available, and without any request from the jet.engine™GUI.  This mode 
does not support the reception or handling of the remote commands defined in the Terminal Mode - Communication Interface Specification. 

From the Port Type drop-down menu, you can choose either RS-232 or Local Host. Local Host allows inter-process communications between the jet.engine™GUI
and remote applications running on the same computer.  The Terminal Mode - Communication Interface Specification contains a description of how to configure the 
Local Host port type. 

If you have selected the RS-232 Port Type, you use the RS-232 Port and Baud Rate drop-down menus to configure RS-232 parameters. 

 

Communications Overview 

Terminal Mode is a capability of the inc.jet™ jet.engine™ imaging system that allows certain operations, such as the receipt of dynamic print data, to be transferred to
the jet.engine™ Graphical User Interface (GUI) application via remote applications. 

Remote applications can communicate to the GUI application via: 

• Serial (RS-232) Interface 

• Inter-process Communication (Local Host Socket) 
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• Ethernet (10/100 Base-T) Interface 

Serial (RS-232) Interface 

Remote applications can communicate to the GUI application via a 3-wire (TxData, RxData, Gnd) RS-232 Interface.  Baud rates of 38,400, 57,600 and 115,200 are 
supported on Serial Ports COM1 through COM8. 

Inter-process Communication (Local Host Socket) 

Remote applications can communicate to the GUI application using Inter-process Communications via the Local Host Socket.  The GUI application is the “Server” while 
the Remote application is the “Client”.  The Remote application must use a Socket Address of 127.0.0.1 (Port 10001) for Sending Terminal Mode Messages to the GUI
application, and the Remote application must use a Socket Address of 127.0.0.1 (Port 10002) for Receiving Terminal Mode Messages from the GUI application. 

Ethernet (10/100 Base-T) Interface 

This has been implemented in an easy to use way that uses the same Ethernet address that the Imagers connect to of the PC to receive and send Terminal Mode data
and commands using the same ports that Local Host uses.  Once the jet.engine GUI’s Port Type is set to Local Host, the GUI listens to the Ethernet’s card address and 
Local Host’s address.  Which ever is seen with Terminal Mode data first, is listened to the rest of the time while in Terminal Mode.  This means that PC with the GUI
must be networked to the PC or other network resource that is sending the data to be printed. 

  Note: You can use local host for selection of second PC on the same subnet as the printers. The jet.engine™GUI will connect to the host internally or externally. 

In order to clear pop-up screens, you need to push buttons, which is not necessarily desirable when you are remotely controlling jet.engine™GUI functions and 
capabilities. You can keep pop-up screens from appearing on the jet.engine™GUI by checking the box for Suppress GUI Pop-Up Screens.  

The Read-Print Mode #1 Index Num is the Field number you assign to the dynamic print data file used in Read-Print Mode #1.  It represents the characters that 
the scanner will output to the jet.engine™ GUI when the barcode on the document is scanned. 

Send Page Printed Early checkbox allows the system to send the Page Printed message after the first Imager has finished printing, rather than the
default of after the last Imager has finished printing.  This option is only available for Index Mode #1. 

The Pre-Amble #1, Post-Amble #1 and Post-Amble #2 are used to delimit the dynamic print data received from the remote application when you are operating in
Terminal Mode #3.  

Pre-Amble #1 represents the character used to signal or delimit the start of a dynamic print data string . If this is not required, it should be left unchecked.  

The Post-Ambles are used to signal or delimit the end of a dynamic print data string.  At least one character is required to delimit the end of a string, and Post-Amble 
#1 should be set to that character.  If two characters are used to delimit the end of a string, then Post-Amble #1 should be set to the first delimiting character, and 
Post-Amble #2 should be set to the second delimiting character.  If Post-Amble #2 is not required, it should be left unchecked.  Carriage return - line feed pairs are 
used as Field delimiters in the Terminal Mode #3 dynamic print data string. 

  

  

Pen Life Settings 

On the Pen Properties screen you can input initial pen parameters and specify levels at which low ink messages will appear. 

 

When you select an Imager from the list, you can set the Pen Type (cartridge, manifold, or bulk) as well as the Available Ink % (Percentage) for each pen. If you 
click on the Reset  button, the available ink percentage is reset to 100.  The ink consumption of a pen is tracked so that if it is removed and replaced in the Imager at a 
later time, it's ink level is remembered and displayed.  New pens are automatically set to 100% available life. 

Pen Calibration: 

The Calibrate button is used to re-calibrate pens to improve their performance. If you click on this button, the following screen appears.  

 Note:You must have pens installed to perform a calibration. 

Data the software collects from the pens: 

At power up, the firmware will do a nozzle test of each pen stall and print cartridge, and return the results to the GUI software. With Imager logging disabled only the 
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number of good nozzles is returned. With logging enabled the individual results of each nozzle are included in the Firmware log. 

The firmware will then read the cartridge ID and determine if the cartridge has changed since the last power up. If the cartridge ID read is successfully and the cartridge 
has been changed (the ID is different), the firmware will do a pen thermal calibration (measure the current value of the pen thermal set resistor (TSR) and set it to the 
current temperature of the pen driver pcb thermistor) - if the pen is not at the same temperature as the pen driver pcb this calibration will be incorrect.  

 Note: There is a 0.5% chance the cartridge has been changed, but has the same Cartridge ID - in this case the system will not recognize the cartridge has changed 
and will use the temperature calibration of the previous cartridge. In addition, ink levels will not be properly reset by the firmware and GUI software. 

Pen Calibration Process: 

Pen Calibration is a process where the software attempts to determine the optimum drive energy for the current print cartridge. 

The Imager will use the current pulse length for the calibration, and vary to drive voltage during the calibration. 

The pen is pre-heated to 80 degrees C for 1 second, then 1000 nozzles are fired at decreasing drive voltages. 

The temperature of the print head ink is measured after each firing sequence. 

The temperatures measured at each drive voltage are returned to the GUI software for analysis. 

This information is relayed to the Imager to adjust the pens. 

The GUI generates the Pen Calibration plot (shown below): 

 

Pen Calibration Plot: 

On the pen calibration plot there are two data points displayed: A green dot and a red dot. 

The green dot indicates the point on the curve where the temperature reached it's lowest point before starting to rise again. 

This is the point where the print cartridge has started to retain heat (and therefore is not ejecting ink reliably) - it is the "turn on energy" of the pen. 

If the pen calibration does not include a "low" point - the GUI indicates the calibration was not successful. 

The red dot indicates the point where the system will set the drive voltage of the pen. 

The drive voltage set point (red dot) is determined by adding the "over energy" (set in the Application Settings, in the GUI , or XML file in Vista installations) to
the "turn on energy". 

If the pen calibration is successful the GUI software will change the drive voltage of the pen to match the calibration results - This is the only change the 
calibration performs. 

If the pen calibration is not successful, no changes are made to the pen configuration settings. 

After a successful pen calibration the pen drive voltage can be changed by using the Options Menu - Advanced Configuration - Pen Parameters Tab 

 The values in the Pen Parameters Tab should only be adjusted by qualified personnel - driving a pen with too much energy (drive voltage, pulse 
length) can damage the drive electronics. 

The system default for Pen Type is  Cartridge System.  If you are using a Bulk System, you need to change the Pen Type from the drop-down menu, and then click the 
Reset button for each setting changed. 

If you select Manifold Pen, a drop-down menu will appear on the right, from which you need to select an appropriate Ink Source.  The Manifold Pen Life Setting is 
available in the lower-right of the System Settings tab, as shown below and can also be set in the Application Settings dialog menu . 
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You can also set the Low Ink Warning Levels for both bulk and cartridge systems. 

The jet.engine™GUI calculates for you the amount of ink used, based on the print jobs that are run, and adjusts the levels in the indicator windows on the Pen Status
screen.  Once the ink reaches the Low Ink Warning Level that you have chosen, the indicator will change from blue to red, and a red dot will appear under the pen
on the Imager Setup page.  Additionally, by selecting the Calculate Ink Costs checkbox in the System Settings tab, you can let the GUI estimate your ink consumption 
cost. 

  

Multistation 

The inc.jet™ GUI allows Imagers to be positioned at no more than 38.9283 inches from the sensor.  However, physical machine constraints may demand that some
Imagers be positioned further away from the sensor (downstream) at a distance that exceeds the maximum allowed. Using repeat length (the distance from the
beginning of one page to the beginning of the next), the maximum distance from sensor (38.9283 inches) and the actual distance from sensor for each Imager (as
indicated for each Imager on the Imager Setup screen), Multistation computes a specific number of blank pages to pass an Imager before it prints the actual page. 
Sending blank pages allows the greater distance from sensor. This computation is not visible in the inc.jet™ GUI.   

 

Once Multistation has been enabled in the Application Settings, a button becomes visible on the Imager Setup screen in the inc.jet™ GUI. If you click on this button the 
following screen appears 

In these screens the operator enters a value for Repeat Length. Repeat Length is the distance, in inches, from the beginning of one page to the beginning of the next.

When Number of Page Sensors = 1, this feature will open the pop up table (shown below). 
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When Number of Page Sensors = 2 or more, this feature will open the pop up table (shown below). 

In Multi-station with multiple sensors: Each Station is defined as a group of imagers that are triggered by the same sensor. 

       

You can set up the number of page sensors and set the Linear Web Distance From First Page Sensor for each sensor you have configured.  

 

To increase or decrease the number of page sensors click the up or down arrows in the "Number of Page Sensors" select box, the up arrow increases the number of 
sensors and the down arrow decreases the number of sensors. 

LinearWebDistance is used to calculate the number of blank pages that we have to be sent to each imager at startup. 

The number of blank pages for each imager within a station will be the same, and it will be calculated as (int) LinearWebDistance /repeatLength. 

When Number of Page Sensors > 1, the user specifies the "Linear Web Distance From First Page Sensor" for each sensor. 

You cannot change the value for the First sensor, as it's distance from itself is 0. 

In the Imager Setup section on the right, the operator enters the Distance from Sensor, in inches, for each Imager used in the print job, and indicates for each Imager
whether stitching is Internal or All Possible. 

In the example above, the Multi-station computation is as follows: 

1. The first and second Imagers are positioned within 38.9283 inches from the sensor. 

2. The third Imager is 100 inches from the sensor and the fourth Imager is 120 inches from the sensor, both outside of the maximum allowable distance of 38.9823
inches (see note below). 

3. The repeat length of the page is 10 inches. 

4. Multi-station divides 100 inches (the distance from sensor of the third Imager) by 10 (the repeat length) to indicate that 10 blank pages must pass before the third
Imager prints. 
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5. The third and fourth Imagers are 20 inches apart, so the fourth Imager will print after 10 blank pages, plus 20 inches. 

Any images stitched together must be within the distance from sensor value of 39.9283 inches. For example, if a group of imagers are located 105 and 115 inches from
the sensor, all imagers in that group that are stitched must be within 39.9283 inches from the imager closest to the sensor in that group. Dividing 105 by 10 inch repeat
calculates to 10 blank pages for the imager at 105 inches.  The calculated distance from sensor is at 5” (the remainder of the division). The second imager, if stitched 
with the first, cannot be past 139.9283 (100 is the evenly divisible value for blank pages + max distance from sensor if the imagers are stitched). 

 Note: The maximum allowable distance from sensor is dependent on the Sensor Delay Accuracy setting, i.e., the lower the accuracy setting, the more the allowable 
distance from sensor increases.  Sensor Delay Accuracy is set in Options/Imager Configuration/Imager Settings.  

How To 
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How To: Set Up and IO Event 

How To: Set the Imager Configuration 

How To: Set Up Stitching (Align Printing) 

How To: Set Up Purging 
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How To: Read jet.engine™ GUI GUI Debug Logs 

How To: Work with Data Sources 

How To: Set Up An IO Event 

Introduction 

The Imager accepts Input signals and transmits Output signals. The connection to the Imager is through a 36 pin connector. In order to access the hardware Inputs and
Outputs, you need a VTMK cable harness, a custom cable assembly, or a breakout board of the 36 pin Imager connector. To use System Events, Page Processed, or 
Page Printed Count as Triggers, no other equipment is necessary, although displaying the results externally may not be possible.  

Configuring an Event with a System Trigger 

Configuring an Output Event means the information from the Imager is displayed via an output device. To configure an Output Event, you need to know the following: 

1. The condition that triggers the event. 

2. The Action that the Trigger will cause. 

3. The condition required to turn off the Trigger. 

 

In this example, it is assumed that you want to turn on an LED to signify that the ink level is low, and that the LED should turn off when the ink level is restored to a
level that is higher than low warning level. 

Therefore: 

Trigger for the event:  low ink level 

Action: turn LED on 

Condition to turn off the Trigger: restore ink level 

Configuring an Event with an Input Trigger 

Configuring an Input Event means that you send information from an Imager. To configure an Input Event, you need to know the same information that is required for 
an Output Event, i.e., the Trigger, the Action, and the Condition to turn off the Trigger. 
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In this example, it is assumed that you want to use a push button or external signal pulse to stop the print job and park the Imager. On manually restarting the print
job, the Imager will automatically move into print position. 

Therefore: 

Trigger for the event:  Assert push button 

Action:  Stop printing. 

Condition to turn off the Trigger:  Optional in this case 

When the push button or external signal pulse is asserted, it creates a Leading Edge. (When the push button action is reversed after being asserted, it creates a Trailing 
Edge). The Trigger executes the Action when it detects the Leading Edge.  

The Action should stop the printing operation and park the Imager. This is a set of actions that must be executed in specified order.  

Refer to the section on Wiring Hardware Inputs and Outputs for details of connecting Input devices. 

Note: You may want to give the Input a more meaningful name, e.g., Stop Printing. You can do this us clicking the  Define Labels button.  

  

  

How To:  Set the Imager Configuration 

Introduction 

Transport Settings 

Setting the Imagers 

Saving the Configuration 

Introduction 

On the Imager Setup screen you can create print job configurations and store them in a file with a .ijj extension. 

The Imager Setup main tab screen is the default screen when you open the jet.engine™GUI. The Current Configuration shown will be the last one used when the

jet.engine™GUI was shut down. When you want to start a new print job, select New Job from the File menu, or click on the  icon. To open an already existing job,
select Open Job from the File menu. 

The bottom portion of the Imager Setup screen shows a rough graphical representation of the default Imager Setup.  You will see the number of imagers in the
system, and their orientation, and whether a fourth pen is present.  It also shows the paper orientation, the print direction, and whether a fourth pen is inline (indicated
as black) or remote (indicated as red).  Low ink levels are indicated by a red dot adjacent to the pen.  As parameters are changed, the graphic is updated. 

If you are unable to see the full layout, check the box next to Fit to Window. 

Page 123 of 146jet.engine GUI Help



 

Transport Settings 

Select the appropriate Job Setup options.: 

 

Form Size:  select from a menu of paper and envelope sizes or set up a custom size. 

Barcode Shaving :  select Glossy, Porous, Regular, or Specific Settings, depending on how your paper accepts ink. 

Print Resolution (DPI): select the Vertical and Horizontal settings that agree with your transport (conveyor ).  It is possible to set Horizontal Resolution at 
600 DPI for speeds of up to 100 inches per second. 

Paper Orientation:  select whether the paper feeds from the Top or Bottom. 

Repeat Length: When Multi-Station is enabled, the Repeat Length is the distance, in inches, from the beginning of one page to the beginning of the next. 

Setting the Imagers 

In the Imager Setup box, click on the Add Jet Engine or Delete Engine buttons until the number of Imagers matches your configuration. 
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The first step in setting the Imagers is to set the Distance from the Top Edge of the page and the Distance from Sensor .  The Imagers should be mounted in a
fixed position above the transport. 

The Distance from the Top Edge is from the top of the page as it passes by to the first pen on the Imager.  

The Distance from Sensor is the distance from the sensor to the first pen on the Imager.  This must be set correctly or printing will not be positioned properly.  The
software delays printing because it counts the number of encoder ticks that correspond to the distance entered in this column before printing. 

Pen Direction refers to the relationship of the Imager to the top of the product on the transport.  Stitching can be Internal (across pens in an Imager) or across
multiple Imagers (select All Possible). When stitching across Imagers, they must be mounted to the same plate with a specific overlap between Imagers. 

If a 4th Pen is used, you must define it here by changing the setting from No to Inline.    

Changes you make in the Imager Setup box will be reflected in the graphic representation of your system’s configuration, at the bottom of the screen. 

 

Saving the Configuration 

It’s a good idea to save your configuration once it is complete.  Select Store Configuration from the File menu, enter a unique name for the configuration, and click 
OK.  To use this configuration in the future, select Load Configuration from the File menu. 

 

  

  

  

  

  

How To: Set Up Stitching (Align Printing) 

An Imager is limited to the area it can cover and the number of pens it can contain.  Similarly, pens are limited to the area they can cover.  If the size of your printed
document requires that you use multiple pens and/or multiple Imagers, you want to make sure that the area where one pen meets another, or where one Imager meets
another, does not overlap or leave a gap in the print, and that the leading edge of images from the multiple pens or Imagers align properly.  Fine tuning this process of
adjusting the pen overlap and Top of Form location on Imager pens is called Stitching. 
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The Pen Overlap section of the screen is used to adjust the image intersection (overlap) between pens. This is also referred to as vertical calibration. The Process 
Direction Adjustment is used to adjust the beginning of page (sensor delay) for each pen. This is also known as horizontal calibration.  

Process Direction Adjustment 

You can use Process Direction Adjustment to define the exact distance from the sensor to each Imager pen. Because any adjustment affects all following (downstream) 
pens, an automated process, described below, is available to determine the exact delay (in encoder ticks) from the sensor to each Imager pen.  

You can also manually fine tune the stitching between pens by using the Manual Adjustment. This performs the same function as the Automatic Adjustment, but you 
must rely on your expertise to set up the parameters correctly.  

 Warning: Manual Adjustment is not recommended if you have limited experience with the jet.engine™GUI or printing with Imagers.  

You can use either Manual Adjustment or Automatic Adjustment at any one time. Once one method of adjustment is used, the other method is disabled until the Imager 
Configuration window is closed. Generally, initial system setup is performed using the Automatic Adjustment, and small, post-setup system adjustments are performed
using Manual Adjustment. 

Pen Overlap 

Pen Overlap is used to disable nozzles on the Imager pens.  Using the Pen Overlap, you can electrically adjust where each image pixel is printed and compensate for
most mechanical mounting errors in a system installation. 

How to Stitch (Calibrate) an Imager 

Setting up the Job 

Click on the Form Design main tab.  The layout that you see represents available print area under the Imagers.  You may need to adjust the form size on the Imager 
Setup page so that all Imagers are included in the form. Stitched Imagers will show a dotted line separator, while unstitched pens will show a solid line. The rulers at
the top and left of the form will change as new settings are applied.  The numbers on the left correspond to the individual Imager and pen numbers available. In order
to properly perform the calibration process, Imager 1 Pen 1 must be the first pen displayed at the top left of the form. This means paper orientation must be inverted for 
all left to right orientations, and normal for all right to left orientations. 

 Note: If the wrong paper orientation is used, stitching corrections will double the error rather than correct it. 

 Note: There must be at least three pens installed in the imager before attempting calibration. 
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Click the  icon to insert the appropriate calibration bitmap for your configuration . (When you install the jet.engine™ GUI, these files are stored in 
jet.engine.gui/Samples/Bitmaps.)  These are named as follows: Stitch "x" imagers "y" pens.bmp, where x = the number of imagers, and y = the number of pens per
imager.  For example, if you are using two imagers with three pens per imager, you would use the Stitch 2 imagers 3 pens.bmp. 

  

 
Click on the Imager Configuration from the Options menu and choose the Stitching tab.  The Imagers have a built-in 4-jet horizontal overlap. By default, these
four jets are disabled at startup and must be activated in order to properly calibrate the Imagers.  You do this by clicking the Zero All button.  Each Imager in the 
system must be set separately. 

 

When finished, click OK, select the Print Manager main tab, and click on the Start Print Job button.  This will send the print job to the Imager.  Start the transport 
and send a piece of paper down the conveyor.  The bitmap will be printed by the Imagers.  

Setting the Process Direction Adjustment (Horizontal Stitching) 
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Examine the printout.  The lines on the left represent Vertical Stitching, while those on the right represent Horizontal Stitching.  Note that each pen has printed the 
calibration pattern.  Find the place where the vertical lines match between the pens, and circle the numbers.  On the right, find the place for each pen where the upper
and lower lines are closest together without overlapping, and circle the corresponding numbers. 

 

 

  

Return to the Stitching screen and enter the numbers that were circled on the printout into the appropriate boxes.  The Pen Overlap section of the screen is for 
vertical calibration, while the Process Direction Adjustment is for horizontal calibration.  Using the examples above, 3 is entered into the box shown, because for the 
set of lines generated by Imager 1 pen 3 and Imager 2 pen 1, the lines at position 3 were closest together without overlapping.  

   

  

In the Process Direction section, 26 and 25 are entered as shown. This is where the lines from Imager 1 pen 3 and Imager 2 pen 1 appeared to line up best.  When
you have finished entering calibration data, click the OK button.  Reprint the calibration bitmap, and examine to verify that calibration was performed properly. 

Saving the Configuration 

You can save the finished configuration with a unique name by selecting Store Configuration from the File menu. To use this configuration in the future, select Load 
Configuration from the File menu. 

  

  

Page 128 of 146jet.engine GUI Help



How to:  Set Up Purging 

Purging at the Start of a Print Job 

Purging During Printing 

Purging is a means of periodically cleaning the ink jets by sending ink through every jet on the ink head. The jet.engine.GUI uses a bitmap, called purge.bmp, for
this operation. You'll find it in the directory where you installed the jet.engine.GUI.  You may, however, choose your own bitmap by putting a monochrome 
(1 bit/pixel) bitmap in the same directory. 

Purging at the Start of a Print Job 

On the Print Manager screen, you can set a specific number of Initial Pages to Purge. 

 

In the example above, five (5) pages are set to be purged at the start of the print job.  This means that the first five pages printed will be used by the bitmap to clean
the jets, and then the print job will start.  

Purging During Printing 

You can also create an IO Event to purge the ink jets periodically during printing . On the Events Setting screen, select Page Processed Count as the Trigger and 
enter a number.  For example, you might want to purge after every 100 pages are processed, so you would enter 100 in the box. For the resulting Action choose 
Purge from the System Action drop-down menu. (See IO Events for details on how to configure Triggers and Actions.) 

You might also want to tie a secondary Hardware Output to the Purge action, such as a divert. For example, you are printing hundreds of envelopes that will be sent
to the post office.  If you are doing a periodic purge during printing, you don't want the envelopes that receive the purge to go to the post office, so you need to set up
another IO Event. For a Trigger you would choose Purge (Page-Based) from the System Event trigger drop-down menu (because you have already set up an 
event to purge every 100 pages) and you would then set up a Hardware Output that diverts the "purged" envelopes off the conveyor . (Again, see IO Events for 
details on how to configure Triggers and Actions.)  

  

How to: Proof 

Before beginning a print job, or perhaps while a job is printing, you may find that you need to adjust the Imager relative to the paper being printed.  To avoid using
records from your print job, and having to re-print any records, the jet.engine™GUI allows you to initiate Proof. With this function engaged, the system selects the first 
record and prints over its object with either the word "PROOF" or an image you have selected, thereby invalidating that object. When Proof is turned off, that record is 
then printed normally. 

While you may find you do not need to use Proof, it's advisable to set up Proof Settings as part of your  configuration . If you have not done this, and want to use
Proof during a print job, you will need to stop the print job, configure the Proof Settings,and then initiate Proof. 

From the Options menu, select Proof Settings. 

 

There are two sections to the Proof Settings screen.  In the first section, you can choose to make the Proof Image either the word PROOF, or an image from a 

Custom File which you select using the file browser button . 

In the Invalidate section, you can choose to print the Proof Image over either the entire Printable Area or Individual Objects. 
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Click OK to save the settings. 

Proof is initiated by checking the Proof box on the Print Manager screen.  You can do this either at the start of a print job, or when a print job is already running. 

 

Once your print job is adjusted, you can turn Proof off by un-checking the box. 

Note:  If you start Proof while a print job is already running, any records already in the buffers will print before any Proof prints.  Similarly, when you turn Proof
off, any Proof prints already in the queue will print before normal printing resumes. 

If you want immediate Proof prints while a print job is running, push the red Stop Print Job button, check the Proof box, and push the green Start Print Job
button.  To stop Proof, push the red Stop Print Job button, un-check the Proof box, and then push the green Start Print Job button to resume normal printing. 

  

  

How To: Advanced Form Design 

Introduction 

Blocks 

Other Toolbar Buttons 

Other Form Design Properties 

How To Introduction 

You set up, or design, your form on the Form Design main tab.  The size and settings on this tab are dependent on the settings in Imager Setup, i.e., the size of the 
area the Imagers will print depends on the number of imagers installed as well as the Imager Setup settings. 

The top, lighter gray area is where you design the template, i.e., what the Imagers will actually print.  

jet.engine™ forms are based on arrangements of data objects, or Blocks.  Each Block is a different type of image or text that can be inserted in the template.  Blocks
are added by clicking the appropriate icon in the Block toolbar. 

 

When you click on one of these icons, its corresponding Block is added to the layout in the upper left hand corner of the form.  From here you can relocate it either by
dragging with your mouse or by using the arrows on your keyboard.  You can delete  a Block by highlighting it and using the Delete key on your keyboard or the Delete
button on the toolbar. 

Block Types 

Field Block 

In a Field Block, you can arrange the display of data from a data source .  You can also intersperse fixed text with the fields from the data source.  

Once you have loaded the data source (see Load Data), and with the Form Design screen active, click on the  icon to place the Field Block in the layout. The 
block will be inserted at the upper left corner of the layout.  You can re-position the block by dragging and dropping it, or by using the arrow keys on the keyboard. 

To load a data source file, click on the Load File button.  Your data will appear in the bottom of the window.  You can place a field into the preview window by clicking
on the column heading, and then clicking the Add Field button.  To add fixed text, simply type directly in the preview window itself. 

Add Fields: 
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Preview Data/Add Function: 

 

You can choose to make a Field Block either rich text format (RTF) or non-RTF. The picture (above) shows a non-RTFField Block in preview window, note that the 
Preview Data button is selected so you can see what the actual data will look like for the fields you have selected in the preview window. The fields for the first record in 
the list will be previewed. You see that all the data is in the same font style and size, and all text has the same characteristics. An RTFField Block, however, allows 
different font styles, sizes, and characteristics within one block (as shown below). 
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If you decide to make the block RTF (by checking the Rich Text Format box), a tool bar appears above the preview window from which you can choose different font
characteristics, as well as the font and its size.                               

                                                                                         

 Note: When you choose the RTF check box, the check box for Remove Blank Lines will not be available and will disappear.  

If you decide to make the block Non- RTF, then you select the font, its characteristics and font size from the tool bar on the Form Design layout page. 

The relative position of the fields is shown in the preview window.  

If you have chosen not to use the RTF format, you have the option to Remove Blank Lines by checking that box.   You can also elect to Remove Leading 
Whitespace from Fields and Remove Trailing Whitespace from Fields.  If you have chosen a non-RTF format, you also have the option to Remove Leading 
Whitespace from Lines and Remove Trailing Whitespace from Lines. 

Add Function Select Menu: 

You have several additional options in the Add Function drop-down menu. 

1. You can add or edit Date/Time Formats.  <<DATETIME(mm dd yyyy, 0.000000, 0)>> Example: 09/30/08 

2. You can insert the current record number into the Field Block as a field by choosing Add Record Number. <<RECORDNUMBER()>>  Example: 1 

3. You can insert the page number into the Field Block as a field by choosing Add Page Number. <<PAGENUMBER()>> Example: 1 

4. You can add or edit the string function for a field in the Field Block by choosing Add or Edit String Function.

 

5. You can add or edit the random function for a field in the Field Block by choosing Add or Edit Random Function.
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6. You can add or edit the counter function for a field in the Field Block by choosing Add or Edit Counter Function.

 

  

Add Function Select/Developer Mode: 

The following are more options that are available in the Add Function drop-down menu when you are in "Developer" Software Mode. 

1. You can insert the horizontal resolution into the Field Block so it will display as a field by choosing Add Horizontal Resolution.  

<<HORIZONTALDPI()>>  Example: 300 

2. You can insert the vertical resolution into the Field Block so it will display as a field by choosing Add Vertical Resolution.  

<<VERTICALDPI()>> Example: 300 

3. You can insert the vertical density into the Field Block so it will display as a field by choosing Add Vertical Density.  

<<VERTICALDENSITY()>> Example: 100% 

4. You can insert the print speed into the Field Block so it will display as a field by choosing Add Print Speed.   

<<PRINTSPEED()>>  Example: 0.00 

  

If you want to include a Postnet Barcode, simply click the Include box. 

To set the position of the block and other characteristics, click on the Block Properties tab. 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

With all text-based objects, including the Field Block, you have the option to display the data as a Barcode .  If you choose this option, a Barcode Properties tab 
appears from which you can set the print characteristics of the Barcode. 

Record Block 

A Record Block is used with a data source that has variable data.  For example, you would use a Record Block if you are printing a job containing multiple names and 
addresses.  The Record Block that you set up on the Form Design layout is actually a template that shows how you want the information from the data source to be
printed.  Its contents will change as each record prints.  

With the Form Design layout active, click on the  icon .  A Record Block is inserted at the upper left corner of the layout. You can re-position the block by 
dragging and dropping it, or by using the arrow keys on the keyboard. 
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Before using a Record Block, it is important to know how your data is arranged in your data source. Record Blocks are, by default, nine (9) lines long. Think of a 
Line as a Field .   Here is an example of a how a Record Block  might be set up from a data source with variable data:  

*******************AUTO**3-DIGIT 110 

 Mr. C. Montgomery Burns 

 71 Croesus Ave 

                             Springfield, US  11001-2554 

This record has four (4) lines.  Note that the person's name in this example is one field in the data source.  If your data source has a name divided into different fields,
e.g., first name, last name, etc., you will probably want to use a Field Block, rather than a Record Block, for setting up your print job. 

Your data source may have fewer than, or more than, nine (9) lines.  You can make this change on the Field Block Properties screen.  

You can view the block's Properties  in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

 

If the records in your data source have more or less than nine (9) lines (or fields), you can enter the correct number in the box next to Number of Lines.   

You may want your Record Block to start with a line other than the first line (e.g., if "Mr." is the first line you might not want that included).  In that case, in the box
next to File Record Line #, enter the number of the line where you want the Record Block to start. 

You can change the Font , as well as its style and size, on the Font tab. 

To set the position of the block and other characteristics, click on the Block Properties tab. 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

With all text-based objects, including the Record Block, you have the option to display the data as a Barcode.  If you choose this option, a Barcode Properties tab 
appears from which you can set the print characteristics of the Barcode. 

Message Line 

A Message Line is a block of fixed text that you have created. With the Form Design layout active, click on the  icon. The Message Line block will be inserted at 
the upper left corner of the layout.  You can re-position the block by dragging and dropping it, or by using the arrow keys on the keyboard. 
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You can enter your text through the Message Line Properties screen. 

You can access the block's Properties  in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

 

On the Message Line tab, simply type your text in the box. 

Choose the Font and its characteristics from the Font tab. 

Set the Block Properties of your block (e.g., the position of the block on the Form Design layout, the position of the text within the block, the block border, etc.) on 
the Block Properties tab. 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

With all text-based objects, including the Message Line block, you have the option to display the data as a Barcode.  If you choose this option, a Barcode
Properties tab appears from which you can set the print characteristics of the Barcode. 

Indicia 

Indicia are similar to message boxes, except that they must be formatted within guidelines specified by the United States Postal Service in its Domestic Mail Manual. 
This manual is available online at http://pe.usps.gov/text/dmm/DMMTC.htm.  The Indicia provided with the software is a template that you need to edit in order to
comply with USPS regulations. 

With the Form Design layout active, click on the  icon.  The Indicia block is inserted at the upper left corner of the layout.  You can re-position the block by 
dragging and dropping it, or by using the arrow keys on the keyboard. 

 

You can view the block's Properties  in one of three ways: 

Double click on the block. 

Click once on the block and then click the  icon in the toolbar. 

Right click on the block and select Properties from the menu. 
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Now you can edit the text by simply typing in the box. 

You can change the font , font size, and font style on the Font tab. 

You have more options on the Block Properties tab. 

 

You can position the block on the Form Design layout by entering values in the Left and Top boxes.  You can size the block entering values in the Width and Height
boxes. You can also set the Horizontal and Vertical position of the text within the block. 

Checking Word Wrap will keep the text from running outside the block. If you check the box next to Transparent , then the non-black portions of a bitmap become 
transparent.  The bitmap can no longer be moved around in the layout window if you check the box next to Position Is Locked. 

Resize text when box size changes means that if the size of the block is changed, the size of the font will change proportionally. However, this is true only if you
resize the block from the corner.  If you resize the object from the top or bottom, the text size will not change. 

You have the option of choosing a Border around the block by selecting Rectangle Type, the default setting is No Rectangle. You can also choose a Full Rectangle or a 
Single line at the left, right, top or bottom. If you select a rectangle or a line, the Pen Width can be selected for the rectangle or line that you have selected.  

                         

You can also have the system Generate error if text exceeds borders. This means that if any of the text exceeds the boundaries of the object, you will receive an
error during printing.  If you do not choose this option and the condition occurs, text will appear truncated or cut off. 
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You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

Fixed Bitmap 

A Fixed Bitmap is one which cannot be changed. You can add a Fixed Bitmap to the Form Design screen by clicking on the  icon.  This opens the Select 
Bitmap Files window, which works like any Windows file browser.   

 

Simply select the .bmp file and click Open, or double-click on the .bmp file name. The bitmap will be inserted at the upper left corner of the Form Design layout.  You 
can re-position the bitmap by dragging and dropping it, or by using the arrow keys on the keyboard. 

You can view the bitmap's Properties  in one of three ways: 

Double click on the bitmap. 

Click once on the bitmap, and then click the  icon in the toolbar. 

Right click on the object, and select Properties from the menu. 

 

From the Fixed Bitmap window, you can change the Bitmap Position by entering values in the Left and Top edit boxes.  If you check the box next to Position Is 
Locked, then the bitmap can no longer be moved around in the layout window. 

If you check the box next to Transparent , then the non-black portions of a bitmap become transparent. 

Bitmaps cannot actually be resized in the GUI. You have to use Microsoft Paint or a similar application to do that.   However, if the box next to Allow Sizing is checked, 
you can change the Scaling of the bitmap in one of three ways: 

You can enter Absolute (specific) Width and Height values. 
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You can enter Scaling percentages in the Width and Height boxes. 

You can enter DPI (dots per inch) X Resolution and Y Resolution values. 

If you check the Lock Aspect Ratio box before you make changes, the scaling changes proportionally. For example, if you change the Absolute Width to 1.5, the 
same value is automatically entered for the Height.  If you change the Scaling percentage to 150% for the Width, the Height automatically changes by 150% as 
well.  If you change the X Resolution value to 600, then the Y Resolution is automatically changed to 600, too. 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen.  

Dynamic Bitmap 

The Dynamic Bitmaps feature gives you the ability to use an assortment of bitmaps during a print run. 

With the Form Design screen active, click on the  icon in the toolbar. The Dynamic Bitmap block will be inserted in the upper left corner of the  layout.  You can 
re-position the bitmap by dragging and dropping it, or by using the arrow keys on the keyboard. 

 

You can view the dynamic bitmap's Properties  in one of three ways: 

Double click on the bitmap. 

Click once on the bitmap, and then click the  icon in the toolbar. 

Right click on the object, and select Properties from the menu. 

 

To add each bitmap, click on Add Bitmap. This opens the Select Bitmap Files window, which works like any Windows file browser.   
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Simply select the .bmp file and click Open, or double-click on the .bmp file name. The bitmap will be added to the list.  Repeat this action until you have added all the
bitmaps.  You can see on the Properties screen above that each bitmap selected is connected to a field in your data source and a criterion specified for that field.
When a field criterion for a given bitmap matches the value in the data source, that bitmap will be printed. 

If you want to remove a bitmap from the list, click once in the block to the left of the row that contains the bitmap you want to delete.  This will highlight the entire row.
Then click on the Remove Bitmap button. 

From the Dynamic Bitmap Properties tab, you can change the Dynamic Bitmap Position by entering values in the Left and Top edit boxes.  

If you check the box next to Transparent , then the non-black portions of a bitmap become transparent. 

If you check the box next to Position Is Locked, then the bitmap can no longer be moved around in the layout window. 

 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

Number Generator 

The Number Generator object is used for jobs that require the printing of a sequence of numbers, with each page having a different number.  For example, if you
were printing tickets that have seat numbers on them, you would need to set up a Number Generator so that the tickets are printed with individual numbers in a 
sequence.  

With the Form Design main tab screen active, click on the  icon.  A Number Generator block is inserted  in the upper left corner of the  layout. 

   

You can re-position the block by dragging and dropping it, or by using the arrow keys on the keyboard. 

In order to configure the Number Generator you need to access the block's Properties , which you do in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 
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The Start # is the number that will start the sequence, and is limited to 19 characters.  A Start # can be simply a number, or it can contain an alphanumeric 
combination.  In the example above, which could be a Number Generator for printing tickets, the Start # indicates that each ticket will be printed with the word 
"Titans", followed by a (-), then a number.  

The Mask controls the way that each character is handled by the software.  There are four different types of masks controlled by Mask Options. 

1. Counter Digits are the dynamic, or changing, characters in the number.  They will change according to a user-defined formula.  Make sure you allow enough 
blank spaces for the number to sequence properly, or  it will roll back to zero.  Counter Digits are always used in calculating the check digit .  This is indicated 
by a “#” character in the mask box. 

2. Static Characters do not change.  They can be included in the Checksum calculation.  Only numeric characters can be Checksummed.  This is indicated by a 
“+” in the mask box.  A “.” in the mask box means that the static character is not used in the Checksum calculation.  

3. Alpha characters, such as "TITAN" in the example above, generate a Static Character (Not Checksummed) Mask ("."). 

4. The Check Digit is the number that is generated as a result of the Checksum Method selected.  This number can be read by a barcode scanner or OCR reader 
to verify that a code has been properly printed and read. 

Weighting allows more sophisticated Checksum calculations to be used by giving more "weight" to certain numbers.  

Once you determine your numbering format , you can set up the method for sequencing the numbers.  The number will increase (or decrease) based on the values
entered into the Count/Every boxes.  The format for the values in these boxes is two numbers, separated by a forward slash (“/”).  The first number is the amount 
that the counter increases when the record is seen. The second number is the number of records that must be seen to trigger an increase. In the Count/Every
example above, 2/1, the number will increase by 2 for each (1) record.  So, if the first number is "TITANS-0001", the next number is "TITANS-0003", then 
"TITANS-0005", and so on. 

Negative values can also be used.  If the Count/Every value is "–2/1", the number will decrease by two for every record it sees.  So, if the first number is "TITANS-
0300", the next number would be "TITANS-0298", then "TITANS-0296", and so on. 

You can set up quite complex counting patterns.  For example, suppose you need to cycle through the same 1000 serial numbers continually.  By entering ‘1/1’ and ‘-
1000/1000’ the number will increase by one every time until it gets to one thousand.  At that point, it will decrease by one thousand, thus returning to the start.  Since
you can enter up to ten values, you can do quite sophisticated counting. 

The Checksum Method and Modulus pull-down menus work together to calculate the Checksum digit in a variety of ways. 

    

DR-Divide, use Remainder takes the numeric string that comprises the Checksum (the number whose Mask is #)  and divides it by the Modulus number.  
Discard the quotient and keep the remainder.   For example, if the string value is 1257 and the Modulus operator is 8, the calculation is as follows: 1257 mod 8 
= 1257/8 = 157 R 1.  Discard the 157 and the resulting Checksum digit is 1. 

DSR-Divide, Subtract Remainder is similar except that the remainder is subtracted from the Modulus number.  For the number 1257 used in the example 
above, the remainder 1 is subtracted from the Modulus 8, resulting in a Checksum digit of 7. 

ADR-Add Digits, Divide Remainder takes the digits in the Checksum number and adds them together.  It divides the result by the Modulus number and 
uses the remainder.  So, 1+2+5+7 = 15, 15 mod 8 = 15/8 = 1 R 7.  Discard the 1 and the Checksum is 7. 

ADSR-Add Digits, Subtract, Divide Remainder is similar to the above method, except that the remainder is subtracted from the Modulus number.  Using 
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the example above, the remainder 7 would be subtracted from the Modulus 8, resulting in a checksum of 1. 

A Checksum generator for Code 128 B Barcode, a common barcode, is also provided. 

You can change the Font , as well as its style and size, on the Font tab. 

To set the position of the block, and other characteristics, click on the Block Properties tab. 

You can Transform the block during printing by clicking on the Transform tab. You will also see the transformation change on the Form Design screen. 

With all text-based objects, including the Number Generator, you have the option to display the data as a Barcode.  If you choose this option, a Barcode
Properties tab appears, from which you can set the print characteristics of the Barcode.   

PDF File 

The PDF File (Portable Document Format) capability is a function that is licensed from Printing Technology Services, Inc., and requires a key for you to use it.  To
obtain a key contact Printing Technology Services, Inc. at info@printingtechnology.net. 

There are two instances in which you might use a PDF file:  either you have constructed a PDF file with variable data in it, or you have a PDF file with which you want to
print variable data (i.e., you want to overlay parts of the PDF file with variable data, or you want to print the PDF file with variable data next to it). 

To insert a PDF File, make the Form Design screen active, and  click  on the tool bar. A PDF Block is inserted in the upper left corner of the layout.  

 

You can re-position the block by dragging and dropping it, or by using the arrow keys on the keyboard. 

In order to load a PDF File, you need to access the block's Properties , which you do in one of three ways: 

Double click on the block. 

Click once on the block, and then click the  icon in the toolbar. 

Right click on the block, and select Properties from the menu. 

 

To locate a PDF File, click on the button at the right edge of the PDF File Name box.  This opens a typical Windows browser from which you locate a file. Once you
select a file, you see that the PDF File Information for that file (Number of Pages, Page Height and Page Width) is automatically displayed. 

You have two options for PDF Printing.  If you choose Single Page, and enter the number of the page to print, the system will print the same page repeatedly.   If 
you choose Multiple Pages, and enter the number of the page where you want the printing to start, all pages in the PDF File from that point will be printed. 

From the PDF Appearance tab, you can determine how the PDF File appears on the Form Design layout. 
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To set the PDF Position, you enter values in the Left and Top boxes.  

You can Crop , or delete portions of, the PDF File, using the Crop from boxes. For example, if you want to delete the bottom inch of your PDF File, simply enter "1" 

in the Bottom box. You can also crop the PDF File directly on the Form Design layout.  Click once on the PDF File block to select it.  On the tool bar, click on , 
the Crop button.  Then, using the blue handles on the edges of the block, and holding down the left mouse button, Crop the block. 

 

The Object Properties tab allows you can give a unique name to the object you have created.  You can also indicate in the checkbox whether or not the Object is 
Printable. 

Other Toolbar Buttons 

Toggle Grid 

The grid is the line of evenly spaced dots that you see across the Form Design screen. You can use the Toggle Grid button  to switch between showing the grid 
lines and not showing the grid lines. 

Toggle Snap to Grid 

Use the Toggle Snap to Grid button  to switch between aligning or not aligning objects to the grid lines.  

Other Form Design Properties  

Transform 

From the Transform tab on the Properties screen, you can change the Angle of Rotation of a block or bitmap in 90° increments.  For some blocks or bitmaps, you also
have the option of entering a Custom degree of your choice. 

Flip Horizontal mirrors the object relative to the horizontal axis.  Flip Vertical mirrors the object relative to the vertical axis.  An object may be flipped Before or After 
Rotate. 

You will see the transformation change on the Form Design screen. 
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Barcode Properties 

With some text-based blocks, you have the option to display the block as a barcode. You do this by opening the Properties dialog in one of three ways: 

Double click on the object. 

Select the object, and click the  icon. 

Right click on the object, and select Properties from the menu.  

Here you will find a box on the screen titled Display Type from which you can choose either Text or Barcode. 

 

If you check the button next to Barcode, you'll see that a Barcode Properties tab appears. You can use this page to define a Barcode Type and its properties. 

 

First, choose a Barcode type from the drop-down menu (see Postnet Barcode for information on using that type). From the Text box, you have the option to Print 
text with the Barcode. You can also elect to place  Text above the Barcode and set the Text Distance in 1/1000 mm increments. 

For information on the settings at the bottom of the screen see Advanced Barcode Settings. 

Font Properties 

The Font tab is available in the Properties window of many blocks.  This is where you can choose the font, font style, and font size for the block . You also have options 
for Underline and Strikeout (put dashes through the text, e.g., strikeout).  The Sample Text Area displays the font with the characteristics you have chosen. 
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Click on this Choose Font Name from Data File link for more information on this feature. 

Block Properties   

A block 's properties (e.g., position on the layout, border characteristics, etc.) are set on the Block Properties tab in the Properties screen.  

Object Properties   

The Object Properties Tab allows you can give a unique name to the object you have created.   

 

You can also indicate in the checkbox whether or not the Object is Printable.  

Transform    

From the Transform tab on the Properties screen, you can change the Angle of Rotation of a block or bitmap in 90° increments.  For some blocks or bitmaps, you also
have the option of entering a Custom degree of your choice. 

Flip Horizontal mirrors the object relative to the horizontal axis.  Flip Vertical mirrors the object relative to the vertical axis.  An object may be flipped Before or After 
Rotate. 

How To:  Read jet.engine™ GUI Debug Logs 

The jet.engine™ GUI Log is used mainly for debugging purposes.  Here you'll find a fairly detailed record of the process the jet.engine™ GUI goes through when 
communicating with the Imager.  For information on enabling Logging refer to System Settings.  

There are several types of messages displayed in the jet.engine™ GUI Log.  Some are self self-explanatory while others are not.  This section covers the latter type. 
The message headers are explained below. 

CFilePage 

CFilePage::OnRasterBufferReadyForData [additional data] 

Messages in this format represent calls to internal jet.engine™ GUI functions.  These may be actions as a result of jet.engine™ GUI programming, or of events that took 
place during  printing.  In the example above, the jet.engine™ GUI received a message from the Imager that it was ready for more data. Once received, the 
jet.engine™ GUI fired this routine to supply the Imager with the requested data.  This would most likely followed by a >>Send message. 

>>Send 

          >>Send, Imager: #, MessageId: #, [additional data], [command] 

This type of message represents a command or message being sent to the Imager from the jet.engine™ GUI.  This displays to which Imager the command was sent, 
the Message ID, any additional data, and the command name corresponding to the Message ID.  For example, the following message: 

>>Send, Imager: 3, MessageId: 0x3, Buffer=4, ReadyToPrint=1, Raster Buffer Data 
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means that the jet.engine™ GUI sent Raster Buffer data to the fourth buffer of imager number 3. 

<<Receive 

<<Received ACK, Imager: #, Ack MessageId: # [command] 

Messages starting with <<Received ACK or <<Receive are messages and responses sent from the Imager to the jet.engine™ GUI.   

The following message is simply an acknowledgement: 

<<Receive, Imager: 1, MessageId: #, [additional data], [command] 

This is sent when the Imager receives and processes a command.  It sends back the acknowledgement along with the command it received. 

The second type is the Imager sending a command to the GUI.  In the following example 

<<Receive, Imager: 1, MessageId: 0x6, Buffer=1, BufsRemaining=3, Page=10, Raster Buffer Ready For Data 

In this message, Imager #1 is telling the jet.engine™ GUI that Buffer #1 has been printed and needs to be refilled, and that it has three filled buffers remaining.  Again,
the Message ID 0x6 corresponds to the Raster Buffer Ready For Data command. 

SYSTEM 

Any message beginning with SYSTEM means that it contains information about the computer running the jet.engine™ GUI.  An example is: 

7:15:734 (476) [DIAG] SYSTEM 522224 KB 

07/01/2004 14:27:15:734 (476) [DIAG] SYSTEM 942636 KB Free on C: 

07/01/2004 14:27:15:734 (476) [DIAG] SYSTEM ProcessorName: Intel(R) 

Pentium(R) 4 CPU 3.06GHz 

07/01/2004 14:27:15:734 (476) [DIAG] SYSTEM ProcessorIdentifier: x86 

Family 15 Model 2 Stepping 9 

07/01/2004 14:27:15:734 (476) [DIAG] SYSTEM ProcessorMhz: 3.06 Ghz 

  

  

  

How To: Work with Data Sources 

In order to print records, you must first load the data to be printed. 

To do this, you can either choose Load Data from the Data menu,  

 

or click on the Load Data Source icon  in the toolbar. This opens a browser window, from which you can locate and select the appropriate data source.  

If you need to Unload Data, you can either choose Unload Data from the Data menu,  

 

or click on the  Unload Data Source icon  . 
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